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Introduction to the iRIC Graphical User Interface 

Launch iRIC 2.3 by electing iRIC 2.3 from the Program Menu list or click on the iRIC icon ( ii ) on the desktop. 
The iRIC Start Page (Figure lA) opens and displays several options to start a project under the Start Simulation 
Project tab: 

Create New Project-Allows you to select the solver you wish to use from a list of solvers currently 
avai lable in the application or to select the solver from a list of recently used so lvers. 
Open Project F ile-Al lows you to open an ex isting project using a browser window or to select from a list 
of recent projects. 

The Support tab on the right provides links to the Home Page, Tenns of Use, and Contact Information on the iRIC 
website. 
Select the Create ew Project button which opens the Select Solver dialog window (Figure. l B). Highlight 
FaSTMECH and click the OK button. 
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Figure 1. Shows the iRIC Start Page (A) and the Select Solver Dialog (B) 
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Figure 2. 

X 

Example of the main iRIC interface 

The iRIC interface is operated using a variety of menus, tool bars, windows, and mouse operati ons. 
The Menu Bar at the top of the wi ndow provides access to the primary functions necessary to build a flow model 
including Fil e Management, Data Import, Geographi c Data, Grid, Calculation Condit ions, Solutions, Calculation 
Resul ts, View, Options, and Help. Addition items are added to the Menu Bar depending on whether a Pre-processing 
or Post-Processing Window is active . 
The Main Toolbar provides standard buttons to handle many of the same fea tures such as opening and closing fi les, 
controll ing the display screen, and opening other windows and graphs which will be explained in the section on 
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Post-Processing. Some features are not enabled until a flow calculation is performed. See the table below for an 
overview of the features that are always enabled: 
Main Tool bar Buttons: 

Opens an existing project 
Saves the project 
Saves a snapshot 
Zooms to the full extent of the data 
Shi fts the active canvas display left 
Shifts the active canvas display right 
Shifts the active canvas display up 
Srufts the active canvas display down 

~ Zooms in 
E\ Zooms out 

.. 
The Pre-processing Window opens by default when iRIC is launched, or by selecting the pre-processing icon ( . ). 
The Pre-processing Window is used for features and functions related to importing data, editing data, generating 
computational grids, and editing computational grids. The Pre-processing Window has t'No parts, an Object Browser 
on the left and a display screen or canvas on the right. The Object Browser in the Pre-processing Window allows 
you to control the display of geographic information such as elevation or topograpruc data as well as other data ets 
that may be necessary for your appl ication. The Pre-processing Window also displays the computational grid, and 
background images. The canvas displays the data selected in the Object Browser. 
The Operation Toolbar provides a unique set of tools that are specific to the different branches of the Object 
Browser Tree. The suite of tools available in the Operation Toolbar are loaded and become active depending on the 
branch of the Object Browser that is currently selected. 
Mouse options allow you to pan (ctrl + left mouse button), zoom in and out (ctrl + mouse wheel), and rotate (ctrl + 
right mouse button) the canvas display. 
iRIC provides a suite oftools for visualizing and post-processing 2D model results. Map visualizations of model 

calculated flow characteri stics are viewed in a 2D Post-processing Window ). Graphs of calculated flow 
characteristics along different grid dimensions or through time can also be generated using the Graph Window tools 

(k':.) . The Post-processing Windows and tools only become available when a simulation has been completed. 
You will become fam iliar with the basic operation and workflow in the following three exercises. The exercises 
focu on: 

• Exercise 1: The mechanics of Importing, Editing and Viewing measured data that will be used to initialize 
the model grid/mesh and can be used for model verification. 

• Exercise 2: Building Grids and mapping/interpolating your measured data onto the grid . 

• Exercise 3: Creating a simulation and editing the solver calculation conditions (parameters), running the 
model, and visualizing the results. 

Following the exercises are a set of Tutorials that will lead you through practical app lications of the FaSTMECH 
solver. 

Exercise 1: Importing Data 

Tills exercise provides familiarity with the mechanics of importing data that can be used to initialize the grid or for 
model calibration and verification. You will also learn how to visualize the data and edit the data if necessary. All 
the data and image fi les are in the iRIC Tutorials\FaSTMECH\Tutorial 1 directory. 
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Import Topography 

• 
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The topography file is the most important piece of information required to build a numerical model of the 
river reach of interest. The topography can be imported by selecting Menu Bar ->Import -> Geographic 
Data -> Elevation. 

In the Select File to Import dialog, navigate to the following folder: iRIC Tutorials\FaSTMECH\Tutorial 
1 \Exercise 1. iRJC can import several different file format ; for this tutorial select ".tpo" in the Fi les of 
Type drop down menu and select the following file: r5finpt2m114_shifted.tpo. This will open a dialog that 
allows you to filter or reduce the number of points imported into iRIC. This can be useful if your data set is 
extremely large, but for our purposes leave the default setting at I and select enter to import the entire 
dataset. 

The Pre-processing Window now displays the topography data on the canvas and the data you imported 
appears in the Object Browser under Geographic Data I Elevation I Points} (Figure 1). In the Object 
Browser the topography can be made visible or not visible by checking or unchecking the box next to 
Elevation. 

To adjust how the elevation points are displayed, select in the Object Browser Geographic Data I 
Elevation I Points] and then right click to access a dialog that allows you to edit the data name in the 
Object Browser, Export the data, Delete the data, and adjust Properties. elect Property and change the 
point size to 1 (Figure 2). 

Add a data legend for the elevation data by selecting in the Object Browser Geographic Data I Elevation 
and then right-clicking and in the resulting pop-up menu selecting Set up Scalarbar. Make sure Elevation is 
displayed in the drop down menu and check the "Visible" box. Select the "Edit... " button for additional 
features that control the legend display. Or simply left cli ck on the legend and drag to a new location. 

To change the range and intervals displayed in the data legend select Menu Bar ->Geograpl1ic Data -
>Color setting ->Elevation. This opens a dialog that allows you to change the minimum and maximum 
elevation color . (Figure 3). Uncheck "Automatic" and change the maximum to 840 to see more detail in 
the channel. 
Explore the Pre-Processing window controls using the buttons on the Maio Toolbar to zoom in and out 
and pan (See the Introduction fo r an overview). Also try the mouse options that allow you to pan ( ctrl + left 
mouse button), zoom in and out (ctrl + mouse wheel), and rotate (ctrl + right mouse button) the canvas 
display. Select Q. to center the data in the Pre-processing window and, if you rotated the view select 12 to 
restore the original orientation. 

iRlC automatically generates a triangular irregular net\¥ork or TIN of the elevation data set. In the Object 
Browser right click on Elevation I Points} and in the resulting pop-up menu select "Property ... " to open the 
Display Setting dialog that allows you to view the elevation data set as points, wireframe, or a surface 
(Figure 1). Experiment with viewing the data as wireframe and as a surface. 

Save by selecting File ->Save as File (*.ipro) from the Menu Bar . 
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Figure 1. Pre-processing Window display of the elevation data. 
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Import Images 

• Import images to placed in the background of the data. Background images can be imported from th e M enu 
Bar by se lecting Import -> Background Image. In the resulti ng Open Image fi le dialog select the fi le 
r5img9.jpg and then select Open. An error message may appear. Ignore thi s and click ok to show the image 
in the Pre-Processing window, your screen should look like Figure 4. 

• Open a second image fi le through the Object Browser by right-clicking on Background Image and selecting 
Import Images in the resulting pop-up menu. Select the fi le rSimg lO.jpg. As with importi ng Geographi c 
Data there are multiple ways to access the import functions by using the Menu Bar or by using the Object 
Browser. 

• Ideally any image you import will have a corresponding world fi le that posi ti ons the image correctly in space. 
If thi s i not the case you can adjust the image manually by rotating and scaling the image. See the User' s 
Guide for more information. 

• Save the fi le 
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Figure 4. Surveyed topography and background image. 

Simple Data Editing 

• We would like to focus on the region of the data set encompassed by the two imported images . iRIC 2.3 
provides some simple too ls for editing the data which we will introduce here. To delete the data outside of 
the two images select in the Object Browser Geographic Data I Elevation I Points I . You will see a 
number of tool icons loaded into the Operation Toolbar as in Figure 5 below. 

• To select a rectangle of points, make sure the ~ icon is selected (selected by defaul t) and left-cli ck the 
mouse and drag a rectangle whi le holding the mouse down, releasing the mouse to finish. When points are 
selected right-cli ck anywhere on the screen to bring up a pop-up menu of acti ons to apply to the selected 
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points (Figure 6). The elected points can be deleted, deleted above, or deleted below au er specified 
threshold. In this case we want to delete the points outside of the two imported images to end up with • 
points and images as displayed in Figure 7. Thus, you'll need to draw a rectangle with your mouse to 
encompass the points out ide the images. Thi wi ll take several selections. Remember to use undo if you 
make a mistake whi le editing your data points. 

• More infom1ation on the data edi ting tools can be found in the User's Guide. 

Figure 5. Data editing tools available for point 
data sets. 
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Figure 7. Image and elevation points following data point editing . 
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Import Data for Model Calibration and Verification 

Import Measured Velocity Data 

• Import data that can be used to calibrate or verify model predictions. Import measured velocity data from the 
Men u Bar select Import ->measured values. Select EM_mar7a_adcp shi ft.csv. 

• Adjust the length of the imported vectors in the Object Browser by right-clicking on Measured Values I 
C: \(path to fi le) I Arrow and selecting Property in the resulting pop-up menu. In the Arrow Setting dialog set 
the values to those in Figure 8 below . 

. .. Arrow Setting 

Color Bar Setting 

Stardard vale : ~: [m/SJ 

LEJ'gthm screen: 20 : [pixel] 

Mnirrum vale Ill craw: 0.00200 : [m/s) 

Cobr 

Q CUstom robr -

By scala- vaLe 

()I( I I carce1 1 

Figure 8. Arrow setting to set measured vector properties 

Import Measured Water-Surface Elevations 

• Import measured water-surface elevation data from the Menu Bar select Import ->Measured values. Select 
3 10 08 wse.csv. - - -

• Adjust the size of the points used to represent the water-surface elevations by right-clicking in the Object 
Browser Measured Values I C: \(path to file) I Scalar and selecting Property in the resulting pop-up menu. 
In the Scalar Setting dialog set the Point Size property to 5. 

• The resulting view with images in the background and measured water-surface elevations and flow velocities 
are shown in Figure 9. 

• Save the project 
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Figure 9. Measured ve locity vectors and water-surface elevations scalar values shown on top of geo­
referenced images. 

Exercise 2: Grids 

This exercise provides famil iarity with the process of creating a curvilinear-orthogonal gri d used by the FaSTMECH 
solver in iRIC. This exercise assumes Exercise 1 has been completed and you have some basic skills importing data 
and working with the Object Brow er to view data. 

• First create a new FaSTMECH project and import the KootMeanderShift_filtered3 .tpo topography file in 
the Tutorial1\Exercise 2 folder. This is a large file of2 .1 million points. Ifyou have a computer with 4GB 
or less memory or you have an integrated graphics board rather than a separate graphics board, you may 
want to filter the data. A good choice for filtering the data is 10, or importing every lO th point in the data 
set 

• Import the Meander2.jpg fi le (Figure 1). 

• Take a look at the data to familiarize yourself with the reach. The Kootenai River is located in orthern 
Idaho, USA. The flow direction is from bottom to top . The mean width of the river is approximately 200 
meters. However there is an island towards the top of the reach and the width of the l\¥o channels plus the 
island increa es to approximately 800 meters. 
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Creating a Numerical Grid 

Kootena i River topography and image. 
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iRIC contains a number of different methods to generate grids fo r the many different iRlC solvers. The FaSTMECH 
solver uses a structured curvilinear orthogonal grid. This type of grid can be created in three basic steps: define the 
grid centerline, specify the width and density of points in the grid, and refine the curvature and location of the grid 
until a satisfactory result is achieved. The result of the process wi ll be a channel-fo llowing grid that looks something 
like that in Figure 2. 

Create the Curvilinear Grid: 

• In the Menu Bar select Grid ->Select grid creating algorithm. In the Select Grid Creating Algorithm di alog 
(Figure 3), select "Create grid fro m polygonal line and width." ote that a brief description or instructions 
for creating the grid are given in the Description pane. Cli ck OK. Another dialog wi ll open providing 
further instructions on using this function. Cli ck OK. 

• To draw the centerline, cli ck the left mouse button in the des ired locations starting at the up tream most point 
of interest and ending at the downstream. Figure 4 shows the start of this process. ote that the center! ine is 
always drawn from upstream to downstream, and Upstream and Downstream labels are affixed to those 
points as they are drawn. In this case flow is from lower right to upper left. At any point in the process of 
drawing the centerline you can use the Pan (Ctrl+Left Mou e) and Zoom (Cntrl+Middle Mouse) functions 
without affecting the placement of the grid center-line. In other words, using the Ctrl key to affect a Pan or 
Zoom wi ll interrupt the center-line process but not break it. When finished press "Enter" on the keyboard. 

• The Grid Creation dia log allows you to specify the number of nodes in the stream-wise direction, n1, the 
number of nodes in the cross-stream direction, n1, and the width of the grid, W (Figure 5). Set the grid 
width to 800 meters and define the number of points in the streamwise and cross-stream dimension to give 
corresponding increments of about 20 meters (disp layed by d1 and dJ)). Use the Apply button on the di alog 
to dynamicall y view of the result of your grid parameters incrementally to find the desired spacing of nodes 
in the stream-wise and stream-normal directions. Select OK when you are done. 
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• In this case it is likely that you will get the following warning, "Grid shape is invalid. Modify grid • 
creating condition, and try again. Select OK to dismiss the wanung. This occurs when the 
streaml ine curvature of the grid centerline is high relative to the width of the grid and results in the 
grid overlapping on itself as in Figure 6. 

• A Confirmation message "Do you want to map geograpruc data to grid attributes now?" follows. In this 
case we will decline by selecting No. We want to modify the location and curvature of the grid which is 
likely in tills case to take many iterations. To disable the automatic mapping of geographic information 
from the Menu Bar select Grid ->Attributes Mapping ->Setting and in the resu lting Grid Attribute 
Mapping Setting dialog, select Manual for the Execute Mapping property. 

• To adjust the centerline to better fit the grid to the data or as in the case here, adjust the curvature of the grid 
to remove overlapping nodes. In the Object Browser select Grid 0 I Grid Creating Condition. This is 
necessary to edit the grid. The center-line and points defining the center-line should be visible. When the 
mouse is placed over the center-line or over a center-line point, the mouse cursor changes to a closed hand, 
and if the left mouse is clicked and dragged, it will move the center-line or center-line point. Experiment with 
adjusting center-line points to remove the overlapping grid nodes. If you make a mistake Ctrl+z will undo 
and Ctrl+y will redo the previous action. Continue adjusting the center-line unti l there is no overlap of the 
grid. Additional utilities to add or remove points are also available and will be discussed in Tutorial 1. 

• Save the project. 
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A user-defined grid following the channel of the Kootenai River. 
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. ' Grid Creation 
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Figure 5 . 
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The Grid Creation dialog 

Figure 6. Curvil inear grid with grid overlap. 
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Figure 7. Grid after editing the location of centerline points to refine the curvature and eliminate 
overlapping grid nodes as shown in Figure 6 . 

Mapping Geographic Data To The Grid Attributes. 

In the Object Browser, every branch in the Geographic Data tree has a corresponding branch in the Grid I Node 
attributes. Imported data into each branch of the Geographic Data, such as Elevation in thi s case, is interpolated to 
the grid by one of several methods described below. The FaSTMECH solver has several branches under the 
Geographic Data however, only Elevati on is required. The possible use of the other branches is discussed 
throughout the Tutorials. Once you are satisfi ed with your computational grid, you can map or interpolate measured 
elevations to each node of the grid. There are two algorithms to do this. See the User 's guide for a more detailed 
explanation of each. 

1. The first u es a tri angular-irregular network (TIN), a surface defined by a set of contiguous, non­
overl apping triangles, generated by a Del au nay Triangulation of the imported data. The va lue at each node 
of the grid is determined by finding the tri angle that contains the grid node and linearly interpolating the 
value based on the values of the three verti ces of the tr iangle. 

2. The second is based on a nearest neighbor approach that utili zes a template with a user-defined width and 
length, where the length fo llows the loca l curvature of the grid . Interpolated values are assigned the inverse 
distance weighted average of all measured points in the bin . 
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Figure 8. 

Mapping With TINs 

Elevation mapped to the grid using the TIN Algori th m. 

1~-1 O.y __ _ 

• In a previous step above we set the Grid ->Attributes Mapping ->Settings to Manual. A setting of Auto would 
result in the application mapping the geographic data after every edit to the grid . The Manual setting now 
allows us to choose when to map the geographic data. Do that now by selecting from the Menu Bar Grid -
>Attributes Mapping ·>Execute. Select OK when notified that mapping is complete. ode attributes will be 
added to the Object Browser in Grid I ode attributes. Expand the ode attributes and make sure that 
Elevation is selected so you can view the results (Figure 8). 

• Save the Project. 

Mapping With the Template Method 

To illustrate the template method we'll open a new FaSTMECH project with elevation data that was dominantly 
collected as cross-sections. In this section you will also learn how to import a non geo-referenced image and stretch, 
rotate and translate the image so that it fits the measured topographic data 

For this exerci e you have two options. Option 1) Start from Part 1 below and learn how to pan, stretch, and rotate 
an image to fit your data or Option 2) Open an existing project with topography and background image already fit to 
the data. 
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Option 1 

1. 

2. 

3. 

4. 

From the Menu Bar select File -> ew Project. Select the FaSTMECH olver. 

In the Object Browser left-click then right-click on the Geographic Data I Elevation and in the resulting pop­
up menu select Import and open the ketchupi sl.tpo file . 

From the Object Browser right-click Background Images and select Add Image Ln the resulting pop-up menu 
and open ketchup2 .jpg (Figure 9). 

To adjust the location of the image select Background Images I Ketchup2 .jpg. In iRIC whenever you want to 
edit data whether it's Geographjc Data, Grid Creating, or Images, the object that is selected in the Object 
Browser is enabled for editing. 

5. When Background Images I Ketchup2.jpg is selected, the left mouse button will pan the image, the mjddle 
mouse button scales the image, and the left mouse button rotates the image. Experiment with these tools to 
fit the image to the data (Figure I 0). 

6. Continue with Option 2 -step 2. 

Option 2 

I. From the Menu Bar select Fi le -> Open and find the fo llowing project file iRIC 
Tutorials\FaSTMECH\Tutorial 1 \Exercise 2\ Ketchup.ipro. 

2. From the Object Browser right-click Grid I Grid Creating Condition and in the resulting pop-up menu Select 
Algorithm for Creating Grid , and then select "Create grid from polygonal line and "'~dth ". Flow direction is 
from bottom to top. Draw a center line and create a grid with a width of 450 meters and discretization along 
the center line of 10 meters (Figure 11) . 

3. From the Menu Bar select Grid ->Attributes Mapping ->Setting In the Grid Attribute MappLng Setting 
djalog select the "Template mapping" option and then select the "Detail ... " button. Set up the following 
di alog similar to Figure 12 and cli ck ok. 

4. From the Menu Bar select Grid ->Attributes Mapping ->Execute. View the results and experiment with 
different template dimensions to see the differences in the mapped topography (Figure 13). Save your best 
effort to compare Mth TIN mapping below. Click on in the Main Tool bar to save an image. 

5. Compare the template mapping to the TIN mapping. Go back to the Menu Bar and select Grid ->Attributes 
Mapping ->Setting, and set the mappi ng algorithm to TIN. Execute the Tin Mapping by selecting from the 
Menu Bar Grid ->Attributes Mapping ->Execute. Cli ck on in the Main Toolbar to save an image and 
compare Mth the image taken of the Template Mapping above (See Figure 13 and 14). 

6. Save the file . 
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Figure 9. A non-geo-referenced image imported into iRIC. 
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Figure 10. The background image fit to the data. 
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Figure 11. Location of the grid. 
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Number of Template Expansions : Ll3 __ ~_1 

Weighting Exponent: , 1.0 ~ I 

OK ] [ Cancel 

Figure 12. Template mapping dialog 
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Figure 13 . Elevation mapped to the grid with the template algorithm. 
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Figure 14. Elevation mapped to the grid with the TIN algorithm 
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Edit Data to Improve Mapping 

Topography collected in the field may not fully resolve the channel. iRIC provides a set of tools that can be used to 
improve the mapping. Wl1en any point data set is selected in the Object Browser under Geographic Data, the 
Operation Tool bar (Figure 5)' shows a suite of tool that can be used to add points using a simple point adding tool 

·~, interpolating between known points· ~ ' , or setting breaklines ~ to the TIN. In this part of the exercise we will 
briefly introduce these tools and provide an example that shows how they may be used to improve the mapping of 
Geographic Data to the Grid I ode Attributes. 

• ow that you 're an expert, start a new FaSTMECH project: 

o Import the elevation data set CotLower.tpo. 

o Import the geo-referenced linage fi le output_mosaic.jpg. 

o Create a grid with a width of200 meters, and an approximately 5 X 5 meter cell dimension along 
the centerline (flow is from left to right). 

o Map the Grid using the TIN with a result that shou ld look similar to that shown in Figure 15. 

• Figure 16 shows a zoomed-in image of the downstream, river-right section of the grid, shown as a red box 
in Figure 15. Because of the way the TIN algorithm creates triangles, cusp can be formed along the banks 
of the channel as shown by the zig-zag line in Figure 16. 

• To provide some insight into how these cusps are formed in the Object Browser turn off Grid I ode 
Attributes I Elevation. Also in the Object Browser right click on Geographic Data I Elevation I Points! 
and in the resulting pop-up menu select Property and then in the Display Setting dialog select Wireframe as 
the Display Method (Figure 17). It is clear that the cusping origmates from the elevation values mapped 
onto the grid from the TIN which has tr iangles with vertices located on the bank and channel essentially 
pulling high bank topography into the charmel. 

• We will use two technjques to improve the TIN and thus the mapping of elevation to the computational 
grid. 

o Breaklines: A breakline is drawn between two or more points. Wl1en the TIN is re-meshed edges 
of the triangle are enforced to conform to the breaklines. Also the value along the breakline is a 
linear interpolation of the bounding points. We will be editing Geograpruc Data I Elevation I 
Points! so make ure that is selected in the Object Browser. We want to separate the charmel 
from the bank so we wil l create a breakline along the base of the bank following the pomts with 
lower topography or in tlus case cooler colors (b lue as opposed to green or yellow). 

0 

• Select the breakline tool in the Operation tool bar(~) and draw a break line between the 
four points shown in Figure 18. ote that as you move the mouse the point to be selected 
is rughlighted. Make sure to select points at the bottom of the bank. 

Re-mesh the TIN to reflect the breakline by right-clickjng anywhere in the Grapruc View 
and ill the resulting pop-up menu selecting Remesh TINs. ote that the edges of the 
triangles in the TIN now confonn to the breakline. 

Remap the Geographic Data to the Grid by selecting from the Menu Bar Grid I 
Attributes Mapping 1 Execute. The result of the mapping is shown in Figure 19. 

I • I 
Interpolation: The interpolation tool ( ~ )can be used in one of two ways . Fir t, to interpolate 
linearly between known pomts at a specified interval and second, to interpolate between known 
points by a user defined path. In both cases, select known points with a left mouse click and define 
a path between existi ng points by holding the Ctrl key whi le left clickjng to define the path 
between points. 

In the Object Browser select Geograpluc Data I Elevation I Points!. This enables the 
data editing toolbar (See Exercise 1 - Figure 5) . 
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Select the interpolation too l [( . Select the same points as selected above for the breakline • 
and select Enter when Finished. In the resulting dialog enter 3 for the "Set Interpolation 
Increment". 

Right-click anywhere in the Graphics View and in the resulting pop-up menu select 
"Remesh TlNs". Right-click on Geographic Data I Points 1 in the Object Browser and 
select Property. Change the Display method to Wireframe and view the results (Figure 
20). 

From the Menu Bar select Grid-> Attribute Mapping -> Execute. View the result in 
Figure 21 and compare with Figure 19. 

• Save the project. 

' C.tdt.r...-nQC.ondoaon 
C.HI ... ,.. 

.. ., lklo<» .. no....,_ 
, o..,_, -­.,.., 

J Gt .. ~ 
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Figure 15. Location (red box) of reach that displays cusping along the bank. 

22 
FaSTMECH Tutorial 1 

iRIC Phoenix 2016 22 of252. 

• 

• 



• 

• 

• 

• UIUWI·IIICJISThC~·~Wirlclooo' 

I • htr ...... , tifoooo~tl,o&o Gold 1._;;;\o ... < ... .,_;c ...... .., S.ul- ,.....,_.......,. V..W o.-- H.tp-
llll a ¥ ""'1 ... ~ ., ... ... , ••••:: ,. • . ,. " •(I --~ " o.;.J C..0W .. "''"""' 

~ ., ~ , ... -
' -· --"c.~ .. ,....,.._ 

"S.OOOCU•.oc-
~ " Gttdiiiii•"J·J~· 

" (jood( ...... ( ....... Dn --' .... _ J­J-
J ~~ J ....,., 
.J 1.Md..~«I(Oft ,_,_ 

1«1~-.. 
, .J ..,.~-.. 

.. .J "-t 

Figure 16. Cusps along the bank from the TIN algorithm 

,.._ 
" ' .J ~4Jhcl\l&.l 

• J ,..J O,.,-

' -· I ..J IIougl.-

' '""' .I ...J C...w.o-

' .J s-t.."""* 

-­,, .. 
~~ ........... 

, .... .......... '1"11 ......... 

" l .;.i iMiogl_.t .. o~QoH 

' """"" ... 

FaSTMECH Tutorial 1 

Figure 17. The TIN and location of cusps . 
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Figure 19. 
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Figure 18. Location of breakline (black line). 
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Figure 16. 
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Figure 21. The topography mapped to the grid following the addition of an interpolation breakline. 
Compare with Figure 19 . 
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Exercise 3: Defining Calculation Conditions and Post-processing 

The last exercise illustrates the process of creating a simulation and provides an introduction to post-processing 
the results. You will set the calculation conditions for the simulation, run the simulation, and view the results in 
a variety of ways. We will look at a reach of the Colorado River in Grand Canyon ational Park. The 
simulation includes a large lateral recirculation zone on river left. Flow is from upper-right to lower-left. ote 
that there are measured water-surface elevations and velocities in the project and a grid has already been created 
for you . 

... -
J -1 -" Jrl::li1:JCIIft! '-· --' """' " e (,r..:.-
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' ........ ~ 
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~ ., • k,QII..,.q'l 
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" r-.!tJIIP9 
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Figure 1. Domain for Exercise 3 including the measured velocity and gridded elevation. 

Defining Calculation Conditions 

• Open an existing project fro m Menu Bar by selecting File ->Open and select the Ex3. ipro project file in the 
Tutorial 1\Exercise 3 folder (Figure 1). 

• To define the calculation cond itions select Menu Bar select Calculation Conditions ->Setting. Enter the 
paran1eters as shown in Figure 2. Select Save and Close when you are done. 
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Figure 2. A. Discharge, B) Stage, C) Roughness, D) Lateral Eddy Viscosity, E) Grid Extension, F) Initial 

• 

Condition , G) Wetting and Drying, H) Solution Parameters, I) Solution Relaxation Coefficients , J) 2D 
Solution Output, K) Quasi 3D Solution, L) 3D Solution Output.. 

To run the simulation from the Menu Bar select Simulation ->Run or cli ck on the .. button. The warning 
dialog will open to a k whether you wish to ave the current project. Select OK. After the project saves a 
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Solver Console will open. This Console shows information about the simulation as the calculation is 
running. A di alog open to notify you when the calcu lation is complete. Cli ck OK to close the dialog. 

20 Post-processing 

Calculation results can be viewed by opening a new 2D Post-processing Window by selecting Calculation Results ­
> Open new 2D Post-processing Window from the Menu Bar or by selecting the . button on the Mai n Tool bar. The 
Post-processing window is organized in a similar way as the Pre-processing Window with an Object Browser and 
canvas. The Object Browser in a Post-Processing Window allows you to control the display of calculated flow 
characteristics such as depth, water-surface elevation, and velocity as well as to display arrows (vectors). 

Displaying Scalar Resu lts 

Scalar results show the magnitude of various flow characteri stic through contour plots. 

A 

• To begin with in the Object Browser turn off Measured Values. 

• In the Object Browser select the check box next to Depth. 

• otice that the entire grid is contoured. To mask the contour to the nodes of the grid that are wet, 
from the Object Browser right-cli ck on FaSTMECH Grids I iRICZone I Scalar and in the pop-up 
menu Select Property, and in the resulting calar Setting dialog (Figure 3A) select the Region 
Setting button. 

• In the Region Setting dialog (Figure 3B) select the Active Region radio button and then select OK. 

• In the Scalar Setting Dialog set the Display Setting Attribute to Contour Figure and take note of 
other attributes that can be set from this dia log including the min, max, and number of intervals for 
the contour. Select OK when finished . 

• In the Object Browser turn the Background ln1ages on. The result shou ld look like Figure 4. 

• Change the display of the legend or scale bar by selecting the Color Bar Setting button in the Scalar setting 
dialog (Figure 3C). 
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A) Scalar Setting dialog and associated B) Region Setting , and C) Color Legend Setting 
dialogs . 
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• In the Object Browser turn on Arrow I Velocity. At first the vectors will be hard to discern so we ' ll adjust 
their size, then adjust their plotting increment to make them easier to see. 

• Access the Arrow properties by right-clicking on Arrow in the Object Browser and selecting 
Property in the resulting pop-up menu. 

• In there ulting Arrow Setting Dialog (Figure SA) in the Length attribute deselect the Auto 
property and set the Length on screen property to 25 pixels. In the Sampling attribute select the 
Sampling rate radio button and set the ampling rate property to 2 in both the 1- and J- direction. 
The result is shown in Figure 5B. 

• Alternatively set the Arrow Setting attributes as in Figure 5C with a result shown in Figure 5D. 

Compare Measure Velocity Vectors to Solution Vectors 

• In the previ.ous step you set the Arrow Setting attributes a in Figure 5D. To compare the measured velocity 
vectors with the solution vectors we want to scale the measure vectors the same as the solution vectors . In 
the Object Browser select Measured Values I C\: ( your path) I Arrow and then right-click and in the 
resulting pop-up menu select "Property ... ". Set the length property attributes to the same ones in Figure 5C 
such that both the measured and so lution vectors have the same scale. Change the Custom Color attribute 
to red . 

• The result is shown in Figure 6. 
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Solution vectors (Black) and measured vectors (Red). 
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Introduction 

In this tutorial you wi ll use the FaSTMECH solver in the iRIC application along with measured topography 
and water-surface elevations to model flow through a reach of the Green River in Utah. This tutorial wil l 
demonstrate the fol lowing tasks necessary to complete a simulation : 
• Getting Started 

o Introduction to navigating the iRIC interface 
• Pre-processing 

o Importing geographic information 
o Creating a numerical grid 

• Defining the Calculation Conditions and Running a Simulation 
• Post-processing 

o Visualizing resu lts 
o Graphing results 

• Model Calibration and Model Refinement 
o Developing a calibration curve 
o Spatially variable roughness 

Getting Started 

• 

• 

Launch iRIC 2.3 by selecting iRIC 2.3 from the Program Menu list or click on the iRIC icon on the desktop. • 
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• 

The iRIC Start Page (Figure. 1A) opens and displays several options to start a project under the Start 
Simulation Project tab: 

Create New Project-allows you to select the solver you wish to use from a list of solvers currently 
available in the application or to select the solver from a list of recently used solvers. 
Open Project File-allows you to open an existing project using a browser window or to select 
from a list of recent projects. 

Select the Create New Project button wh ich opens the Select Solver dialog window (Figure. 1 8). Highlight 
FaSTMECH and click the OK button . 

A 

Weko!JetoiUCI LJiRIC 
RIC c..-.-.wte riwu from C!Dado Rlvef to tte Nle. 

[ St! rt Simulation Project I 
I Create New Project ... 1 

Recent Solvers: 

) FoSTMECH 
~ 'P' I'IIJO!Iall'lan Nelson 

Support 

I Open Proj<oct Rle .. . 1 

Recent Projects: 

.1J2!l 

8 

'M1en you aeate a new projeCt. you have 10 select d-e solver to use fa" cabJiaoon. PEase select a 
solver, .rd l)'"ess "'C" bunDn. 

Name FeSTp.£0f 

....... 1.0 

CCJPYI'iC:tt JoMthan Nekon 
Release 2009/11/01 
~ ttsp 1/wrm gosp: sg. p f 

"""-' I ...... I 
Apache lMC:at 
Copyrtolt 1~2'009 The Apache Softw.e Fo.rdation 

Tm pro6.d. rdlde5 ~.developed by 
The Apache Software Fou1datian ~:/f'-w.~.orgf). 

The Windows lnstaler is b.* wth tte IUKit. 
Scrtlteblelnsta1Sy$«n(NS1S), wNch is 
open 5CU'CO sott-e. The orighal software and 
related Wormatlon Is evalable ot 
httD://Nrs.SOI«loroe.net. 

Java COft'debon sottw.e for JSP paoes ls Pf'CMded by Ec:lpie, 
¥hct! s open scuce sdtware. The croNI software and 
relatedWometiDnili.walab6eat 
t'ttp://Www . .--.OI'IIJ. ~ 

Figure 1. Shows the iRIC Start Page (A) and the Select Solver Dialog (8). 

Pre-Processing 

Importing Topography 

The measured topography is the most important piece of information requ ired to create a numerical model 
of the river reach of interest. Ideally the elevation data will extend well beyond the specific area of interest 
and be of sufficient spatial resolution for the application . 

• Topography can be imported through the Menu Bar by selecting File..,.. Import..,.. Geographic 
Data ..,.. Elevation. In the Select File to Import dialog, navigate to the following folder: iRIC 
Tutorials\FaSTMECH \ Tutorials\ Tutorial 2. iRIC can import several different file formats ; for this 
tutorial please select ".tpo" in the Files of Type drop down menu and select the following file: 
"GR_ Topo_Shifted.tpo". This will open a dialog that allows you to filter or reduce the number of 
points imported into iRIC. This can be useful if your data set is extremely large, but for our 
purposes leave the default setting at 1 and select enter to import the entire dataset. 

• The Pre-processing Window now displays the topography data in the canvas and new data 
appears in the Object Browser under Geographic Data I Elevations I Points1 (Figure 2). In the 
Object Browser the topography can be made visible or not visible by checking or unchecking the 
box next to Elevation . Add a scalebar from the Menu Bar by selecting Geographic Data ..,.. Set up 
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Scalarbar. Make sure Elevation is displayed in the drop down menu and check the Vis ible box 
(Figure 2) . 
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Figure 2. Pre-processing Window display of the Elevation data. 

• To adjust how the elevation points are displayed, highlight Elevation 1 Points1 in the Object 
Browser and right cl ick. This will bring up a dialog that allows you to rename the data in the Object 
Browser, Export the data, Delete the data , and adjust properties. Select properties and change the 
point size to 2 (Figure 3). 
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Figure 3. Display Setting dialog to select graphic attributes for the Elevation data 

• Save (for example, Tutorial 2) by selecting File ~Save as File (* .ipro) from the Menu Bar. 
• Import an image to place in the background of the data. Background images can be imported 

through the Menu Bar by selecting Import ~ Geographic Data ~ Background Image. In the 
Open Image dialog select the Green River.jpg file . The image will be displayed in the canvas 
(Figure 4). To turn the image off, uncheck Background Images in the Object Browser . 
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Figure 4. Addition of the background imagery. 

Importing Measured Water Surface Elevations 

.. , 

• To verify the modeled water-surface elevation , you need to first import measured water-surface 
elevation data. Select Import ~Measured Values from the Menu Bar. Select the file 
"GR_wse.csv" in the File Open dialog. The data is added to the Pre-processing Window Object 
Browser under Measured Data. 

• You will see that importing the measured data adds a legend by default. To turn the legend off in 
the Object browser select and right click on Measured Values 1 C:\(path)\wse.csv I Scalar and in 
the resulting pop-up dialog select Property. In the Scalar Setting dialog select the Color Bar 
Setting button , and then deselect the Visible attribute . 
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Creating a Numerical Grid 

All solvers require a computational or numerical grid to perform the calculations. iRIC contains a number of 
different methods or algorithms that can be used to generate the grid you need for your model. The 
FaSTMECH solver uses a structured curvilinear-orthogonal grid. A curvilinear-orthogonal grid defaults to a 
recti linear grid when only two points define the centerline. This type of grid can be created in three basic 
steps: define the grid centerline, specify the width and density of points in the grid , and refine the curvature 
and location of the grid until a satisfactory result is achieved . 
When creating a grid there are a number of things to keep in mind; 1) Keep the grid within the bounds of 
the data; 2) Define the upstream and downstream boundary of the grid beyond the area of computational 
interest to account for the effects of upstream and downstream boundary conditions; 3) Locate the 
upstream and downstream boundaries (the edge of the grid) in areas where flow is as uniform as possible. 
Avoid areas of recirculating flow or abrupt transitions in the bed or width; 4) Orient the upstream and 
downstream boundaries perpendicular to the main flow direction; 5) Select a grid width that minimizes the 
amount of the grid outside the active channel , therefore maximizing the number of nodes in the grid 
contributing to the solution; 6) Insure that the grid does not overlap itself in the active channel. The 
application will give an error if the grid overlaps. 

Create grid : 

• To better view the data, click on the bottom right corner of the Pre-processing Window and expand the 
window or select the maximize button along the top of the Pre-processing Window to expand the 
window. 

• In the Menu Bar select Grid ..,.. Select Algorithm to Create Grid. This opens a dialog (Figure 5), select 
"Create grid from polygonal line and width ." Click OK. Another dialog will open providing instructions on 
using this feature. Click OK. 

-----~'-· 

Figure 5. Example of the Select Grid Creating Algorithm dialog. 

• To draw the centerline, click the left mouse button in the desired locations starting at the upstream 
most point of interest and ending at the downstream (Figure 6). The upstream end of the channel in 
Figure 6 is at the bottom right and the channel centerline should be drawn in the direction from lower­
right to upper-left. When finished press "Enter" on the keyboard . Use Figure 6 and the blue water­
surface points on the background image as a guide in selecting the boundary locations. 
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Figure 6. Location to draw centerline. Flow is from bottom to top so start at the lower end of the 
channel and select points ending near the top of the channel. 

• A new dialog opens that allows you to specify the number of nodes in the stream-wise direction, n1, the 
number of nodes in the cross-stream direction, nJ, and the width of the grid , W (Figure 7). Set the grid 
width equal to 360 meters and define the number of points in the streamwise and cross-stream 
dimension to give corresponding increments of about 5 meters (displayed by d1 and dJ)). The distance 
between nodes in the stream-wise direction along the center line and the cross-stream direction is 
constant everywhere on the grid . Use the Apply button on the dialog to dynamically change the view of 
the grid to find the desired spacing of nodes in the stream-wise and stream-normal directions. Select 
OK when you are done. If you need to return to this menu, select Grid ..,.. Create Grid from the Menu 
Bar. 

• " Gnd CreatiOn 

n,: ""' : d1: 1~03796 
nJ 12 • dJ ..-, --

W: 360.CIXI:: m 

~~~ 

Figure 7. Grid Creation dialog that allows you to specify grid characteristics. 

• A Confirmation message "Do you want to map geographic data to grid attributes now?" follows . In this 
case we will decline by selecting No. We want to modify the location and curvature of the grid which is 
likely in this case to take many iterations. To disable the automatic mapping of geographic information 
from the Menu Bar select Grid ..,.. Attributes Mapping ..,.. Setting and in the resulting Grid Attribute 
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Mapping Setting dialog, select Manual for the Execute mapping property. Your grid should look similar • 
to Figure 8 

Figure 8. Example grid for the Green River. 

• To adjust the centerl ine to better fit the grid to the data or as in the case here, adjust the curvature of 
the grid to remove overlapping nodes, in the Object Browser select Grid() I Grid Creating Condition. 
This is necessary to edit the grid. The center-line and points defining the center-line should be visible. 
When the mouse is placed over the center-line or over a center-line point, the mouse cursor changes to 
a closed hand, and if the left mouse is cl icked and dragged, it will move the center-line or center-l ine 
point. Experiment with adjusting center-line points to remove the overlapping grid nodes. If you make a 
mistake Ctrl+z will undo and Ctrl+y will redo the previous action. Continue adjusting the center-line until 
there is no overlap of the grid 

• Adjust the grid so that the upstream and downstream boundaries are roughly perpendicular to the 
channel and the upstream and downstream extent of the grid encompasses the measured water­
surface elevations. Be careful at the upstream end because the measured water-surface elevation is 
right at the limit of the measured elevations. Extending the grid too far upstream will result in poor 
elevation values at the upstream end of the grid . 

• Add or remove centerline points by selecting Grid ...,.. Grid Creating Condition on the Menu Bar and 
select the option you need. Be aware that new centerline points must be added along the current line; if 
you cl ick too far away from the centerline no points will be added. 

• Your result should look simi lar to Figure 9. 
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Figure 9. Edited grid location. 

Mapping geographic data to the grid attributes . 

Once you are satisfied with your computational grid, you need to make sure that elevation is specified for 
each cell on the grid . There are two ways to do this. The first method uses a triangular irregular network 
(TIN) to interpolate the elevation data at each grid cell. The second method is based on a template that 
uses a nearest neighbor approach to interpolate. In a previous step we set the mapping algorithm to the 
template method. 

• We need to set the width and length of the template. From the Menu Bar select Grid ..,.. Attributes 
Mapping ..,.. Setting. This opens the Grid Attribute Mapping Settting dialog . We previously set the 
Execute attribute to Manual and the Mapping attribute to Template. Select the Detail button near 
the bottom of the dialog (Figure 1 0). 

FaSTMECH Tutorial 2 

~ Grid Altnbute Mapping Setting [1}~ 

Exeo.te-

0 AtJ.o 
'Nhen the r;,kj is created, you eYe asked whether to executa 
Attrb.Jte MappnQ eveyttre. 
o~ 
Attrb..te mappno Is executed oriv when you manuo!lly select "Exeate • 

Geoor"*"daU-
0 --..wthTIN< 

TINs aeated from oeot7.!1Phc data Me used for m.!ClPI"'Q. Grid nodes 
attrb.te valles ,ye cak:Wted as !Yeictted aver.,ge d the vak.Jes at 
the TINnodM. 

0 , ......... _... 
Find Q1!1C9'epfic data pol'ts that Me near to the g1d node$, regerci"IQ 
the gid eel shapes, and use the vak.Jes at those poi'ts for .. ..-. 
Ths ~eM be used c:riy for structu'ed gids. 

~ 
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Figure 10. Grid Attribute Mapping dialog 

• This opens the Template Mapping dialog. Set the Search region to Manual and set the other 
attributes to the same values as Figure 11 and select OK. The topography/bathymetry data set has 
a high density of points , and we could simply use the option to map with the TIN, however, there is 
quite a bit of noise in the data so we choose here to sl ightly smooth out some of the noise by using 
the template with a size of 25m and 5m in the stream-wise and cross-stream directions 
respectively . 

• 
B Template Mapping Setting ~ .&:1. 

Search region 

" Marual 

Straa.,..wise length(m]: SO.CDJ 

Cross-stream wttth[m]: s.cm 

""mber ofle,.,late Expansicns : 3 ; 

ll>!i<tlthg EJ<ponert: 1.0 ; 

I oc I I c.n:., 

Figure 11. Template Mapping Setting Dialog 

• To execute the mapping method, select Grid ~ Attributes Mapping ~Execute from the Menu Bar. 

• 

Select OK when notified that mapping is complete. Node attributes wil l be added to the Object 
Browser under the other Grid features. Expand the Node attributes and make sure that Elevation is • 
selected . 

• You wil l likely need to adjust the Color bar so you can view the resu lts of mapping elevation to the 
grid. From the Object Browser select and right-cl ick on Grid() I Node Attributes I Elevation and in 
the resulting pop-up menu select Property. In the Grid Node Attributes Display Setting dialog 
uncheck the box next to automatic. Set the max value to 449 and the min value to 444. Set the 
Contour setting attribute to Contour Figure. Select OK to obtain results that look like Figure 12 . 

. ·-'-. , ... _ -·­·-­-·-
-==~ -. -~-

. ... ..,._loo.., ·-. .,.(-.._ . -· 

Figure 12. The resulting computational grid with the measured elevations mapped to the grid. 

• Save the Project. 
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Defining the Calculation Conditions and Running a Simulation 

Once the grid is complete, the next step is to set up the required information, or calculation conditions, for 
the FaSTMECH solver. 

i 

A 
i 

c 

• In the Menu Bar se lect Calculation Conditions .,... Setting. This opens the Calculation Conditions 
dialog. The left window of the dialog displays the primary parameter groups that can be set using 
the FaSTMECH solver. Values for various parameters are entered in the fields on the right side of 
the window. 

• Enter the required parameters based on the values in Figure 13 and select Save and Close when 
complete. 
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lD Soluoon OutpUt 2D Solunon Output 
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Stage Ra.ifness 0151rb..rt.a"l lea-. .... · ! 

Grcx..ps 
leon.""' · I Dmharge 
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Figure 13. FaSTMECH Calculation Conditions dialog . (A) Discharge, (B) Stage, (C) Roughness, (D) 
Lateral Eddy Viscosity, (E) Grid Extension , (F) Initial Conditions , (G) Wetting and Drying , (H) Solution 

Parameters, (I) Solution Relaxation, (J) 2D Solution Output. 
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• From the Menu Bar select Simulation ..,.. Run . The warning dialog will open to ask whether you 
wish to save the current project. Select OK. After the project saves a Solver Console will open. 
This Console shows information about the simulation as the calculation is running (Figure 14). Note 
that the Solve Console displays the "mean error on discharge ." Typically this value should 
decrease as the simulation converges until it reaches a low value (typically values less than -3 
percent) and stabilizes. A dialog opens to notify you when the calculation is complete. Click OK to 
close the dialog. 

• If the solution fails an error message will be displayed in the Solver Console and you must select 
from the Main Toolbar and then in the Menu Bar select Calculation Conditions ..,.. Setting and make 
sure your setting are correct (See Figure 13). 

Sofo.er Comolt IFaSTMECHJ (sto()I:M'd) 
:Iteration: "' He-an Error on Oie<:he.rge: l..l-6486717875800 
:Iten.tion: ,. Mean Error on Di:~c:hu·ve: 1.154649909!574 65 
:Iteration: "' Mean Error on Oiac:harge: l..UJJJ539294096 
:Iteration: ,. Mean r.:rr-or on Dieehu:ge: l..lJ8'7903302Z052 
:Iteration: 91!.1 Haan Error on Oiac:harge: 1 . .14290059718906 
l:terat.i.on: ... Mean l!:rror on Oiac:!,.rve: 1. Ul.6!58Jl.St7601 
:Iteration: 901 Mean En~ or on Oiac:hu:ge: l..Dl.U95l.S99975 
Iteration: 982 Mean Error on Diac:harge: L U.1948117632U 
Iteratl.on: .. , Moan Error on Diac:hargo: 1.10513946128219 
:Iteration: ... Mean Error on Diaeharc;~e: l..096U196900l.26 
I.teration: .. , He an Error on Diac:horga: 1. 09609299519278 
:Iteration: ••• Mean t!!rror on Oi:~charge: l.l.O!il.SB20202SJZ 
:Iteration: 987 M11an t!!rror on Di:~eharg~~:: .1. Ll.9267Jl.055924 
:Iteration: 9B8 Mean error on Oi.!lehargoe: .1 . .12B0401SS92BBB 
:Iteration: ••• Mean error on Di.!lc:harge : .1 . .1JS73641.2B0257 
:tterat.i.on: ... Mean error on Di•charg:~~:: .1 . .1440.1094554270 
Iterat.ion: "' Mean error on Oi.=ochargc: l..l.5SS35422JOU4 
:tteration: 992 Mean error on Oi:~charge: .1 . .177746.1422.1720 
Iterat.ion: .., M11an error on Oi:~charge: l . .1685556l2Z.1BSJ 
Iterat.1.on: 994 Mean error on Oi.!leharge: .1 . .1682B66JUJ9Sl 
:Iterat.ion: 995 Mean error on Oi.!lcharge: .1.161.93874'708400 

996 Mean error on Oi:~eharge: l..l6"7617:!lSllSBJ2 
:rterat.ion: 997 Mean Error on Oi.!lcharge: .1 . .16l.l23007066SO 
Iterat.l.on : 998 Mean error on Oi:~charqo : l..H9193S49H770 
I:terat.ion: 999 Mean Error on Oi.!leharge: .1 . .13"148264348338 
Iterat.ion: .1000 Mean Error on lh.:~eharge: l..l.24U986286418 

Figure 14. Example of the Solver Console. 

Post-processing 

iRIC provides a complete suite of tools for visualizing 20 model results. Map visualizations of model 
calculated flow characteristics are viewed in a 20 Post-processing Window. Graphs of calculated ftow 
characteristics along different grid dimensions or through time can also be generated using the Graph 
Window tools. The Post-processing Windows and tools only become available when a simulation has been 
completed . 

Map Visualizations 

Calculation results can be viewed by opening a new 20 Post-processing Window by selecting on the 
Main Toolbar. The Post-processing window is organized in a similar way as the Pre-processing Window 
with an Object Browser and canvas. The Object Browser in a Post-processing Window allows you to 
control the display of ca lculated flow characteristics such as depth, water-surface elevation , and velocity as 
well as to display arrows (vectors). 

Displaying Scalar Results 

• Scalar results show the magnitude of various flow characteristic through contour plots. 
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• In the Object Browser select the check box next to iRICZone I Scalar I WaterSurfaceEievations • 
(Figure 15). 

I T~~ iiaC!f6TM£0Cl·Jioa~aDl4il 

... ... oi) ., ,..,. ... Jr ~ .... .., ..... 
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448. 
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Figure 15. Initial display of the simulated water-surface elevation. 

• Change how the contours are displayed by selecting from the Menu Bar Draw ~Contou rs (Figure 
16). Experiment with attributes in the main Scalar setting dialog . 

• 
Scalar Setting 

Physt al YakJe : lwatErSrfaceEievatJon ·I 
Ya kJe r a-oge 

":] Automatic 

Max: 

Mn: 

Color map 

DisplaySetti1g 

4'19.131 

447.08 

IZ Flllt.wer ..... 

~ Flllbw9'¥ea 

Color Fri'"lge G Contt:u Fg.re Iso1nes 

D Tr;n;par-E'nt a : 

I Region Setting I 
lcolor Bar Setting I 

OK II Cirocal 

Figure 16. Scalar Setting dialog 

• Change the spatial extent displayed by selecting Region Setting in the Scalar setting dialog. Select 
Active Region to display only wet nodes (Figure 17 A). Or select a specific area of interest to 
display using the Custom Region options . 
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A 

• Change the display of the legend or sca lebar by selecting the Color Bar Setting button in the Scalar 
Setting dialog (Figure 17B). 

i:i Region Setting 

0 Full Region 

•§! Active Region 

0 Custom Region 

IM1n: 

!Max: 304 • 

JM1n : 1 . 
JMax: 37 

OK II Cancel 

~ Color Legend Setting 

B 

[{] Visible 

Title: 

Orientation : 

watsrSurfaceEievation 

0 Vertical ~ Horizontal 

llllrrber of labels : a ~ 

Size Position 

Specify Cola bar size Specify Cola bar left 
as rate against wi1dow bottom position as rate 
size. against whdow size. 

Wdth : .ft 0.800 : X : G 0.100 : 

Helljlt : .ft Q.200": Y : Q; 0.800 : 

OK II cancel 

Figure 17. Add itional display options available in the Scalar Setting dialog include the (A) Region Setting 
dialog and the (B) Color Legend Setting dialog (B). 

• Experiment with these features and to achieve a satisfactory display of the model solution (Figure 
18) . 

4 , ( ~·••flO.• 
# ./ C,....ol.-'_.., 

# ./ ki(II'Oioftd .. ~ 

"~ ... ,.,. 
./ ..) lof .. 

Figure 18. Example display of the simulated water-surface elevation . 

15 
FaSTMECH Tutorial 2 

iRIC Phoenix 2016 47 of252. 



Displaying Vector Results 

Vector results such as the orientation and magnitude of velocity and shear stress can also be displayed 
using the 20 Post-process ing Window. 
• For now, in the Object Browser uncheck the box next to iRICZone I Scalar to turn off the display of 

this type of data. Check the box next to Arrow and select Velocity. 
• The default values for the vectors often need adjustment. From the Menu Bar select Draw ...,.. Arrows to 

bring up the Vector Attributes dialog (Figure 19). The result is shown in Figure 20. 

SardonfoqW UO) : (m.'l] 

1.8'"gV:lCI'I~ : 15 :(pall 

1-dre:to'l s: klrteta'l t: 

o.-a>b- -

I 
o ey~~w = ... -==c-=>-,·J 

. ~~I 

Figure 19. The Vector Attributes dialog . 

Figure 20. A plot of velocity in the modeled reach represented as vectors. Vectors are color coded and 
scaled according to their magnitude. 
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Model Calibration and Refinement 

Developing a Calibration Curve 

Model calibration is an important step in developing a flow model. Typically simulated water-surface 
elevations are compared to measured water-surface elevation data collected at a known discharge. 
Comparing measured and simulated results helps to determine whether or not calculation conditions like 
roughness have been set appropriately. Other types of measured data can also be compared to the 
simulated values, such as velocity. 

• In the Menu Bar select Calculation Results ...,.. Compare with measured values or select the ~ tool 
In the Main Toolbar. This opens a dialog that allows you to select which variables to compare. Set 
the fields as shown in Figure 21 , and select OK. A Verification Window opens that plots the 
measured and simulated water-surface elevations along the stream-wise direction (Figure 22) . 

• 
b. Verification Setting 

Tlmestep 

Select the tfmestep of calculatbn result 

) 

CabJ!aticn Resu~ 

Select which JY"tysic.a1 vaLe to use for c:o~ison. 

Physi::al vaua: lwaterSlrfaceEievaticn · I 

Select which rnea:stred vaUe to use ftr coCT"parlsal. 

vai.Je: lwai9"SlrfaceEievaticn · I 

I ()( II cane:., I 

Figure 21 . Use the Verification dialog to select 
data for comparison . If more than one 
measured data set has been imported 

there is an additional field to select which 
file to use. 

·448.5 

soo 1.000 t.m 2.000 2.m 1.000 1.500 
Stru.m-wise Disblnce 

Figure 22. Example verification plot showing the 
measured and simulated water-surface 

elevation. Note that the simulated water-surface 
elevation is too high compared to the measured 

data at the downstream end of the modeled 
reach. The Root Mean Squared Error is 0.1. 

• To calibrate the model you could try adjusting the roughness value, Cd, to see if you can obtain a 
better match between the simulated and the measured values. Figure 23 shows the verification plot 
that contains the RMS error for a range of simulated roughness values. Looking at these results , it 
appears that a Cd of about 0.008 yields the lowest RMS error. However, none of the simulations 
are a good match at all locations . 
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Figure 23. Plots of the predicted and observed water-surface elevations for a range of drag coefficient 
values between 0.005 - 0.01 (A-F). The RMS error indicates that the best calibrated value for the 

drag coefficient is between 0.007 and 0.009. 

• Another way to look at these results is to plot a calibration curve which shows the roughness value 
on the x-axis and the RMS error on they-axis (Figure 24). This curve indicates how sensitive the 
simulated water-surface elevation is to the roughness value. Additional simulations could further 

• 

• 

determine the drag coefficient that gives the lowest error between measured and predicted water- • 
surface elevations. 
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Figure 24. Calibration curve showing the relationship between roughness and the RMS error for the 
simulated water-surface elevations. 

Spatially Varying Drag Coefficient 

Examination of the simulated and measured water-surface elevations in Figure 23 indicates that using a 
constant drag coefficient for the entire reach yields unsatisfactory results. Generally the predictions are 
good for either the upper or lower half of the reach but not the reach as a whole. This indicates that there is 
a change in roughness through the reach. This can be the result of many factors including a change in 
grain-size, different bedform geometries, and the presence of aquatic or submerged vegetation. 
Maps of grain size distribution or vegetation can be used to adjust the roughness in specific regions. In this 
tutorial we simply vary the drag spatially by defining an area with a higher drag coefficient in the vicinity of 
the large island mid-way through the modeled reach. 
To spatially vary roughness we'll return to the Pre-processing module. Note that Roughness is one of the 
Geographic data sets. 

• The first step is to delineate polygons that spatially define regions of roughness . 
o In the Pre-processing Window turn on the background image and in the Object Browser 

right-click on Geographic Data 1 Roughness and in the resulting pop-up menu select Add 
...,.. Polygon . Click OK when done reading the instructions and define a polygon that 
encloses the entire model Grid. When done, hit the Entry Key and enter a roughness value 
of 0.007 in the dialog . 

o Create another polygon and this time define a polygon similar to the one in Figure 25. At 
the prompt enter a roughness value of 0.013. 

o Make sure that both polygons are displayed in the Object Browser under Geographic 
Data I Roughness . 
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Figure 25. Example of the polygon mapping 

• The next step is to map or specify the roughness for each cell in the grid . The iRIC application • 
knows when you have changed any values in the Geographic Data tree and will make sure the 
new values are mapped before you run the simulation. However in order to see how the polygons 
are mapped to the grid we'll do it manually. 

o First highlight Geographic Data I Roughness inthe Object Browser. Then on the Menu 
Bar select Grid ~ Attribute Mapping ~Execute. 

o Make sure that the roughness values have been mapped to the grid by checking the box 
next to roughness under Grid I Node Attributes in the Object Browser. You may need to 
expand those sections to see the fu ll list. Make sure you get a result that looks like Figure 
26. 

o You can ed it the location of polygon nodes by selecting the polygon you want to edit in the 
Geographic Data tree, and then much like the grid centerline you can move the mouse 
until it's over a node to move the node or over a line between two nodes to move the 
whole polygon. You will also notice that there are tools in the Operation Toolbar to add or 
delete nodes in a polygon. 
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Figure 26. Final roughness attribute mapping 

• Now update the calculation condition so that it uses a variable instead of a constant roughness 
value. 

o From the Menu Bar select Calculation Condition ~ Setting. In the Calculation Condition 
dialog select roughness and change the settings to look like Figure 27. Select the Save 
and Close button . 

FaSTMECH Tutorial 2 
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Soluoon Relaxaoon Coeffic•tnts 
20 Solu0011 OulpUt 
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Sediment Transport 
W•lcock-Kenwordl}' Parameters l 
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-Typo !"' .. ""''"'""' · I 
Rl:u;j'ressOi>trb.Jtlcrl V<rlablebyNode • 

Ccnstirlt.R.ol.rjressVal.e OCOB 
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Maxlrrum Drag Coefficient 0 01 

Figure 27. Calculation cond ition , roughness dialog 

21 

iRIC Phoenix 2016 53 of252. 



• Now rerun the simulation by clicking the run button or by selecting Simulation ~ Run from the 
Menu Bar. 

• When the simulation is complete, look at the Verification (Figure 28). 

IS,. Verification 

Chart Type: Stream~·ise Distance vs. Measured Values and Calculation Result 

II) 

cv 

449 

448.5 

::J 448 
ro 
> 

447.5 

447 
I' II ' I " ''I II " I II II I " II I' ' " I' II 'I 
0 500 1,000 1,500 2,000 2,500 3,000 3,500 

Stream-wise Distance 

o Measured Values (WaterSurfaceElevation) 

- Calculation Result (WaterSurfaceElevation} 

Root Mean Squared Error: 0.0277884 

Setting.. . ) [ Export.. . ] [ Close 

Figure 28. Comparison of the measured and simulated water-surface elevation using a spatially variable 
drag coefficient. RMS error is 0.028. 
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• Quasi-3D Model and 3D Graphics 

In this section the simple vertical structure of shear flows and the generation of secondary flows using the 
quasi-3D sub-model available in FaSTMECH is briefly explored . A more in-depth discussion of this topic is 
available in Tutorial 3. In addition , an introduction to the 3D graphics capabil ities of iRIC is provided. The 
model previously developed is used and the qausi-3d model and 3d solution is simply turned on . A nice 
feature of th is function is that the quasi-3d solution is computed upon completion of the 2d solution , such 
that this additional step requires a minor amount of additional computation time. The quasi-3d model offers 
the option of using the channel curvature or channel curvature +streamline curvature for calculating 
secondary flows. We'll use both options in the following sections. First, secondary flow expressed as the 
helix strength, which is defined as the angular difference between the near-bed flow and the surface flow 
and is a simple measure of the presence and strength of secondary flows is explored . Second, vertical 
sections of velocity vectors are plotted to illustrate the rotation of vectors in the vertical due to secondary 
flow. Finally, cross-sections are examined through the reach to visualize the vertical structure of the flow. 

Visualize Two- and Three-Dimensional Solution Without and With Streamline Curvature 

• Return to the pre-processing module by selecting View ..,.. Pre-processing Window. 
• Select Calculation Condition ..,.. Setting and edit the following tabs in the 

Calculation Condition Dialog as in Figure 29 and 30 . In this first case only 
channel curvature is used. 30 output including the calculation of the helix strength 

• and the 30 scalar and vector quantities are added through the 3D Solution Output tab. 

• 
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Figure 29. Quasi-3D Solution tab of the 
Calculation Conditions. 
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Figure 30. 3D Solution Output tab of the 
Calculation Conditions 

• Re-run the model to obtain the new solution . Notice that in the tool bar the 3D ") option is now 
available. 

• Before exploring the 3D graphing options, look at the Helix Strength 2D solution result as in Figure 
31 below. 

o Set the min and max Helix strength to -25 and 25 respectively. Also, set the Display 
Property setting to Contour. 
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Re-run the model with the Use Streamline-curvature option set in the Calculation Conditions and the 
Minimum Streamline Curvature set to 10m. The resulting helix strength solution is plotted in Figure 32. 

• The helix strength and streamlines are plotted in Figure 33. Note the correlation between 
curvature of the streamlines and the helix strength . 
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Figure 31. Helix strength calculated using only the grid curvature 

Figure 32. Helix strength calculated using streamline curvature 
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Figure 33. Helix strength and streamlines originating from the upstream boundary. Notice the correlation 
between curvature in the streamlines and the helix strength . The boxes are the locations of the 

following figures A) Figure 34, B) Figure 35) and C) Figure 36 . 

Vertical Structure Continued 

1. To create an image as shown in Figure 34: 

• In the 30 Post Processing window right-click FaSTMECH Grids I iRICZone I Arrow in the Object 
Browser and select the Property pop-up menu. Set up the Arrow Setting dialog as shown in Figure 
34 (A and B) . Where each Face added (Face001 , Face002 ... , Face011 ) incrementally increases 
the value of the K index (from 1 - 11 ). Also, set up the Length, Sampling , and Color fields as 
shown. 

• By zooming into the downstream end of the main (river-left) channel around the island, where the 
flow has some of the highest curvature, you should be able to reproduce the graphics as shown in 
Figure 34 (C).The velocity from every vertical node is shown illustrating the secondary flow where 
the surface velocities are oriented towards the outside of the bend and the near bed velocities are 
oriented towards the inside of the bend . 
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Figure 34. The Arrow Setting dialog. Note that in (A) the K index is set to 1 and in (B) the K index is set to 
11. The 3-dimensional vector field where the velocities at the surface are highest and the near bed 

velocities are lowest. Notice how the orientation of the velocities changes as the streamline curvature 
changes 

2. To Create an image as shown in Figure 35: 

• In the 30 Post Processing window right-cl ick FaSTMECH Grids I iR/Clone I Contour in the 
Object Browser and select the Property pop-up menu. Set up the Contour Setting dialog as 
shown in Figure 35 (A & B). Note that the NVelocity is the cross-stream velocity re lative to the 
grid coordinate system. When the cuvature of the coordinate system (Grid) follows the 
channel curvature nicely it's easy to see the secondary flow in the plots below (See Figure 36). 
Seven Faces are added incrementally with the value of the !-index equal to 200, 210, 220, 230, 
240, 250, 260. 

• Add itionally an iso-surface of the velocity magnitude (0.01 m/s) is added to provide a sense of 
the channel bottom (Figure 35C) 

• 

• 

• To add some vertical exaggeration so that it's easier to see the cross-sections select View->Z • 
Direction Scale from the Menu and enter 5 in the Z-direction scale. The easiest way to orient 
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A 

the channel is to first select the :zy .button and then using the Ctrl Key and Right mouse button 
-drag the mouse from top to bottom. In this case flow is from top to bottom. Convince 
yourself of th is with the knowledge that the coordinate system is right-handed . 

• Figure 36 is created by adding additional contour sections with the 1-index values equal to 125, 
130, 135, and 140. The max and min NVelocity values are 0.1 to -0.1 . 
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Figure 35. The cross-stream velocity is shown for a number of cross-sections through the reach . 
NVelocity is the magnitude of the velocity oriented perpendicular to the stream-wise direction. When 

the grid follows the channel curvature well , NVelocity provides a good representation of the 
secondary fiow. Here the grid does not follow the curvature of each channel around the island, so we 

only capture some of the secondary fiow with these plots. 
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• Figure 36. Vertical Profiles at cross-sections corresponding to !-locations of 125, 130, 135, and 140. 

• 

• For a more in-depth discussion of secondary flows and its effect on sediment-transport, please see 
Tutorials 3 and 5 respectively . 
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iRIC Soft~are 
Changing River Science 

FaSTMECH Tutorial 9 
Flood reconstruction and peak discharge estimation 

Satellite image of river flow and flood damage on September 14 following the peak discharge on 

September 13. 
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Introduction 
In September, 2013, a slow-moving, low-pressure system over the Great Ba sin (southwest of Colorado) 

pulled a strong plume of monsoonal tropical moisture from the Pacific Ocean off western Mexico and as 

time progressed, the circulation pattern brought additional moisture from the Gu lf of Mexico on 

easterly and southeasterly flow. These easterly and southeasterly flows resulted in upslope flows in the 

Colorado Front Range and propelled the moisture against the foothills . The presence of a stalled cold 

front assisted with additional lift, resulting in rainfall over a very large area 1 (rough ly from Colorado 

Springs north to Fort Collins) (Figure 1). Rainfall amounts exceeded 38 .1 em (15 in) in some locations, 

w ith the majority falling in a 36-hour period from the afternoon of Sept. 11 through early morning Sept. 

13. Boulder County, where the CODWR gage on St. Vrain Cr.at Lyons is located, received over 22.9 em (9 

in) on September 12 and cumulatively up to 43 .2 em (17 in) for the week2. Boulder County has an 

average annual precipitation of 52.6 em (20.7 in)3 
. 

Colorado Flood Event , 9-16 September 201 3 
An nual Exceedance Probabili ties (AEP s) for Worst Case 48-hour Rainfall 

Hydrometeorological Design Studies Center 
Office of Hydrologic: Development. National Wuther Service 

National Oceanic and Atmospheric Adm nist~tjon 
~ ,.,.,,.., 
~~ ~ •.. hCpJtwww nws.nou p#OhdiMicl 

~ ~ ... .. . -..'l ~~.::::.::.:.=w._.,.1~t. 
~ ............. ..._.....__Oitl 

Figure 1 

C > l /1 0 
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- < 111 000 

1 "Severe Flooding on the Colorado Front Range, September 20 13": A Preliminary Assessment from the CIRES Western Water Assessment at 
the Univer iry of Colorado, NOAA ESRL Phys ical Science Division, and the CSU Colorado Climate Center, released September 25, 2013 Lead 
author: Jeff Lukas CIRES/WW A; lukas@colorado.edu 
2 Andy Freeman, "Flood-Ravaged Boulder, Colo. , Sets Annua l Ra infall Record" Climate Centra l published on September 16, 20 13 
http://www.climatecentral.org/news/flood-ravaged-boulder-colorado-sets-annual-rainfal l-record-16481 
3 "Average Annual Rainfall for Colorado" Current Results Research News and Science Facts 
http://www.currentresults.com/Weather/Colorado/average-yearly-precipitation.php#b 

iRIC Phoenix 201 6 63 of 252. 



The flood peak on St. Vrain Creek at Lyons occurred sometime in the evening of Sept. 12 or early 

morning of Sept. 13. The State gaging station was destroyed by the flood sometime afte r 21:15 hrs when • 

it last transmitted data (Figure 2). Data collected by the gage in the final hours shou ld be considered 

unreliable as undermining ofthe road and gagehouse structure was likely occurring and would have 

affected gage recordings . Within the town of Lyons, many homes and businesses in the central part of 

the floodway along the Hwy 36/66 corridor were inundated with water, and flood damage to 

infrastructure was extensive. 
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Figure 2 Colorado Division of Water Resources gage record for Saint Vrain Creek at Lyons, CO 

(http://www.dwr.state.co.us/SurfaceWater/data/detail graph .aspx?ID=SVCLYOCO&MTYPE=DISCHRG) 

Following the flood, USGS personnel surveyed High Water Marks in the region of interest, and shortly 

following t he flood LiDAR was flown. You are provided with Topography as measured by airborne LiDAR 

following the flood and the measured HWMs and your job is to determine the peak discharge during the 

flood. In this tutorial you will perform the following tasks: 

1. Import elevation, measured high wate r marks, and background imagery 

2. Process topography to account for flow under the roads 

3. Build a grid 

4. Determine peak discharge: 

a. For a given single roughness value . 

b. For a range of roughness values . 

Note : There are two general ways the user instructs iRIC to perform an operation : 1) through the menu 

at the top of the application, or th rough the Object Browser on the left of the appl ication. We use two 

formats to indicate a menu operation or an Object Browser operation . For Example: 

Menu operation: File-> Import-> Geographic Data-> Elevation .. . The menu operation is show in Bo ld 

font, and each successive menu is separated by an arrow(->). 

Object Browser: Geographic Data I Elevation I Pointsl The object browse r is essentially a tree view 

with set of branches and sub-branches. Each sub branch is separated by a (I) sybol, and the font is Bold 

+Italic. 

iRIC Phoenix 2016 64 of 252. 

• 

• 



• 

• 

• 

Task 1: Import Data 
1. launch iRIC: Start iRI C and select FaSTM ECH as your solver (Figure 3A). 
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Ftgure 3 A) Opentng dtalog to set solver or open prevtously bwlt project. B) Sea Iebar setttng dtalog. C) Elevatton Color setttng 

dialog. 

2. Import topography: Se lect from the menu, lmport->Geographic Data -> Elevation. In t he folder 

contain ing t he dat a for th is tutorial se lect t he fi le StVrain_1_0m_ 477700_ 4452000_shi fted. tpo . 

When t he file is selected the Fi lter Sett ing dia log w ill appear wh ich allows you to simply 

decimate your data set. For example setting the filter value to 1 imports every point, setti ng the 

filter value to 2 imports every other po int, etc. This data is a subset of ava ilable LiDAR data for 

the reach (Figure 4A). It has been decimated to 1 meter resolution, and shifted by 477700 

meters in the X-direction and 4452000 meters in theY-direction . 

3. Add a scalebar: Select Geographic Data -> Set Up Scalebar from t he menu (Figure 3B) . In t he 

resulting dialog make sure the dropdown list is set to Elevation and select OK. You can always 

change t he color setting by se lect ing Geographic Data ->Color Setting -> Elevation. For now 

keep the default setting by selecting OK (Figure 3C) . You r project should now look like Figure 

4A. 

4. Import background image: From the menu se lect Import-> Background Image and select 

Post Fioodlmage_Shifted .jpg. 

5. Import the measured high water marks (HWMs) : Se lect Import -> Measured Values, and select 

the fi le HWMarks3_SAC_RIGHTBANK.csv. By defau lt , iRIC has placed a data legend for the 

HWMs over the Elevation data legend . Move t he Elevation data legend by f irst selecting 

Geographic Data I Elevation in the Object Browser tree . Next, click your mouse on the legend 

and drag it to a new location. 

6. Increase point size of HWMs: Turn off t he elevation point set by de-se lecting the Geographic 

Data I Elevation checkbox in the Object Browser. To make the HWMs more visib le, first select 

Measured Values I File path and name I Scalar in the Object Browser with your mouse. Then 

right -c lick on t he same path in t he Object Browser and select Property from the pop-up menu. 

In the resulting dia log set the Point Size t o 7 and select the OK button. You r project should now 

look like Figure 4B. 

Now you have imported all the data necessary to begin creati ng a flow model and in the process you 

have learned some of the basic functionality of the iRIC appl ication . You ca n import different data sets, 
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add a data legend for the different data sets, and change the graphic properties and view of imported 

data . 
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Figure 4 A} graphic view of imported LiDAR data set and B) Background image and measured HWMs. 
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Task 2: Preprocess the topography 
1. Set the color map of the topography to better visualize the elevations of interest. 

a. Turn offthe measured data by deselecting Measured Values in the Object Browser and 

then turn the Elevation data back on . You will edit the elevation data to simplify the 

view. In particular, we want to delete those points higher than are necessary to model 

this reach, and second we will change the color setting. 

b. Select Geographic Data I Elevation I Pointsl in the Object Browser. Doing so enables 

the tool bar + + X 51'~ 'l. · ~ · /.;: for editing the point set data . Notice that if you 

select some other branch in the Object Browser, the toolbar is no longer visible . In iRIC, 

whenever you want to operate on a specific data set, you should first select that data 

set in the Object Browser, and any available tools for interacting with that data will be 

visible in the tool bar near the top of the application . The Select Point button (4th from 

left) allows you to select a single point, shift-select mult iple points, or drag-select a 

rectangle of points. To see how this works, drag-select a rectangle of points. The point 

set is very dense, so unless you zoom into a specific area, it will be hard to see the points 

that are selected . That is not important for now. Following the selection, right click on 

the graphic window and select Edit Selected Points from the pop-up menu. If you did 

not effectively select a point then the Edit Selected Points option will be greyed out. If 

so, try again . In the Edit Points dialog notice that you will see the number of points 

selected and the minimum and maximum value of those points. This provides a quick 

and easy way to probe the data and we will use this technique again later in the tutorial. 

Also notice that X-location andY-location are blank. If you had selected a single point 

then you could change its x,y position if desired . When multiple points are selected only 

the Value is available to change. In this case we are not interested in editing the data ; 

we only use this tool as a quick probe of the values, specifically the minimum and 

maximum values . Select the Cancel button. If you select the OK button then all the 

selected points will be set the Value specified in the Edit Points Dialog. Don't do that 

here, again we are just probing the points to determine their values. If you do this by 

accident then simply select the Undo button ( II) ) in the main tool bar at the top of the 

application. 

c. We are go ing to delete points greater than a defined value . Th is will greatly reduce the 

number of points in the data set to speed up some of the operations we will perform 

later and also provide more color resolution to the data of interest in the channel. Using 

the select point tool described above select a point or region of points somewhere in 

the light blue range to determine the elevat ion value (s) specifically. You should find 

values somewhere near 1634. Zoom out so the entire elevation data set is visible, then 

using the select point tool, drag-select then entire data set. Right click on the graphics 

window and select Delete Points Greater Than Value, and in the resulting dialog enter 

1634 and select the OK button. The results should look like Figure SA. 

d. To change the color map of the data first make sure you have selected Geographic Data 

I Elevation I Pointsl, since that is the data set we will be operating on. Next select 

Geographic Data-> Color Setting-> Elevation from the menu. In the Elevation Color 
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Setting dialog, de-select the Automatic checkbox and then enter 1634 for t he Max value . • 

In the Colormap subbox, choose the Custom button and then select the Setting button 

A 

B 

and set the Type to Three Colors, the Medium Value color to white (click the color field 

to get the Select Color dialog) and then enter 1620 for the Value . The resulting data and 

the three dialogs described in this operation are shown in Figure SB. 
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Figure 5 A) Elevation data below 1634 meters. B) Modified Color map of elevation data. Insets ore in clockwise direction 1} 
Elevation Color Setting dialog, 2} Custom Color Map dialog, and 3} Select Color dialog. 

1 ~ 

4------

Figure 6 Location of flow diversions under roads and irrigation ditch which require some modification of the existing topography 

2. Modify the topography to account for flow under the roads. In iRIC you can modify any of the 

imported Geographic Data such as elevation by drawing polygons over the point set and 

defining an elevation value to represent the topography. Then, when the Geographic Data is 

mapped to the grid you will create later, wherever a polygon exists it will over-ride the 

measured values below it. We will add a series of polygons to approximate the location ofthe 

channel under the roads. 

a. In Figure 6, four locations have been identified that require some modification to the 

elevation data set. At 1, 2, and 3, a road crosses over the channel , and at 4, there are 

constrictions in an irrigation ditch likely due to vegetat ion obscuring the ditch in the 

LiDAR topography. In the following steps, you will add polygons on top of the elevation 

data . Each polygon has a user defined value that will override the underlying 

topography and approximate the elevation of channel bottom underneath the road . In 

this way, modifications to the topography can be imposed without losing the original 

measured data . If you don't like the modification, just delete the polygon. 

b. To modify the height of the topography at a road crossing, follow the steps below. You 

will add a polygon yourself for the road crossing identified by the number 1 in Figure 6, 

and for the rest of the road crossings and mod ifications to the irrigation canal you will 

import the polygons which have been built and saved in a shapefile (.shp) for you . 

i. Adjust the color setting to add more detail to the topography so it' s easier to 

define the location of the road crossing #1. We learned how to adjust the color 
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setting of legend in section 1d above. Set the color setting to a minimum of 

1615 and maximum of 1617. 

ii. Set the size ofthe elevation point set to 7 which will make the data easi er to see 

when zoomed in . To do this select Geographic Data I Elevation I Pointsl and 

the right-click and select Property in the pop-up menu . Then set the point size 

to 7 and select the OK button. 

iii. Probe the elevation values on either side of the road to determine the best 

single value to assign to the elevation of the po lygon you will create next. You 

learned how to probe values in section lb above. 

iv. To create a polygon that approximates the spatial location ofthe channel below 

the road be sure to first select the Geographic Data I Elevation in the Object 

Browser with a left-click, and then right cl ick the same and se lect add -> Polygon 

in the pop-up menu. Draw a polygon that crosses the road and connect to the 

topographically low cha nnel on either side. When finished select Enter on the 

keyboard to finish drawing the polygon and in the resulting Edit Elevation value 

dia log, enter the elevation for the polygon based on the values you probed in 

section iii above (Figure 7A). 

v. Import polygons created for you to improve the elevation ofthe rema in ing two 

diversions and the irrigation canal. In the menu select Import-> Geographic 

Data-> Elevation and browse to the lrrigationCanal2.shp file. Make sure that in 

the Polygon Import Sett ing dialog you have selected Name from the drop-down 

• 

menu for the Name field, and you have selected Value in the drop-down menu • 

for the Value field (Figure 7B). 

vi. Turn off the Elevation I Pointsl in the Object Browser and the result of the 

drawn and imported polygons should look something like Figure 7C. 
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Figure 7 A) added polygon to approximate diversion 11. B) Polygon Import Setting dialog- when importing a shapefile make 
sure you have selected the correct values in the drop-down list for the Name and Value fields . C) The complete set of polygons 
to enhance the topographic representation of diversions and irrigation canal . 

iRIC Phoenix 2016 71 of 252. 



Task 3: Create Grid 
In this section we' ll create a grid and map or interpolate the measured topography values, and the 

overriding user defined polygon values, to the grid. It might be easiest to read this entire section before 

you begin . We will be performing many ed its to the grid during this section, to improve the use r 

experience we will turn off some of the automated features of iRIC. 

1. Set mapping attributes: Select Grid-> Attributes Mapping-> Setting from the menu and in the 

resulting Grid Attribute Mapping Setting dialog, select manual in the Execute mapping section of 

the dialog. This wi ll prevent iRIC from mapping data to the grid following every edit to the grid. 

2. Considerations: In step 3 below you will select a grid generator and draw a centerline, but 

before doing this it' s important to conside r the following points. 

a. Note that the centerline is drawn from upstream to downstream, in this case f rom 

upper left to lower right. 

b. In Figure 8, a simple grid is shown for context only- You won't see th is as you draw your 

centerline. Each of the small black squares on the centerl ine are the po ints used to 

define its path . In this case 6 points are defined . Usually only a few points are desired. 

You can always add or de lete centerline points later if necessary. 

c. The downstream boundary is located such that the furthest downstream measured 

water-surface elevation is at the boundary because we will use its value as a boundary 

condition for our simulation . 

d. You will want to adjust the curvature of your grid such that the boundaries are as 

perpendicular as possible to the ma in flow direction. See the insets in Figure 8. Here 

we plot the vectors from a simulation for illustration, but it is generally easy enough to 

guess the flow direction . It's possible that after an initial solution you may want to go 

back and adjust the location of the boundaries. 

e. Additionally, it ' s important to place the upstream boundary such that there is not a 

narrowing of the channel immediately downstream. The flow direction at the upstream 

boundary is set perpendicu lar to the boundary by default (note it is possible to adjust 

the flow direction at the boundary, but for now it's best and easiest to assume a 

perpendicular flow direction) . If the channel decreases in width immediately 

downstream, then the flow will be directed into the bank. Looking at the upstream 

boundary inset in Figure 8, if the boundary was placed further downstream then you 

might imagine the flow at the upstream boundary would be directed into the bank 

downstream; the common result is for the model to crash. 

3. Select grid generator and draw centerline: Select the grid generator by selecting Grid -> Select 

Algorithm to Create Grid in the menu and in the resulting dialog select "Create grid from 

polygonal line and w idth" in the list of Algorithms and select the OK button . An information 

dialog will appear. It provides a qu ick description on how to create the grid using this tool. 

Select the OK button. Using your left mouse button define the centerline for the grid . It should 

look something like that in Figure 8. It's not important to be precise at this point. As you will 

see later it's important to get the boundaries of the grid perpendicular to the main flow 

direction and that is easily done once you have a basic grid . The aim here is to draw your 

centerline in a location that is similar to that in Figure 8. The centerline is completed by 

selecting the Enter button on your keyboard. 
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4. Create simple grid to help placement of grid and boundary conditions: Create simple grid by 

selecting Grid-> Create Grid from the menu. In the Grid Creation dialog enter 11 for ni, 12, for 

nj, and 450 for the width and select the OK button (Figure 9A) . We' ll create a finer grid once we 

have edited our initial guess of centerline location . 

5. Adjust your centerline and grid curvature: In this step you will adjust the centerline point 

locations until you have a grid that encompasses the flow area, good boundary angles to the 

incoming and outgoing flow direction, and a downstream boundary at a measured water­

surface elevation which we'll use as a boundary condition By adjusting the centerline points of 

the grid you can adjust the grid curvature, and the orientation of the upstream and downstream 

boundaries. First, select Grid Creating Condition in the Object Browser. This will turn on the 

centerline you created in step 3 above. You can adjust the location of each centerline point by 

moving the mouse over the point and using a mouse left-click and drag to move it. If you don't 

like your move select the undo button ( "1 ) in the main toolbar. 

6. Rebuild grid to final 2 meter resolution: Once you are satisfied with the location of your grid, 

rebuild the grid such that it has a 2 X 2 meter spacing between nodes. From the menu select 

Grid-> Create Grid and enter values for ni and nj, such that the resulting values of di and dj are 

approximately 2 meters. You can iterate on these values by entering your guess into ni and nj, 

then selecting the Apply button to see the resulting values of di and dj (Figure 9A) . 

7. Map measured values to the grid: Map or interpolate all geographic data to the grid, in this 

case just the elevation data. We will map values to the grid using the TIN of the values. This is 

the default interpolation method. This value is set from the menu by selecting Grid-> Attributes 

Mapping -> Setting. Note that Geographic Mapping is set to Mapping with TINs in the Grid 

Attribute Mapping Setting dialog (Figure 9B). Next we will execute the mapping. From the 

menu select Grid-> Attributes Mapping-> Execute. If you turn on the Grid I Node attributes I 
Elevation in the Object Browser, your project should look similar to that in Figure 9C. 
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Figure 8 For illustration purposes a simple grid developed from the centerline is shown. Importantly 1) the upstream and 
downstream grid boundaries are aligned nearly perpendicularly to the incoming and outgoing flow directions, 2) there ore no 
constrictions in flow immediately downstream of the boundary (see the Upstream Boundary inset). Finally the width of the 
channel encompasses the potential flow area. 
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Figure 9 A) Grid Creation parameters far the simple grid in Step 4 (top) and for the final refined grid (bottom) . B) The Grid 
Attribute Mapping dialog with the mopping method set to use the TIN. C) The elevation as mopped to the computational grid. 
Note that the location of the weirs are approximated by channels across the roads. In this way you can see the result of the 
polygons we drew earlier. 

iRIC Phoenix 2016 75 of252. 



Task 4: Determine the peak discharge 
Now that you have created your grid and mapped the elevations values on to it you are ready to begin 

simulating flow through the reach. The goal here is to estimate the peak discharge using the avai lable 

topography and measured HWMs. Both discharge and roughness are unknown. To begin in Part A, we 

will first determine the best discharge corresponding to a single value of roughness. To estimate this 

peak discharge we will run a series of simulations that sweep through a reasonable set of discharge 

va lues. (Table 1). The resulting simulated water-surface elevations will be compared to the measured 

HWMs and a root mean squared error (RMSE) w ill be determined for each simulation . We will record 

those RMSE values in Table 1 and then estimate the peak discharge from the discharge value that results 

in the best prediction to the measured HWMs. 

Part A 

To help you get started, we provide the input cond itions for the 650cms flow with a drag coefficient of 

0.02. The input conditions are provided below in Figure 10. A few notes before you begin . 

i 

a. Note that we are using a 1-dimensional model (Figure 10F) to determine the in itia l water­

surface elevation through the reach . For each new discharge you simulate you will have to 

change the discharge in the Discharge and Initial Conditions tab (Figure 10 A & F respectively). 

b. We have provided you with the stage of the most downstream measured HWM which is 

1607.61 meters. It will stay constant for all the simulations. 

Calculation Condition r~. ~.~ ~ I Cakulation Condibon ,.,~ • \-ij,~ 

Groups Groups 
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'""""""'' · I 
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Groups 

Discharge 
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Note: The last 5 groups, Quasi3D Solution, 3D So lution Ouput, etc. are not used in this simulat ion 
because we are only running a simple flow solution . For more information on the Quasi-3D solution 
look at Tutorial 3. For more information on sediment-tran rt look at Tutoria l 5 & 6. 

Figure 10 The calculation conditions for the FaSTMECH model accessed by selecting Calculation Condition ->Setting from the 
menu. Each tab for a flow solution (without sediment transport) is shown including: A} Discharge, B) Stage, C) Roughness, D) 
Later Eddy Viscosity, E) Grid Extension, F) Wetting and Drying, G) Solution Parameters, and H) Solution Relaxation Coefficients. 

1. Enter the calculation conditions for a simulation: From the menu se lect Calculation Condition -> 

Setting, and Fill in the values for each tab ofthe Calculation Condition dialog as those in Figure 10 . 

Except as exp lained above in (a) enter the discharge corresponding to the discharge you are 

modeli ng in the Discharge and Initial Conditions tab . 

2. Run the simulation: From the me nu select Si mulation -> Run . The So lver Console view wil l be 

act ivated in iRIC and you will see the progression of the simulation showing t he Iteration number 

and the mean error on discharge. The mean error on discharge is the root-mean squa red erro r 

between the specified discharge and the discharge calculated at each of the cross-sections in the 

grid. Watching these values provides some insight to the simulation conve rgence. Ideally t he values 

shou ld converge to values less than 3 (usually much smaller) and should be re latively steady or 

unchanging at t he end of the simulation. However, some small change in va lues is expected. lfthe 

simu lation is successful you wil l see the So lver Finished dia log. Select OK and proceed to the next 

section . 

3. If the simulation stops before the number of iterations specified: You will see an erro r message in 

the Solver Conso le view. Note the last iteration number and se lect the II button from the too l bar 

to end the simulation. The best way to begin investigating why your simulation did not complete is 

to run the simulat ion for approximately 5 iterations before it stopped (which is why you noted the 

iteration the so lution stopped) and look at the solution . Ru nning the simulation for 5 iterations 

before the so lution stopped is a good rule of thumb but it may be anywhere f rom 1-10 iterations to 

get a solution which will provide some clue as to why the so lution stopped . Genera lly viewing t he 

water surface elevation and/or the velocity vectors will provide some hints to why t he so lution 

stopped . Discuss wi th your neighbor or ask an instructor for help. 

4. Compare the simulated water-surface elevation to the measured HWMs and record the RMSE 

value: When the simu lation is fi nished, select Calculation Result-> Compare with measured values 
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from the menu and you will launch the Verification dialog. Initially it starts with the Verification 

Setting dialog (Figure 11A). Set the Physical Value in the drop-down list to WaterSurfaceEievation 

and press the OK button. 

a. In the Verification dialog you will see a comparison between the measured data (circles) and 

simu lation (line) as a function of stream-wise distance (Figure llB} . Note that in the 

Verification dialog the root mean squared error, a measure of the mean difference between 

the measured and simulated data is displayed in the dialog below the comparison plot. 

Write this number down in the appropriate column of Table 1. 

b. You now know how to get a comparison between measured and simulated water-surface 

elevations in iRIC. (Figure 11 B. You will fill your Table 1 w ith the RMSE value for each 

discharge and drag coefficient pair. 

8_ Verification Setting l 'Y I.....a..J 
l::i VerfficabOn _L !:! 

Tmestep 
Olart.Type: ! Str~~Oistzncevs.~Velles .-.:l cakiJatx:nR.esft -I 

Select the timestep of calculation result 1.620 • Measlnd ~ (WSE) 

o- fO 1,618 
- Cakl.MtianResUt (Wa~atJOn) 

1.616 

Calculation Result :n 1,611 

Select which physical value to use for comparison. 
::J . 
~ 1,612 

Physical Value: lw aterSurfaceElevation · ) 1,610 

Measured Values 1,608 

Select which measured value to use for comparison. 1,606 

Value: l w sE · ) 200 400 600 BOO 1,000 1,200 L,-400 

Stream-wise Distance 
Root MI!an 5c).Jared &ror: 0. 236 1-49 

I s....,. .. 11 ._._ .. I~ 

B 

I OK I I Cancel I 
A 

.. 
F1gure 11 The Verification d10log can be accessed by selectmg Calculation Result-> Compare with measured values from the 
menu. A) The initial dialog provides the setting ta choose which simulation scalar set will be used to compare with the 
measured data, in this case WaterSurfaceEievation is chosen. B) The comparison from the simulation of 650 m 3/ s with 2500 
iterations. 

Table 1 Your root mean square error, shown in the Verification dialog for each simulation pair of discharge and drag coefficient 
(Cd} will be recorded in this table. 

400 450 500 550 650 700 750 800 
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Part B 

In Part A you assessed the best discharge value given the measured high water marks, for a drag 

coefficient of 0 .02. However, we really don't know what the drag coefficient is. Generally we calibrate 

each flow over a range of drag coefficients to determine the best drag coefficient for each different flow 

magnitude. That is the calibration process. We calibrate in this way because the total roughness is the 

additive roughness over a range of sca les from the individual grains on the bed, to bedforms including 

ripp les and dunes if present, increasing in scale all the way to the plan form shape ofthe river itself. 

Between the scale ofthe computational grid, and the resolution ofthe measured topography, our 

simulation wil l capture some subset of the various scales of roughness. The rest of the roughness is 

lumped into a single value represented by the drag coefficient. 

A good strategy when determining the peak discharge based on surveyed topography and high water 

marks is to sweep through the parameter space of both discharge and roughness. Comparing t he 

simulated water-surface elevation at each discharge and roughness pai r and reco rding the RMSE of each 

simulation will resu lt in a tab le that will provide a good estimation of the peak discharge assessed from 

the discharge roughness pair that results in the lowest RMSE . 

In addition, t he resulting table also provides a sensitivity analysis on the peak discharge. Based on the 

resu lts you may find a well-defined peak discharge where the RMS E values clearly indicate a single 

discharge value, or you may find t hat a well-defined discharge is not found and instead the simulations 

indicate that the peak discharge lies w ith in a range of flows . In other words, you may f ind that there is a 

clear lowest RMSE value that indicates the peak discharge, or you may find that there is range of flows 

that have RMSE errors that are too similar to definitively distinguish a best value. While this method is 

more time intensive it provides an improvement to t he standard 1-dimensional approach where a single 

roughness value is specified a prio ri. In Part B we will run simulations for the set of drag coefficients 

(roughness values) and discharges defined in Table 2. Before you begin your simulations you might find 

it instructive to look at grids of other students near you and provide each other feedback and make sure 

you are all on the same page. 

Table 2: Fill in the RMSE values far each simulation pair af discharge and drag coefficient {Cd) 

Cd 500 550 600 650 700 750 800 

0.01 

0.0125 

0.015 

0.0175 

0.02 

0.0225 

0.025 
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Introduction to Nays2DH 

1. What is Nays2DH? 

ays2DH is a computational model for simulating horizontal two-dimensional (2D) flow, sediment 

transport, morphological changes of bed and banks in rivers . Although iRJC has provided several 2D solvers, 

such as ays2D, Morpho2D, FaSTMECH, etc., we believe that the users sometimes may confuse which 

solver is preferable for their own case. Therefore, we decided to combine Nays2D and Morpho2D to provide 

a more powerful and user friendly tool for iRlC users, we called it ays2DH. 

ays2D, developed by Dr. Yasuyuki Shimizu in Hokkaido University in Japan, is a plane 2D solver for 

calculating flow, sediment transport, and bed evolution and bank erosion in rivers. By joining many develop­

ers to ays2D project, several functions, for instance, river confluence model, nlixed grain size model and 

hot start function, have been added. Nays2D is attached to iRlC and RlC- ays which is a predecessor project 

of iRlC. ays2D includes several options for simulating river flows such as an unsteady vortex generation in 

open channel flows and river morphodynamics. River morphodynamics includes the initiation and develop­

ment of free bars in rivers and the interaction between free bars and forced bars in meandering channels. In 

addition, ays2D has been applied to several practical applications: bed evolution process in rivers affected 

by trees and vegetation, calculation and prediction of inundation on floodplains, sedimentation in river con­

fluences , analysis of bank erosion and flood disasters. 

Morpho2D developed by Dr. Hirosru Takebayashi is a solver to simulate the two-dimensional morphody­

namical changes in rivers. Initially, it was attached in the RlC- ays as 'Mixed grain-size model'. Since iRlC 

released version 1, tills solver has been reformed as Morpho2D. Morpho2D includes several possibilities for 

simulating the morphological changes of river bed with uniform and mixed sediment sizes, and simulating 

the development of free bars with sorting of sediment particles on the river bed. Morpho2D has also been 

applied to several real world applications in river engineering, such as analysis or bed evolution under vege­

tation effects, sediment transport and bed evolution with the non-erodible bed. 

Both solvers have their own advantages, but they include a common part as they are both 2D models. We 

developed a new and more powerful solver by combining the functions of these models. In this version, the 

user can choose a sediment transport model based on the functions which were implemented in the both 

solvers. The user also can combine a river confluence model, bank erosion model, bedload-suspended load 

simulation in mixture sediment, bedload layer model and fixed bed model, and also able to change the sedi­

ment supply rate from the upstream end. However, there are some uncoupled parts in the current version. The 

combination of the functions explained above may not work in some points, and the seepage flow model 

used in Morpho2D is not implemented. These points will be improved in the near future. 

ays2DH development team 

Yasuyuki SHIMIZU, Hokkaido University, Japan. 

Hirosru TAKEBAYASHI, Kyoto University, Japan. 
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I 2. Features of the hydrodynamic model 
I I 

(1) As a coordinate system, a genera l curvi linear coordinate system is adopted, allowing direct consideration 

of complex boundaries and riverbed shapes. 

(2) Calculations involving confluences of a main channel and tributaries can be performed. 

(3) For the finite differencing applied to the advection terms in the momentw11 equations, the user can select 

from among [Upwind difference method (fust order)] and [CIP method]* I. 

(4) For the turbulent field calculation method, the user can select from among [Constant eddy viscosity], 

[Zero-equation model] and [k-c model]. 

(5) Various settings are possible for boundary conditions of the upstream and downstrean1 ends, including 

periodic boundary conditions, downstream water surface elevation setting and upstream velocity setting. 

Thjs makes it convenient to set boundary conditi ons from limi ted observational data. 

(6) For setting the initial water-surface profile, the user can select from among [Constant slope] , [Line] , 

[Unifonn flow calculation] and [Non-unifonn flow calculation] . 

(7) The bottom friction evaluation method is set by using Manning's rouglmess parameter. This parameter can 

be set to each computational cell. 

(8) Any obstacle within the calculation target area can be taken into account on a calculation-cell basis. For 

each ca lculation cell , a flag can be determined to define an obstacle. By thi s means, river structures such 

as bridge piers can be easi ly incorporated in calculation . 

(9) The effect of vegetation on the flow can be introduced as a drag force. The user can set the density of 

vegetation and the height of vegetation in each computational cell. 

( 1) The model a llows the user to select between performing flow regime calculation only and performing riv­

erbed defonnation calculation along with flow regime calculation. 

(2) For sediment transport, the user can select between bed load only and bed load + suspended load. 

(3) For grain size distribution, the user can select between uniform and non-uniform. When non-uniform 

grain size is selected, changes in the grain size distribution in tl1e depth direction during calculation can be 

stored on a multilayer basis. 

( 4) The sediment suppl y rate at the upstream boundary condition can be adjusted. The user can set the ratio of 

"sediment transport supplying rate from upstream " to "equilibrium sediment transport rate" . 

(5 ) The sediment transport and mass balance of it on the fixed bed can be calculated by introducing the bed­

load layer model. In addition, the user can set either the elevation of river bed or fixed bed . 

' 1 This is a high-order finite-di fference method. By using a cubic polynomial as an interpol ation function, numeric diffusion is re­
duced, thus enabling high-precision local interpolation. 
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(6) The user can select a tota l bedload transport formula from among [Meyer-Peter and Muller formula] and 

[Ashida and Michiue fommla]. For calculating the bedload transport vector, the user can select [Watanabe • 

formula] or [Ashida, Egashira and Liu formula]. 

(7) The user can select an upward flux of suspended sediment from river beds from among [Lane-Kalinske 

formula] and [Itakura and Kishi fonnula]. 

(8) Morpholog]cal factor which is an acceleration parameter of bed evolution can be set. 

(9) The solver incorporates a slope collapse model. An unrealistic steep slope can sometimes occur in the bed 

evolution, if it is simulated by using only Exner equation. In this model, if the angle of riverbed exceeds 

the critical angle, which is a user parameter, the bed is instantaneously corrected to adjust the bed angle (to 

be not larger than the critical angle) . By applying this model , the user can treat the morphologic evolution 

processes such as bank erosion, which cannot be well captured by using only continuity equation of riv­

erbed. 

(10) Bank erosion takes into account of the angle of repose. More specifically, when the riverbed slope ex­

ceeds the angle of repose as riverbed deformation proceeds, adjustment is made by exchang]ng sediment 

with surrounding cells such that the bed angle slope decreases and fall lower than the angle of repose. In 

addition, if the channel widens from bank erosion, calculation grids are automatically moved accordingly. 

II 4. Other features 
(1) HotS tart is provided (starts the calculation from where the previous calculation left off, based on the pre­

vious calculation results). 

(2) The user can use parallel computing by OpenMP for reducing the computational time. The user can spec­

ify the number of the CPUs used for the computation. 
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II 5. Calculation steps 

You can use ays2DH in the iRlC for your calculations as fo llowing procedures; 

Launch Nays2DH 
Prepare to use ays2DH in iRIC 

Generating the computational grid 
Generate the computational grid by using several geographi c data 

(river survey data, Digita l Elevation Mode, etc). 

Setting the computational conditions 
Set initial and boundary conditi ons, etc. 

Running a simulation 
Use ays2DH to run a simulation. 

Visualizing the simulated results 
Visualize the simulated results by contour maps, vectors, strean1lines, 

parti cles and etc . 
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II 6. Operations in [Object Browser] 

iRIC uses [Object Brow er] for all sub windows except [Solver Console] and [Graph Window]. 
/ Pre-processmc- -W-in-do-w------------------------~§~ 

Object Browser 

Geocraph1c Data 
ElevatiOn 

R >!rSur e 1 
_ TopocraDhiC As1=•ec1 

• .. md \18 5 = ~( l 
Grtd creatnc cond!loo 
:.r1d ~hape 
rJ )de .attributes 

£1e·~·at,on 

Cell :~ttrb.Jte~ 
Bad croond Imace::. 

~rowser 

X 

J 

[Object Browser] of the [Pre-processing Window] 

• In [Object Browser] , the following operations can be made: 

Selecting an operation target: 

Elevoflon 
13.0 
11.2 
8.9;> 
6.5d 
4.19 
1.84 
-O:i03 
-2.8:i 
-5.20 
-7.5d 

Left click on the item to select data to be edited. The menu enables operations that are possible under 

the configuration of items elected in [Object Browser]. 

Switching between "show" and "hide": 

Make a check mark in the box left of the item, to make it shown on the canvas. For items in hierar­

chical trees, if the check mark for the upper-level item is removed, the item and all the lower-level 

items are hidden. 

Changing the order of items: 

An item can be moved up and down to change order_ This operation is available only for [Geographic 

Data] and [Background Images] on [Pre-processing Window]. Select + I + on the Operation 

Tool bar to change order of items. 

Changing a display setting in [Property] dialog: 

Open right-clicking menu and click on [Property] to open a dialog and modify settings. Some items do 

not have [Property] dialog. 

Importing I exporting data 

Open right-clicking menu on an item to facilitate data import or export. Some items do not have import I 

export feature_ 
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• View changing operations can be made with Ctrl key and mouse operations . 

View changing operations on the canvas 

Operation Action Cursor during action 

Rotate Right drag while press i11g Ctrl key. Q 
Zoom Drag the scroll button (wheel) while pressing Ctrl key, p 
in/out or scroll up/down the scroll button. 

Drag Left drag while pressing Ctrl key. ~ 
~ 

7. Toolbars 
[Main Toolbar] handles fi le VO, view setting operations for canvas, solver launching and opening sub 

windows . 

[Maio Toolbar] 

Functions of the items on the [Maio Tool bar] 

Icon Name Description 

[Open] Opens a project fi le 

[Save] Saves the project. 

[Save Snapshot] (N) Saves a snapshot of the active window. 

Saves images of each time step produced by the 
[Continuous Snapshots I Google 
Earth Export] 

Post-processing Window/Graph Window into image fi les, 
and outputs a KML fi le for Google Earth . 

lt1 Undo Undoes the most recent action. 

~ Redo Redoes the most recent undoed action. 

©, Fit 
Zooms out such that everything is di splayed in the win-
dow. 

Rotates the graphic such that the X-axis is pointing right-
12 Reset Rotation ward (in the positive direction) and the Y-axis is poin ting 

upward (in the positive direction) . 

~· 90-Degree Rotation Rotates 90 degrees counterclockwise. 
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Rotates the graphic such that the X-axis is pointing right-
Yx XY-plane ward (in the positive direction) and the Y-axis is pointing 

upward (in the positive direction). • Rotates the graphic such that the Y-axis is pointing right-
:z, YZ-plane ward (in the positive direction) and the Z-axis is pointing 

upward (in the positive direction). 

Rotates the graphic such that the Z-axis is pointing right-
Zx XZ-plane ward (in the positive direction) and the X-axis is pointing 

upward (in the positive direction). .. Moves to the left Shifts the viewpoint to the left. .. Moves to the right hi fts the viewpoint to the right. 

Moves to the top Shifts the viewpoint to the top. 

Moves to the bottom Shifts the viewpoint to the bottom. 

<!1. [Zoom in] Zooms in on the display. 

0,. [Zoom out] Zooms out from the display. .. Extension in the X-axis direction Extends only in the X-axis direction . 

•• Shortening in the X-axis direction Shortens only in the X-axis direction . 

... Extension in the Y-axis direction] Extends only in theY-axis direction . ... 

... Shortening in the Y-axis direction Shortens only in theY-axis direction . ... • 
~ [Run] Starts the solver. 

[Stop] Stops the solver. 

' Display Pre-processor Opens [Pre-processor Window]. 

• Display [Solver Console] Displays [Solver Console] . 

~ 
[Open ew 2D Post-processing Opens a new [2D Post-processing Window]. 
Window] 

20 
[Open ew Bird's Eye 2D Opens a new [Bird 's Eye Post-processing Window]. 
Post-processing Window] 

~a 
[Open ew 3D Post -processing 

Opens a new [3D Post-processing Window]. 
Window] 

IS [Open ew Graph Window] Opens a new [Graph Window]. 

~ [Compare with measured va lues] 
Opens a dialog to compare calculation results with meas-
ured values 

[Reload Calculation Result] Reloads calculation result. 

~ [Mouse Hints] Displays the [Mouse Hints] dialog. 

• 
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• Mouse Hint] dialog 

Menu bar: [Help] (H) ..,.. [Mouse Hints] (M) 

Operation Toolbar: eJ 

II Mou•e Hint 11JL8] 

lf!ill·~ Pan 

@!!!!• ~ Zoom 

@!!!!• e Rotate 

[Mouse Hint] dialog 

8. Grid creating algorithms available in Nays2DH 
Several types of grids generator can be used in ays2DH solver. 

Grid creating algorithms available in Nays2DH solver 

Created grid Item Description 

[Create grid from polygonal Creates a grid that smoothly fo llows a polygo-
lines and width] nalline . 

Creates a grid fro m [River Survey Data]. In 
[Create grid from river urvey addition to transverse lines being set, division 
data] points are set on the transverse lines the river 

centerl ine and left I right bank lines. 

Two-dimensional [Create grid by dividing rectan- Creates a rectangular grid that is evenly divided 

structured grid 
gu lar region] in the x and y directions. 

Creates a grid that has lower channel, by defin-
[Create compound cham1el gri d] ing grid creating region and lower chmmel re-

gion. 

Create a geometric grid such as straigh t, si-
Multi function grid generator ne-generated curve, zigzag, or Kinoshita me-

andering curve 

Simpl e grid generator 
Create a geometric grid with straight or si-
ne-generated curve 
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Tutorial 1. 

Flow Simulation for a Channel with Structures 
• Purpose of this tutorial 
Simulate the flow regime (water depth and flow velocity) by using ays2DH for a channel with obstacles 

and with a certain discharge, and verify the simulation results. 

• Outline : 
Creating the calculation grid 

Using the grid creating algorithm ofiRIC, create a calculation grid for a straight channel (10m long, 0.5 

m wide) that has four obstacles that resemble spur dikes. Create calculation grids: 21 division points in 

the transverse direction, and 201 division points in the longitudinal direction. 

Setting the calculation conditions 

Set simulation conditions for steady flow with a discharge of 0.003 m3/s for 600 seconds (10 minutes). 

Set various other conditions necessary for simulation. 

Making a simulation 

Visualizing the calculation results 

This section explains examples of how the "particles" and streamline are used to visualize the flow field. 

1. Generate a computational grid 

Operations related to [Geographic Data] are available from [Geographic Data] menu when the 

[Pre-processing Window] is active. [Geographic Data] types that users can import and edit depend depends 

on the solver. Currently, iRIC supports the fo llowing three types of [Geographic Data]. 

• River Survey Data 

• Elevation data 

• Polygon 

In Tutorial 1, generating a rectangular channel computational grid with rectangular cross sections, use [Mul­

tifunction Grid Generator] provided in iRIC. By using [Multifunction Grid Generator], user can create age­

ometric channel such as Straight, Sine-generated curve, Zigzag, and Kinoshita meandering curve. The opera­

tion to make a straight channel in Tutorial 1 is as below. Fist, select Menu bar-> [Grid]-> [Select Algorithm 

to Create Grid], and select [Multifunction Grid Generator] in the dialog of [select grid creating algorithm]. 

After the dialog for grid generation is opened, set the various conditions for generating the computational 

grid as fo llows; 
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[Channel Shape)----- Select Channel Shape : Straight, Cross Sectional Shape : Single Cross Section 
[Cross Sectional Shape Parameters)----- Width: 0.5m, Number of Grid in Latera l Direction : 20 
[Channel Shape Parameters]----- Wave Length of Meander: 1Om, Wave umber: 1 

umber of Grids in One Wave Length : 200 
[Bed and Channel Shape] ----- Initial Bed Shape: Flat (no bar), Channel Slope : 0.001 
(Bed Condition] ----- Bed Condition :Movable Bed 

The default values are used for the other parameters. 

The computational grid will be generated as fo llows; 

By using the mouse to move the grid and to zoom in and out, the grid becomes easier to see. 

Display settings for grids in Object Browser as below. 

Menu items in [Display Settings] 

Menu Description 

(Grid shape] (S) Edits di splay settings on grid shape. 

[Node Attribute] (N) Edits display settings on grid node attribute. 

[Cell Attribute] (C) Edits display settings on grid cell attribute. 

[Set Up Scalarbar (U) Edits display settings on color bar. 

a) [Grid shape) (S) 

11 

Right click on [Grid Shape] and select [Property], then [Grid Shape Display] dialog will appear. In the dialog, 

you can change the setting to visuali ze the calculation grid in the pre-processing window in iRIC. 

Nays2DH Tutorial 

• e .J GeogBphte Oira 
e Elewlion 
., Ot>stacle .. _ 
i!l Roughnc=Ss con 
21 Areal tradaon t· 

QKI Creat~t~g eo-
~ ~ConddJ·· 

- e Gncl 1 1 x 9 - 189 

iRJC Phoenix 2016 91 of 252. - -

' Gnd Sha ... ? 

G001il106 

~ AJI 

ra OuthmOnly 

Color -
Gndirdces 

r Visfb'o 

Color -
OK C.nc.l 

1 I 1 1 

Example of grid shapes 

r: n 1. 



12 

(b) Node Attribute (N) 

Right click on [Node Attribute] in the object browser and select [Show attribute browser], Attribute Browser 

window will appear as below. In this di alog, user can confirm the gri d number of I and J, X and Y coordinate 

valuables, and Elevation value at the selected location. I is the grid nwnber of the longitudinal direction, in­

creasing toward to the downstream direction. J is the grid number of the transverse direction, increasing from 

left bank to right bank direction. 

Unotled ·!RIC 2.3.9.603'1 [Nay<20 Fk>Od v5.0 64 b<t) ·[Pre-processing Window) 

.... • .. '~ '"" "•II' 

· i' .;) Geo,I~O..W 
~ - tllt•r.•.on 

~ ""'""" ... _ .. __ 
Jot • Al8l nct!JI'\ t-

~ J Gri:t~Co 
e ~,eoe.J11 

- Ia Gn.:J(2 l )!i • lW} 
Ill Clid::N;NI 
il NoO&llt'tJI:utes 

e l rw.. 
. n • c.t •Ur 

ee~M J.6:-t 

0400: : .. • • ... 

Attnbute _Bro_~_ .. _r ---' 

"- " -;;g~~aa. ~ .J Axd J 5 y 0 
• 0 .;l ~-

e J I'\NJ.IS• r....._-":-::.,...,....--:-:c-::,_.c:::--.,.-:-::'""":c:-r--
'E~ -e.ooos 
"[Nv'3t101" 0.0001 

In addition, when you right click on [Node Attribute] -> [Elevation] in the object browser and select [Prop­

erty], Grid Node Attribute Display will appear as below. In this dialog, you can change the maximum and 

minimum scale value of the elevation contour map, contour color setting, transparency of the contour map, 

and so on. 

(c) Cell Attribute (C) 

.._ 
e Roughntss con-·· 
e Aleal trJCtion t .. . 

.J Grid O'eabng eo. 
e Bouodafy Concflti· 

Gnd (21 • 9 189) 
21 J Gdd~ 
el Node attnboles 

ContDur-5etti,.. 

t= ColorFn,., r eon-..)!, .. ~ r ltolil"tN 

When you select [Cell Attribute], you can confirm the location of Obstacles, Fixed and Movable bed, and 

Height of Vegetation if you have set such valuables to the grid, and also confirm Manning's roughness coef-
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ficient and Grain size di stributions in each grid cell. 

. file Import Geographic Data Grid Measured values Calculation Condition Simulation calculatk>n Result V"tew Option 
W .., ,.. '•tl "Jc lv~ ••tf ~ uu;: .. fr. , C.. .. ~ 

1<1 "' Geographic Data 
Ill Elevation (m) 
1!1 Elevation or fixed bed (Ill) 
e Obstacle 
El fixed or Movable Bed 
E!1 o Density ol \lcgcl<ltion (m-1) 
!ll Height ol vcgemtion (m) 

u Manning's roughness coefficient 
B u Grain )(le distribution 

e:l .l Grid Cleating Cond1tion 
- E!1 Grid(21 x9- 189) 

B J Grid shape 
- 0 Node attributes 

0 J Elevation (m) 
) Elevation of fixed bed m 

Ill J Obstacle 
0 .J Fixed or Movetble Bed 
0 J Dcnsoty ot VcgctoltK>n (m- 1) 
0 J Height ol Vegetation (m) 
0 J Maming's roughness coclftdcnr 
0 J Graln size diStribution 

e Measured values 
E'l Bad<ground Images ~ I 
i<l J Axes ...:...J 

(d) Set up Scalar bar (U) 

When you select [Geographic Data] -> [Set Up Scalarbar] on Toolbar, the [Scalar bar Setting] dialog wi ll 

open . In the dialog as below. Select [Elevation (m)] here, then scale bar of Elevation will appear in the 

pre-processing window in iRIC. If you want to change the scale value of the Elevation, select (Geographic 

Data] -> [Color setting] on Toolbar. 

+ + 1' 

) bject Browser 
E:l Geogrc 

E:l Elev. 

E:l Fixer 
E:l Den! 
E:l Heig 
0 Man 
E:l Grair 

E:l D Grid 0 
E:l Grid (::i 

E:l r.rirl 
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2. Set Manning' s roughness coefficient 

Set Marming's roughness coefficient on calculation grid. Select [Geographic Data] -> [Manning's rough­

ness coefficient] in the Object Browser and select [Add] -> [Polygon] by right clicking on the [Obstacle]. 

Make a polygon by PC mouse as like figure below. If you want to add different Manning's roughness coeffi ­

cient in each grid cell, make several polygons respectively. 

3. Set Obstacles 

• .. 

Set obstacles on calculation grid. Select [Geographic Data] -> [Obstacle] in the Object Browser and select 

[Add] - > [Polygon] by right clicking on the [Obstacle]. Make a polygon by PC mouse to select the area 

where an obstacle is to be set. 

After making polygon, [Edit Obstacle value] window will appear . 

. ' Edit Obst2>de w lue '1f ll 

Please i1put new value in this polyson. 

Obstocle ' I Obstocle ~ I 
OK I I Cancel I 

Select [Obstacle] and click on [OK]. 

11 11 IIIII Ill 

Select [Grid] - [Attribute Mapping]. Then, [Attribute Mapping] window will appear. In the window, check 

graphical data which you want to give to the grid as attributes. ow, select only [Obstacle] and [Marming's 

roughness coefficient], and then click on [OK]. 
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Geographic Data 

I Bevation (m) 

I Bevation of hed bed (m) 

F' 01:61ade 

r Fixed or Movable Bod 

I Dansity of Vegetation (rrr-1) 

I Height of Vegeta tion (m) 

P'" Manning·s roughness coefficient 

I Grain si2e distrib..rtion 

? 

Check Al l II OK Cancel 

• 

• 
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To check the results of attribute mapping, select [Grid] -> [Cell Attributes] in the Object Browser and 

make a check mark Ql in these boxes; also, select [Grid] -> [Cell Attributes] -> [Obstacle] and make a 

check mark Ql in these boxes. 

8 0 ~ ,o.oc....,. Oat• 
0 '-2 Etev•t"" (m) 
~ 12 Elevaton of foced bed (m} 

!!] ~ ""''"~ 
!!) (,? Fi<od "' - ... ~ Bod 
~ ~ Demit)' of Vecetahon (m-1) 
0 ~ Hecht of Vecetahon (m) 
0 t;:? M.Ynin&'s rcucMess coeffiC"'' 

!!] t;? Gra.,si:!ed~trb.ltiOn 111111111111111111111 
~ L.) Grid C..eatrc ConditiOI'I 

8 0 0.~ (201 ' 21. •221) 

0 D "'"'"-o Node attrh:tes 
8 ~ Cell attr~es 

~ Obstacle 

0 Q '"'"""'-... ~Bod 

I 
0 D Densrty of VecotatiDI'I (··· 
0 D HeiCht of V«etahon (m) 
o D ~nc·• rOUimeu CO" ·· 

0 0 Gran s12e dis:tributm 

Set four obstacles on the calculation grid in the same way. 
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Cells that share an attribute are 
displayed in the same color. The 
blue ones are fluid cell s. The red 
ones are obstacle cell s. 

Example: Set four obstacles. 

Note: Setting obstacles near inlet 
or outlet areas of the calculati on 
flum e will cause instabili ty of 
your calculation . 
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4. Setting calculat ion conditions 

Select [Calculation conditions] - ) [Setting] on menu bar and set calculation conditions as fo llowings. 

The default values are used for the other parameters. 

Solver Type: 

.1J.£ 

I••""""' :::1 
lo""'"" ::J 
jciP method :::1 • Select solver type---- Standard 

lo ...... ::J 
j !Jolr~or.., ::J 

I""'""' :::1 
•Bedload trans:port lorrrulo lor w11form cedunen~ 

Bed defonnation---- Disabled 
Finite difference method of ad­
vection tenns---- CIP method 

•VeciorolbeclloadtrllnStO"t 

•FcrlftJio ot ~dtUx ot ~load tromrrv« bed i'· lJI'll~l:"ldlftlrn.J 3 
Note) You can select the items with 
mark [ + ], in case that you select [Ad­
vanced] in [Select Solver Type]. 

jDI5libled 3 
I"' ::J 

I Zeroe~tl'lt1~1 iJ 
· How to set elevat10r1 of fixed bed 

ays2DH has two types of solvers: the standard edition and the advanced edition. The standard edition al­

lows you to perform flow regime analysis of general river segments and analysis of bed defonnation with 

uniform sediment material. The advanced edition allows you to deal with more complex boundary conditions 

and initial conditions such as the following: non-uni fonn grain size multilayer model , river confluence model, 

Hot start, and so on. 

Descr iption of Solver Type settings 

# Item Description Remarks 

Sets the solver type. Choose [Standard] When [Standard] is selected, 
1 Solver type 

or [Advanced]. items marked [+] cannot be set. 

Sets whether or not bed deformation is 
2 Bed deformation 

calculated. 

Finite-difference Select the finite-difference method of 

3 method of advection the advection terms between [Upwind 

terms difference method] or [CIP method]. 

Boundary Condition: 
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.ll.l!l 

P.,oodc~cond41CW'l ~ 

~lerari~at~trMm jlhformfloow ::::J 
Ccro;-tarrtvaloe ( m) r--o 
Slope kt W~rtc.-., llor!oo jCak:ulated lro111 ceopepluc dot. iJ 
Slooeval.oe et dcMn=tteam ~ 

Velcx:rTy .. ~.Ptfum j ~.Mrfarm f brrt :o:J 
Slooe tor wcr .. to.. jc.a,IW!d fro"' ciiOII'GPhc dat.t ::::J 
SIQc»val..eoi\14JCTellft ~ 

•Sicoevel..eollrb.luryc:n.ret ~ 

Time.~.n~toldiSd'lllru/...atetSI.riecefile ~ 

Time-oesold-=tw•e•t~C~Strum.-d-ter level et dooon:tream ~ 

•O..chert o timo-esoltrbnarychernel ~ 

oCNrcethe$lAIPtyr~eofted•men1fromlh.~CJ;IrNI!Ibor.ldiry ~ 

•Thert!OoiSIO.CIClled$Cid•lhlll'lltr.-.oortto..,eQ..IIIbullls.iomantlr.tflSIIOI1U0 ~ 

• 
• 
• 
• 
• 

Peri odic boundary condition 
---- Di sabl ed 

Water urface at downstream 
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---- Uni form flow 
Velocity at upstream 

---- Uni form fl ow 
Time--- Second 

Click on [Edit] to set di scharge 

After click on [Edit] , the window for setting the discharge will open as below. In the window, click on 

[Add] and input the following settings. 

fi Calculation Condition 

~ 
Add Rerrove J 

Im po rt Clear 

# Item 

Periodic boundary 
I 

tion 

Water surface at 
2 

stream end 

3 Constant va lue (m) 

X 

0.0045 _,-------- 0.6 

0.004 

~ cg 0.0035 

l 0.003 
to 

.I: 
~ 0.0025 
0 

0.002 

0.0015 

0 50 100 150 200 
T ime 

0.4 

~ 
0.2 0) 

S 
' 0 (D 
< 
(!) 

-0.2 [: 

-0.4 

-0.6 

OK Cancel 

• Time---- 0 - 200 sec 
• Di scharge---- 0.003 (m3/s) 

Descriptions of boundary condition settings 

Description Remarks 

condi - Enables/di sables the periodic 

boundary condition*2. 

Sets water surface at downstream 
When set to [Given fro m time seri es 

down- end. [Constant va lue], [Uni fonn 
data], the user should set the water 

level changes 111 [Time series of 
flow] or [Given from time series 

data] can be selected. 
di scharge at upstream and water lev-

el at downstream] 

Enter a value if you have selected 

' 2 [Periodic boundary condition] give the hydraulic and sed iment transport conditions at the down tream end to the upstream end. It 
is used when hydrau lic conditions, channel conditions and sediment feeding conditions are of period ic nature, uch as in the case of 
experiments. Before using it for an actual ri ver, suffi cient verification of periodici ty is necessary. 
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7 

8 

9 

10 

11 

[Constant value] for [Water sur­

face elevation at downstream 

end]. 

Enter a value if you have selected 

18 

Slope for unifom1 flow 

[Uruform flow] for [Water sur- If [Calculated from geographic data] 

face elevation at downstream is selected, uruform flow calculation 

end]. Select [Calculated from is done using the slope of the down­

geographic data] or [Constant stream end calculation grid. 

value]. 

Enter a value if you have selected 

Slope value at downstream [Constant value] for [Slope gra­

end dient for uniform flow simula-

tion]. 

Sets the velocity distribution at 

Flow velocity di stribution the upstream end. Select [Calcu-

at the upstream end 

lope for unjfom1 flow 

late from water depth at upstream 

end] or [Uruform flow]. 

Set this if you select [Uniform 

flow] for [Flow velocity distribu-

tion at the upstream end]. Select 

[Calculated from geographical 

data] or [Constant value]. 

Enter a value if you have selected 

Slope value at upstream [Constant value] for [Slope gra­

end dient for uruform flow simula­

tion]. 

+Slope value of tributary 

channel 

Time unit of ills-

charge/water surface ele­

vation file 

Enter a value when using the 

confluence model when you se­

lect [Constant value] for [S lope 

gradient for urufom1 flow simu­

lation] . 

Sets the unit of time for the time 

columns of Discharge time se­

ries, Stage at downstream time 

series, and +Discharge time se­

r ies of tributary charmel. Select 

[Second] or [Hour]. 

If [Calculated from geographic data] 

is selected, utliform flow calculation 

is done using the upstream toe slope 

of the calculation grid. 

Time series of discharge at Click [Edit] and set the discharge Select [Second] or [Hour]. The unit 
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upstream and water level hydrograph and the water level 

at downstream variation 

+Discharge time series of 
Sets the discharge hydrograph of 

13 tributary channel when the con-
tributary channel 

fluence model is used. 

+Change the supply rate The user can change the supply 

14 of sediment from the up- rate of sediment from the up-

stream bow1dary stream boundary. 

+The ratio of supplied The ratio of supplied sedi-

15 
sediment transport to an ment-transport rate to an equi-

equilibriwn sediment libriwn sediment-transport rate 

transport(%) can be defined. 

Time: 

i Calculation Condition 

Groups 

Solver Type 
Boundary Condition 
Time 
Initial Water Surface 
Bed material 
Vegetation 
+Confluence 

Output time interval (sec) 

Calculation time step (sec) 

Start t ime of output (sec) 

Start Time of ted deformation (sec) 
[Neaatlw Is ro ted deformation] 

Maximum numt:er of Iterations of water surface calculation 

+Non-uniform ma... Relaxation coefficient for water surface calculation 

+Bank erosion 
+Secondary flow 
+Others 
+Hot Start 
+Output variables 

X 

031 

0.01 

0 

30 

10 :B 
OB 

• • 
• 
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of discharge is "m3/s." 

Select [Second] or [Hour]. The unit 

of discharge is "m3/s." The same 

data nwnber and start-end time is 

required benveen the main and trib-

utary channel. 

When you select [Periodic bounda-

ry condition], you cannot select this 

option. 

The ratio is in %. 

Output time interval (sec)---- 0.3 
Calculation time step (sec) ---- 0.01 
Start time of output (sec)---- 0 

Descriptions of time-related settings 

# Item Description Remarks 

1 Output time interval (sec) Sets the time interval at which 

calculation results are to be output. 

2 Calculation time step (sec) Sets the time interval of calcula- This is an important parameter that 

tion steps. determines calculation efficiency 

and stability. 

3 Start time of output (sec) Sets the time to start outputting 

calculation results . 

4 Start time of bed defor- Sets the time to start bed defor- If a negative sign is specified, bed 

mation (sec) mation calculation. deformation calculation is not per-
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formed. 
~-+----------~-------------~ 

5 Maximum number of it- ets the number of internal itera- If water surface elevation calcula-

erations of water surface tions when water surface elevation tion is unstable, adjust this setting. 

elevation calculation is calculated. 

6 Relaxation coefficient for This is the coefficient that is used 

water surface elevation when water surface level calcula-

calculation tion is performed. 

Many other conditions can be set; however, they do not need to be set for this simulation. 

After making the settings above, click on [Save and Close] to close the window. 
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5. Making a simulation 

Before starting the simulation, select [File]- [Select As F ile (* .ipro)] and save your proj ect. The File exten­

sion [*.ipro] means a compressed fi le. If there is possibil ity that your proj ect fi le will be larger than 2G bytes 

after your calculation fi ni sh, select [Save As File .. . . ] instead of [Select As File (* .ipro )]. 

For running a simulation , select [Simulation] -> [Run] in menu bar or select ~ on the menu tool bar. Then, 

Solver console w indow wi ll appear and calculation starts. 

Solver Console Window: 

~ ' ' ' ' ~ ~;: [8. f1le I~ Si!rul.!ltiOn G!.lc:uiet101'1 Resuh Vew ()pt~:~n Help 

M ~~~· . ,., r . r.r Yx "-< "x l!.l e I++ ••: ! I .. • I .' A ~~ » 

0. 400 0 . 0030 0.0350 o ou< .!.J 
0.500 0 . 0030 0.0350 . ..,, 
0.600 0 . 0030 0.0350 . ..,, About the output values of the solver o. 700 0.0030 0.0350 o ou< 
o.eoo 0.0030 0.0350 . ..,, console: 0.900 0.0030 0.0350 o ou< 
1 . 000 0.0030 0 . 0350 . ..,, • The red box bows the times taken 1 . 100 0.0030 0.0350 . ..,, 
1 . 200 0.0030 0.0350 . ..,, 

for calculation (sec.), 1.300 0.0030 0 . 0350 . ..,, 
1.400 0.0030 0 . 0350 '"'" 1.500 0.0030 0.0350 . ..,, • T he blue box shows the calculated 
1.600 0.0030 0.0350 . ..,, 
1 .700 0.0030 0 . 0350 ' ..,, d ischarges (m3/s) 1.eoo 0.0030 0.0350 0 OU< 
1.900 0 . 0030 0.0350 . ..,, • The green box shows the water el-2.000 0 . 0030 0.0350 . ..,, 
2.100 0.0030 0 . 0350 . "'" evation at the downstream end (m). 2. 200 0 . 0030 0 . 0350 o au< 
2.300 0.0030 0.0350 . ..,, • The number of "8" shows iterati on 2 .4 00 0 . 0030 0.0350 . ..,, 
2.500 0.0030 0 . 0350 . ..,, 

t ime 2.600 0.0030 0 . 0350 ' ..,, 
2 . 700 0.0030 0.0350 o ou< 
2. eoo 0.0030 0.0350 e ou< • Out denotes that the solver is writ-2 . 900 0.0030 0.0350 0 OU< 
3 . 000 0.0030 0.0350 . ..,, ing the resul t to the proj ect fi le . '=m- o ou< 
3 . 200 0.0030 0 . 0350 . "'" 3.300 0.0030 0.0350 o ou< 
3.400 0.0030 0.0350 . ..,, -:-

Pro,ect SUC:Ce$$fully 5aVed to ~¥LkerS;Vk)'th¥0esktco¥9¥1lJ~Nays2DH!OI)if.ilt11x IY· p 

The stop icon for the calculation is [Simulation]- [Stop] on the menu bar. 

If you want to visua li ze your ca lculation results before the calculation fini sh, Select [ca lculation result] -

[Reload] on the menu bar. 
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b --~ -• ...... , I 
01\culotion Result J View Option Help 

I ~ Open new 20 Post -Process1ng W1ndow 

~ Open new 20 B1rcfs-Eye Post-Processing Wmdow 

~ Open new 30 Post-Processing Window 

i{.. Open new Groph Window 

L. Compore w1th mellsured volues ... 

Relood 

X Delete ... 

Import. .. 

Export. .. 

Import Visuolizotion, Groph Settings . 

Export Visuolizotion/ Groph Settings ... 
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6. Visualization of calculation results 

Select [calculation result]-> [Open new 2D post-processing window] on the menu bar, or click on the but- • 

ton [2D] as shown in the following figure. Then [2D Post-processing Wmdow] will open . 

11ulation calculation Result View » 

• • • + 

~l s i '------== 

In the Object Browser, select [Nays2DH 1.0 64 (32) bit Grids] - [iRICZone] - [Cell Attributes]- [Obstacle 

(Obstacle)] and make a check mark 0 in these boxes. In the Object Browser, select [iRIC Zone] - [Ve­

locity (ms-1)], and then contour map of velocity wi ll appear. 

=- td U...,.;J-.":u.t.. 
21 [llv~O'Itlll) 

!1 tl••r.t-olhauMt.r-
d 21 ..,.... 

~ j ~"'~ 
b 21 ~.~r 

O J "'"""' 
O J ~-'..C.! 
U .) W..Nt-llrr-
0 j 'h'toci!J(• I) 
D.l ',..,.,,.._ 
0 ) O'fliSI<t~:r~t!Mr­
O ..l ~to:;,rwl#r• 
0 J C.•1Sot<t~:r~t~ 
tl ..l Ve\IQI;)(_..U(-

10 21 -n .J ,_.,.__• 
b 21 ~••llllr•n 

O .) v.__.o 
b 21 P.rto::lu 

n ..)~u 
PI Cdi•nrb.a.f 

• The obstacles will be indicated by 
red lines. 

In the Object Browser, make a check mark[{] in [Nays2DH 1.0 xxbit Grids] - [iRICZone] - [Scalar] -

[Depth (m)]. Set the time controller arrow icon, which shown in the red box in the figure, set t=O (t) . 

I \.llobW IIKZJ..Il>Tl9 ~1061bof:' I'Qst~f20 2!1 
,-. ~ o.- ~O.t. -...-~ ~.....,.. v.r.. eo- ..... 

a l .... ,, ~ • · · .. 
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• t = 0 (t) 
• Click on the start icon of the time 

controller on the toolbar. 

• The animation will start . 

• 

• 
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To fix the value range of the scalar bar on the depth contour map, right click on [Scalar] and open [Prop­

erty]. In the property window, make the following settings and click on [OK]. Then, scalar bar wi ll be 

fixed during the animation. 

Scalar Setting 

Physical Value : jDepth(m) 

!
Value range 

I Automat ic 

Max: lo.03 P"" Fill upJE r area 

Min: lr:o--=.002-=-=---- P"" Fill lower area 

Division Numl::er: h 5 

~Co lormap 

r. -..---~----.-

r Custom Setting. 

Display Se tting-------------, 

r. Colo r Fringe r Contour Figure r !salines 

I Transp:~re nt ''''''''''' ~ 

? X 

Region Setting I 
Color Bar Setting I 

OK Cance l 

• Remove the check----- Automatic 
• Max: ---- no change 

- Min------ 0.03 (m) 
-Max----- 0.002 (m) 

• Generation space interval---- 1/2 

• Remove the check----- Transpar­
ent 

In the Object Browser, select [Nays2DH 1.0 xxbit Grids] - [iRJCZone] - [Particles] - [Velocity (ms-1 )] 

and make a check mark 0 in these boxes. [ · ] will appear at the upstream end of the simulation. 

Set the time controller arrow icon, whjch is shown in the red box in the figure, set t=O (t). 
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~_U_-~~~~:::__· t = 0 (t) 

IXU421Sililh i'i'·61Slliriiii1H 

• Click on the start icon of the time 
controller on the toolbar. 

• The animation wi ll start. 
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If you want to edit the start position, the generation interval or the size of particles, select [Nays2DH 1.0 

xxbit Grids] - [iRICZone]- [Particles] in the Object Browser, and right click on [Particles] to open [Prop­

erty]. Then, in the [Particle Setting] wjndow, make the following settmgs and click [OK]. 

------- ----- - - - --===-- -------------
PI Particle Settinc ,_. 

Common Settings-------------, 

Generation time interval----------, 

~ ---- f-----. + f172 
1/ 5 

Start Position------------, 

Range -------------, 

Spec ify the area to generate particles. Q 

I Min 

I Max 

J Min 

l------f1j3 
f------f1j3 
l------f1j3 

1111111111111 1 1111111 

JMax ,,,,,,,,,,,,, , ,,.,,,?~ 

Generation space interval-------, 

1/ 5 

Color: 

Add Remove 

Region Setting I 

OK Cancel 

The color of animation is changed. 

1!!1 J O odst._ 
I"' PI kAiv 

0 .1 -o) 
rJ.l r~~ 
0 J W..ttr'"~~o-­
u .) \blotl)'(-1) 
o J r-..a ..... 
W .l Cr~~ ... -
0 .) C.on!i«•-11.­
U .) QDAS.;tu .. !k-· 
O .) \lrloc~ Ot-· 

ld -.~ 
0 ..) \ltloc~ l) 

F' l!l Sir ........ 

F g,!:~u 
Pl ..l ~~u 

F !!J .till t..ll.l. 
n ..l a.u,e~ (H. -
el j Cbi;!#;lr f<:k~ 
n .J r""":t • .....,. ...... 
o j r.-J. MrHOir­
n ..l r...., &.c'f'IC..tr.,... 
0 J Cu~1 ce lkltrr· 
CJ .) a-... . ,., .tmrr· 
0 J cu ... acedntrilr· 
n ..l o-."' ...,,_,_. 
0 .) Ch f'll a 411 illilr' 
f J..} G- -..-.• ..... 
0 J 0 1<'1 1C!I Iutrib- · .:.1 
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• Generation time interval----- 1/2 

• Start Position---- no change 

• Generation space interval---- 1/2 

• Color---- blue 
• Size---- 2 

• 

• 

• 
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This is another example. In the [Particle Setting] window, make the fo llowing settings and click on [OK]. 

.mJ Particle Sett inc :.~ 

Common Settings------------, 

Generation time interval---------, 

Q - ---~1-----. + 11 
1/5 

r Start Position 

Range 

Specify the area to generate particles. ~ 
I Min / f1"33 
I Max :~ 
J Min f1"33 (,I I I I I I I I II I I I ! Ill I t • • 

JMax---) :~ 
I I I I I I I I II I I I I I I I I I II a •• a. a 

Generation space interval 

~ ---J--+11 
I I I I I I I I I 

1/ 5 1 5 

•• C.,loo:. Size: - f2"3 . 
Add J : Remove · ........... . 

tJ Particle Setting ~-

Generatton ttme tnterval 

r

Common Setttngs 

~ - -.-.--. -.- .~-------. . II 
1 / 5 

t t• : 

. . . . . . . 

: . Start Position-----------, . . . Range------------, 

Specify the area to generate particles. ~ 

!Min ~ 

!Max ~ 

J Min -.-.. -.-.. -.-.. -.. r .. -.-.-.. -.-.. -. ~ 
JMax ,,,,,,,,,,,,,,,,,,,,(~ 

Generation space interval------, 

1/5 

Color: Size: @ I2'::B 

Add Remove 
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Region Setting I 

Region Setting I 

• Generation interval----- 1 

• Start Position 
- J Min------ 1 
- J Max----- 10. 

• Generation space interval--- 1 

• Color----- black 

• Click on [Add] 

After click on [Add], layer 2 will ap­
pear as left fi gure (red box). 

• Start Positi on 
- J Min----- 11 
- J Max----- 2 1. 

• Color----- pink 



The color of animation is changed and the animation is easier to see after it is restarted. 

f?J 
9 ~ Sc..!. 

O J """""' O J [leYMD"'(-.) 

0 .) Wau.s...t-EJ.v·· 
Q J \t:lrtocey(rl) 
Q ..) Frcu;le~ 
Q ..) Ctoc:S.ctoDNJMr·· 
0 .) er-s.ctiDNIA-·· 
D .l """"'ono!A··· 
0 .) Veb:II)(RriH -· 

8 1;!1 -0 .) Vebell)'(..--1) 
9 ~ Sn.llli-es-

0 Velou:~(erl) 

S ljl IH' 
E!J.) V.b::ll)(--1) 

a ~ c. . ... buld 
0 ..) thtecla (fb .... t ·· 
l!] ..) lht«:IB(ot.t«;-.) 
0 ..) Fao:edDI' llb.rablr·· 
O ..l f~orJo!oYM>Ir · · 
0 ..l <hncaed~S~JV·· 
0 J Chn ue dintr·· 
O .) <hnnedilll'b-·· 
O i.l Chnslll!d•~ritr· · 
0 i.) Chns~:ed•~rb'·· 
0 J (hnsaeda~rb'·· 
0 ..) (hrot~ndinb-· 
Q .) Chnuedi:fTtb'·· ..:.J 

" 

Visualizing with streamline: 

nme: HlJsec 

ilijx'i'mmlh"'ii"a.,.ii-IY -tlillmum 

26 

In the Object Browser, select [Nays2DH 1.0 xxbit Grids] - [iRICZone] - [ tream line] -[Velocity] and 

make a check mark 0 in the box. Then start animation. 

kJ J Ctd ...... 
-B ~ 

IJ J ........ 
O ..l tr.eto-Uo) 
O .J ~n-...... 
U .J V.~d 
0 rP'tlldt...-.. 
O..l o-.M..t-..~Mo-
0 J OOII!;.et-.A­
Q J '-­
o .J -..-n<-

.2 2.1 ..:.1 .....,. 
u .l \Wor~-u 
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Tutorial 2 . 

Calculation of flow and morphological change of river bed 

in a meandering channel 
• Purpose of this tutorial 
Simulate the fl ow and bed morphological change in a meandering channel with simple bed geometry to un­

derstand the fundamenta l bed evolution phenomena in a meandering channel and also the basic operation of 

ays2DH in iRJC. 

1. Generate a computa tional grid 

Generate a computational grid of a meandering channel with a rectangular cross section by using [Multifunc­

tion Grid Generator] attached in iRIC. Fist, cli ck Menu bar-> [Grid) - > [Select Algori thm to Create Grid], 

and select [Multifunction Grid Generator] in the dialog of [select grid creating algorithm]. After the dialog 

for grid generation is opened, set the various condi tions for generating the computational grid as fo llows; 

[Channel Shape]----- Select channel shape: Sine-generated curve 
[Cross Sectional Shape Parameters] ----- Width : 0.3m, Number of Grid in Lateral Direction: 16 
[Channel Shape Parameters]----- Wave Length of Meander: 4.7m, Meander Angle: 28.6 degree, 

umber of Grids in One Wave Length: 40 
[Bed and Cha nnel Shape]----- Channel Slope: 0.004 

The default values are used for the oth er parameters. 

The computational grid wi ll be generated as fo llows; 

• • All Import Gl!ogn!phlc Data Gnd MYSI.nd Wlues Cekulobon Condition SirniAa!XIn COklMtion Result V1tw Option • - • M 

lal 6 ~ ~('110..r!: t! "'x 7.,.Zx ••tf G\€l ++++!! lll> • . ~ .- §,~ ~ ~ 

lx: 2.0597-4388123 fv: -0.86648786068 

2. Set the cell condit ions 

The computational grid will appear 
on the screen. 

The cell conditions can be set on the generated computational grid. Here, you set the [Manning's rough-

• ness coefficient]. 
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Click on [Cell attributes] in the object browser, and change the status of cell attributes to 0. You can open 

the item of cell attributes by clicking on C> bottom on the left side of [Cell attributes], and then click on • 

[Manning's roughness coefficient]. 

. .. Ale Import Geogn!phk: Oi!!lll Grid M~sured ~lues Qk:u~tlon Condition Simulilltion Cela.Jiilltion Rest 

~ !"' ~ [2,~ "'x'Y"x ... t. e. e. •••• :: .. . : 

0 
0 Obstode 
li] Axed or MOVZible Bed 
0 Density ofllegetlltioo ..• 

0 Height of \legetlltlon ( ··• 

ftl M&nnlng's roughness c ·· 
fll Gnlin size disbibutkln 

~ D Grid creotlng Condition 

' 0 Gr1d (41 X 17 • 697) 

0 D Gr1dshope 
0 Node llttr1butes 

4 ~ Cell illttributes 

!:] D Obstllde 

1:1 D Axed or MOVllble B 

1:1 0 Density of Vegetllti··· 

[l D Height of Vegetllti 

rl Measured Values 
0 Sod<ground lmoges 

X 

• The left side of the figure is object 
browser, and the right side of the 
figure is the visualization screen. 

• When you want to change some­
thing such as geographic data, cell 
attribute, etc. in the visua lization 
screen, you need to click on the re­
lated item in the object browser. 
When you click on that item, the 
background color of the item 
changes to I ight blue. Such status is 
defmed as 'active' here. 

• Wbjle you keep the status of [Man­
ning's roughness coefficient] as 0 , 
the contour on the grid indicates the 
value of [Manillng's roughness co­
efficient]. 

Select all of computational grid by operating your mouse, and then right-click on the selected region. 

Then select [Edit value] on appeared menu. 

• You can directly change the value 
of cell attributes of each cell. 

• Hold Shift key and select some 
cell s. You can select a group of 
cells, even if they are not directly 
connected. 

On the dialog [Edit Marming's roughness coefficient], you can specify the value of this coefficient in the 

region you selected. 

By this procedure, Manning's roughness coefficient is set to all of cells in the grid. 

Input the new value of Manning's roughness coeffic ient at the selected grid cells. 

Manning's roughness coefficient : 0.0 131 

'----O_K-1~ I Cancel 
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• Manning's roughness coefficient 
:0.013 

• 
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3. Set the computational conditions 

• Select [Calculation conditions]-) [Setting] on menu bar and set calculation conditions as followings. The 

• 

• 

default values are used for the other parameters. 

Solver Type: 

eroo=~ e<mruon l 
nme 
Inltial\\'lltei"Surfac:e 

Bedmot2riol -­+Coolluonoe ·-= +Banlc erosion 

+Secondary flow 

S.lec1 ~Iva type 

Bed deformation 

Fnite drffcrontlllll method of odvect10n tcrmt 

·Bed matonalt)'(le 

•Sedm.en\tf~type 

•Bodlood tramport bnaJio for W'llform sediment 

•Vectlll' of bedb&d ~ 

.. .._ 

~ I 

'""""" · I 
lciP melhocl · I 

lklrior m 

•ForrN.Jio ot ~d fk.tt of~ lood from rM:t bed 11•~~"• and kGt\1 forMJio • 

+HoC':Stllrt •Bent CII'O.IOI'I 0-.abled 

.. s~ope co11ap;e model No 

•T.,..bulentrnoclel Zwt~eq,~$10'111'10del 

I •How to~~ elevatiOn of feted bed \,ke nd'411 bed elevetuu; of ft•ed bed ttll' ... 

Boundary Condition: 

Bodmot<NI _....,., 
..Q>nl!"""" 

+Non.unlformma· 

-Benk:eruslon 

+5«X>ncca<yllow 

·"""" ....... rt 

Co'\S~vaUe(llll 

S lopelorlnlfonnfbof 

Sklpevakaatcbw-ctreem 

\lekJclly et\.OftrUIII 

Slopelor~r~rlormfbot 

Slr:lpevaUea\I.C)Stream 

·Slape vaU of trllutary chin-e! 

TIINI&'I~O'Idlldwce./.,.terll.rftcefllt 

ll.hrforndboo · I 

•• 
Uttforr11IP. 

Cacula•~ trOftl uocro~Phc ~ .. 

T- SerMofdJid\II'"~I.OStreamend..eter !eYelet cbonstrelm 

'" 
oQwu the IIAlO'r tele ol $ed1men1 from the l,Cirteam bau-dary 

•The r11110 oiii.CIPiied aduntl'lt tr..soart to., eo.ullno~m sedunont tran;port 00 "' 

i Celculenon ConcLnon l!..WW 

nme ~m3/s) 
0 006 06 

1 0 0.004 00055 

2~0.004 
04 

0 005 ..., 
02 ~ ';:; o 0045 

..§ ~ 
~ 0 004 0 f 
.l! . 
-~ 0 0035 .0 2[: 
0 

0 003 

.04 
0 0025 

0 002 .06 
m ' 

0 500 1.000 1,500 2.000 

~~- Time 

~ DC]~ 
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• 

Select solver type---- Standard 
Bed deformation---- Enabled 

ote) You can select the items with 
mark[+], in case that you select [Ad· 
vanced] in [Select Solver Type]. 

Boundary conditions 

-Periodic boundary condition 
:Enabled 

- Tin1e uni t of discharge/water sur­
face fi le : Second 

• Set the discharge of upstream end 
- Select (Edit] and input Time and 
Di scharge. Time fro m 0 to 1800 
(sec), and a constant discharge of 
0.004 m3/s, is given in this example. 



Time: 

..... ..-. ............... 

4. Run a simulation 

Ol.rtJ:M t.,..nt.v•I(Md 

C.lc:u!.uan l lrlle CUIP (.c) 

Sl¥t tm.ol"""""' (secl 

St.tT-olbld defcrlfllltO'I (secl 
(Neu1,.. • no bed deioriNitoU 

---.. 
IJ I 

0 

10 

,, : .. 

4 

• Time Conditions: 
- Output time interval : 60 sec 

- Calculation time step : 0.0 1 sec 

- Start time of output : 0 sec 

For running a simul ation, select [Simulation] -> [Run] in menu bar or select ~ on menu tool bar. Then, 

Solver console window will appear and ca lculation starts. 

olver console : 

,• Solw<"""'*(-1.0 .... 11"""""1 ,_..,....., ,~ 
.. y:.Z:III SOl'"= Ve-n~ 1.0.000 l..ut l~Pda~ :lOU/ 1/:JO 
(:opyr111htCCJ2DOJ-2011 by fuuyukl 9I!Um, !lcl:bldo tl:l..lY •• .!&pel, anG !Uroshl T 
~'O.SI'Il. )tyou unt.v,. J~. All IU~t. kff.t"V'ed 

0.000 1:1.0040 0.010~ 0 Ollt 
10. 000 O.otl40 0 .010~ 11 o;n; 

120.000 0.0040 0.0 105 ll co:. 
1eo.ooo o.oo•o o.o1D5 u out 
240.000 0 .0040 0.0105 11 O:Ot 

5. Visualize the results 

• The numbers shown in solver con­
sole are time (sec), di scharge (m3/s) 
and downstream water level (m) 
(from left to right). 

• The [out] shown in right of numbers 
means that the iRJC output the re­
sult to the fi le to be visualized. 

Select [calculation result] -> [Open new 2D post-process ing window] in menu bar, or click on the button 

shown in the following figure; 

tion Condition Simulation calculation Result View » 

» 

~J § J 
L---------------------~== 
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You can visualize the item li sted in the obj ect browser to the visualization screen. Firstly, fo r visualizing 

the morphological change of bed, check the box of [ElevationChange] under [Scalar]. 

Anlmbtion Celculetlon Result VIeW Option 

" tf Yx Zv Zx ••tf ~~ ·•••l! ... . 

Sa>~>• 

!:J ;) Deo<ll(m) 
r:l ::l ,...llon(m) 
!:J J ,_.......,, 
!:J J Wo~ 

J ,...""""" .. 
J '""""'Y( .. 1) 

~ [) MenDitlmetl!l'( 

!:J i) F,_""""" 
C .:l PN 
!:J ;) ShieldsNumbeo" 
r:! ::l~ 
r:l ::l~ 
!:J ::l~ 

!:J i) ­
!:J .:l -ms-1) 
!:J J !l«<loodFlu><(m 

Arrow 

!:J i) ~ty(ms-1) 

!:J i) BedloodFIU>C(m nme: 1m sec 

Jxo - lv: -

• [Scalar]: show a contour map 
of selected scalar data. 

• [Arrow]: show a vector of 
selected vector data. 

• [Streamlines]: draw stream­
lines based on the selected 
vector data. 

• [Particles] : visualize particle 
movement by selected vector 
data. 

• [Cell attributes]: show the 
cell attributes you set in the 
cell conditions. 

• [Measured va lues]: You can 
read the measured data such 
as experimental data . 

For changing the range of color legend, right -cl ick on [Scalar] and select [Property]. 

Q, ,.IIOOs 

~ 5 ~,..."-llon(..,-m""'")-r--1+-' 
r:I J -· 
!:J ~ WI>~ 

~~ 
!:J ~ """""Y(H) 

.) Meai1Diarneter( 
0 D Fn:l!..ldeNunber 
!:J J Phl 
!:J ;) SM~d>Nunbor 

0 CrossSectioNII 
r:l i) OossSe<tionol 
!:J i) ~l 

!:J J SusperdedSedl 
!:J ;) -ms-1) 
!:J J B<dloodflux(m 

Arrow 

!:J J """"'Y(""·1) 
!:J J a.dloadFI<D<(m 
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""""' ~~ ··· · :: • • 

nrne: 1m sec: 

• You can change the location 
of the color legend by drag­
ging it. (You need to click 
[Scalar] to make the status of 
[scalar] 'acti ve'.) 

• You can pan , zoom and rotate 
the visualizati on screen by 
mouse operations shown in 
fo llowing figure : 

eJ f'.1ouse Hint l 'Y I~J 

[9ill+~ Pan 

[9ill+ ~ Zoom 

@ill+~ Rotate 
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In this dialog, you can set the maximum/minimum value for the legend colors range, the nwnber of 

labels for the color legend and etc. 

~ Scalar Settmg 

Physic.- I Value: ] ElevatiooCilance(m) 

v~lue ranee 

EJ Automatic 

Max: 0.02 

- I 

0 Fill upper area 

Min: ....,_0"'.04,----- 0 Fill lower area 

DivisK>n 1-Lmber: -,5- ~: 

Colo< map 

0 Custom Settinc: . 

Display Settinc 

.._. Color Fri1ce !_ Contour Ficure ..._, lsolines 

EJ Tranoparent 

., """'"" 
" ,.) Q'Cibpt ,_ 

J ~l"') 
.l~ ... , 
.l .._... • .) ........_, ·!l ­J~ .. IJ 
j ­_,,_ 
..l "' _, _ 
_, ............., 
j .,._ 

J<­
j ­
_) ~,..1) 

..~-~ 

Re2ion SettinJ< 

I color Bar Setting! 

OK I I c.ncel 

• Deselect [Automatic] box 

• Max : 0.02 (m) 

• Min : -0.04 (m) 

• Display setting : Contour Figure 

• Deselect [Transparent] box 

After set the conditions above, the 
contour map will be clear and point bar 
is clearly observed a on the inner bend 
with the erosion in the outer bend. 

ote) The default setting of display 
setting is [color Fringe]. But, a color 
contour will be much clear by select­
ing [Contour Figure]. In this case, the 
visualization will have higher quality 
but the load for visualization will be 
larger. 

In the next step , the flow field is visualized by vectors. Click on the box of [Velocity] under [Arrow] in 

the object browser. 

nme: HDJ sec 
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V ebclty(rr's-1 ) 

0.0 

The flow in the computation is 
visualized by vectors. However, 
the length of vectors is not suita­
ble for the visualization. 

• 

• 

• 
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For setting the properties of vectors, right-click on [Arrow] , and select [Property] on the appeared pop-up 

menu. The dialog for setting the vector wi ll open. 

~ Arrow Sett1ng 

Physica l value: !Velocity(ms- 1) 

Length 

D Auto 

Standard value: 

Length on screen: 

0.500 l: [m/ sl 

201 l: [p ixel] 

Minimum value to draw: 0.00 I 00 ~ [mls] 

Sampling 

<r All vertices 

_: Sampling rate: 

!- direction 1 : J- direcHon 

Color 

ii Custom color 

~ By scalar value Depth(m) 

OK J l Cancel 

• deselect [Auto] check box 

• Length on screen : 20 pixel 

By adjusting the length of vectors, you 
now can see the flow field in the me­
andering channel. 

One dimensional graphic function is used for visualizing the water level and bed elevation in a cross sec­

tions. Select [Calculation Result]-> [Open new graphic window]. 

• I caJ0<1M100 .....,. 1 VIew Option Help 

l15t Open I"'I!W 20 Post-Processing wmow 
~ Open new 20 Blnfs-Eye Post-Proc:essing Window 

rl l!i; """"""·30--~ .... - iJ 
~ ()p@n new Gnlph Window 

Nays2 DH Tutorial 

Ccm~re ttlrne:asurtd\1!11 

Relood 

)( Oeiet~ .. 

• Import. .. 

• Expolt.. .• 

• Import Vlsuellmdon/Gnlph sett1og5 .. . 

..,. Export VISUlltJUJtJOn/ Gnlph Settlngs. .. 
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The dialog for setting the data of lD graph wi ll open. Select X Axis as [J], and add [Elevation] and • 

[WaterSurfaceEievation] from [Two dimensional data] to [Selected data]. 

Calculation Resuh '-'Ext= .. """"I..L_ ___________ -, 

Two dimensional Data Selected Data 

Deptl!(m) Elevotioo(m) 

FlxedBedEievotioo(m) W.terSurforeE!evotlon(m) 

ElevobonOI!mge(m) 

Vortloty( S· l ) 

M~nOiemeter(mm) 

FroudeNumber 
Phi 

Shle'dsNumber ~ 
CrossSectionoiMinBedEiev(m) « Po"""" 
CrossSectlonoiAveBedEiev(m) 

CrossSectloMIAveWatert.ovel(m) 

SuspendedSedlmentconcentrotlon 
Velodty(ms· l ) (magnlbJde} 

BedloadF1ux(m2s·l) (magnitude) 

.I Settnc 

_,.--------- -----·"--- ''"''""-':71:"m ~1 = Gnl~ Window: 2 . ., 
E ooz ~ ~ -------------- w,ter&naceEIIrvatD'("" 

"'! 001 .. -.....;: ; 
E > 0 

'!-" 
-~ ~ -Q01 
~~ -o0'2 
w ~ 

,! -ooo 

~ -o04 
-<>05 

0 0 .05 01 015 02 0.25 0.3 

Corltroller 

l 

Dista nce 

0 ,, : 
[O.Ui&uce i! Ax•Senrc l D'•Set1 [~Seurc [ ~ 

I - llcsvr- 1 

You can change the style width and color of lines. 

!:::. Orow Settlng 

Bevation(m) lobe~ Elevotooro(m) y Axis 
waterSumce8evatioo( m) fo left v Richt 

Lr.. Styi« c:.ISo;_IOJ;_L_r.. __ y_,ILr.. Wdtk T: 

Color. -
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• X Axis : J 

• Two dimensional Data : Se-
lect [Elevation] 
[WaterSurfaceElevation] and 
click on [Add]. 

Then, The water surface and 
bed in a cross section are visual­
ized. Click on [Draw Setting] for 
changing the visualization proper­
ties of this graph. 

By moving the location of I on 
Controller, you can see the lD 
graph in a different cross sections. 

ote) I and J mean the index of • 
longitudinal and transverse direc-
tion in the grid. 

• Setting for Elevation(m) 
-Line style : olid Line 
- Line Width : 3 
- Color : Black 

• Setting for WaterSurfaceEl-
evation(m) 

- Line style : Solid Line 
- Line Width : 3 
- Color : Blue 

• 



• 

• 

• 

You can visually understand the line of water surface and river bed . 

-- ~~2 

ooo~i==----------=---- c ..... e~O"(..l 

' ow 11---- --- ------ - --s...~«co.--c..,) 
] oo1" __ _ 

ii () 
'!.! 
~§ -oot 
! ~ -c~ 

V-oco 

~ ..... 
0(15. 01 01!. 02 O.Z OJ 

l>is t• nc• 

, .. 
o.c.~ fL .tu:iiS.1'f"C ~:-....~nrc ]! Gcw 1 
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As the last step, simulated bed elevation change is compared with the experimental results. Right-click on 

[Measured Values], and select [Import] on the pop-up menu. 

J-~ -J~~l) 

J-m c.oe.-.... 
..l CJbcti,$(NOf .J-­..l Ruod•~ 
J~«MoY•b --­J ~tl!t:~ 

J CiBiftllt•cliltn 
J Grllllllledlstn 

J Grain&.~:eo.tn 
..l c;r- ..:• dctn 
~ er-~ ... _,. 
JCr.-Sl-V~ 

,J c. ... 14 .... ci5Crt 
.)GI -..-.r:cbttt I ,..._........, 

l ..) ~lf'I'\6Qft ·J-I .Jf.n. 
' J ..... 

~ I 0.".bnee'Mtlt~ 

• "measured.txt" is specified as 
a [Measured va lues]. 

The measured data will be imported. The range of color legend in the simul ated result and measured va lue 

is set to be same. You can change the range of color legend by right-clicking [Scalar] under [Measured Va l­

ues] and selecting [property] on appeared pop-up menu. 

Dz 
.0.04Xl .0.0314 .OD229 .0.0143 .0.00071 0.00260 0.0114 OD200 
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• ays2DH can reproduce the 
trend of morphological 
change of bed in the experi­
ment. 
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Saving the image fi le of the results: 

Select [File]-> [Save Snapshot] on Toolbar then [Save Snapshot] dialog will open. Input the file name and 

click on [Save]. 

SavcSnupshol ~ 

.... n ........ ' • m--- cl-
cl-

...... 
__) ............. 

"'"""""" 
... - ... _ 

= CE:::J fi«M 

Flesrltype: PNGt-.(•pc) ~ 

Saving the animation fi le of the results: 

Select [File] -> [Continuous snap shot/ Movie/ Google earth export .. . ] on Toolbar. CD Select target win­

dow wruch you want to export as an animation fi le. ® Select the file folder from the dialog. Q) Check 

output movie files and set specify movie length [sec]. @ Set start and stop time of the movie, and set skip 

rate 

® Wi ndow Selection 
Please select tarset windo"M> ard specify how }OU want to outp..rl 
files 

Ta®t windows 

E'l Post-processinci f2oj' 1 
0 !Post- rocessin 20 : 2 
o Post-processing (20): 3 

Qutp.Jt file Layout 

r. In one file r- Asis 

r Respectiwly ,. 1-torizorrtally r transoerent 

r Vertically 

<Bock 11 Next > 

® Movie Properties 
Please specify the properties ofoutp.rt files 

F' Outp.Jt movie files 

File reme 

im .wmv 
File name 

Cencel 

Play speed Profile !Default ::J 
"' Soodfy movie lenstl{sec) ~ 

r s..,dfy fremes "'' seoord ~ 

< Bock 11 Next> Cancel 
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@ Fi~ ~n:pe~es 
Rease speofy the ~rties of output files 

Directory 

_j 
File name 

Prefix 

img 

Suffix length ['4'3 Fomat IPNG (• p;;gj 

< Bock II Next> Canaol 

® rimestep Setting 
Please specify the start time steo. st.oo time step, and the skip rate 

start (,' ''' '''' ''' '' ''' ''' ''' '''' ''' 0 

Stop I I I I I I I I I I I I I I I I I I I I I I I I I I I I I I ( lE(X} 

Skip "'te fji"3 

<Bock 11 Next> Canaol 

• 

• 

• 
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• 
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End Tutorial 2 . 



1 

Tutorial 3. 

Flow and Morphodynamics Simulation for an Actual River 
• Purpose of this tutorial 
Simulate flow and morphology changes in an Actual River by using ays2DH, and verify the simulation re­

sults. 

• Outline: 
Creating the calculation grid 

Using cross-sectional river survey data of an actual river, create calculation grids: 11 division points in 

the transverse direction, and 216 division points in the longitudinal direction. 

Setting the calculation conditions 

Set simulation conditions for a steady flow discharge of 300 m3/s for 1 hour or 3,600 sec. Set various 

other conditions necessary for simulation. 

Making a simulations 

Visualizing the calculation results 

• Format of the river survey data: 
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* indexl- index4 
lndexl:Numberthat corresponds to the left bank distance post 
lndex2:Number that corresponds to the left bank shoreline post 
lndex3:Numberthat corresponds to the right bank shoreline post 
lndex4:Number that corresponds to the right bank distance post 

5JtS CJUF fe}., 

• 

• 

• 
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1. Generate a computat ional grid 

Import the elevation data (cross-sect ion river survey data) of the target river, and then generate a computa­

tional grid by using one of the grid generators called [Create Grids :from River survey data] attached in iRIC. 

On the menu bar, se lect [Import] -> [Geographical Data] -> [Elevation] , and then open the sample data 

named [ori.riv]. After the data is imported successfull y, the shape of the river as below will appear on the 

pre-processor window of iRIC. The nw11ber of each cross-section show the di stance :from the river mouse. 

S EJ G.otrckON 
8 E) EI•Ya10'1 ( ,.) 

El ...........,, 
EJ EMtlllf'l ol fiUdbed {lll) 

eJ """"" E1 Fndorlllo.-ablcs.d 
El t:l Dlnll)oo!V..e\.1110'1 (..- 1) 
El U He!IMol\loec.wotoon (lll) 
E1 """""''•roo.ctr.n coetic.-
EI O C:h'"••.,_.hlloon 

!!i .J Qod ()NtqCorditCin 
E2l C)dtJtlo...l 
EJ MNN.:IV.U• 
eJ ........,,__ 
El ..l -

8 121 o.wu ........ 
EJ ..l '*-'•1 

IX ti iUDHJI2 jY lk$,ii1Rh 

To confinn the topography data, se lect [Geographic Data] -> [Elevation] -> [River Survey 1] in the Object 

Browser, and right click on a cross sectional line where you want to confi rm the bed topography. Then, select 

[Di play Cross Section] as below. 
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To create calculation grid, select Menu bar - > [Grid]-> [Select Algorithm to Create Grid] , and select [Create 

Grids from River survey data] in the dialog of [select grid creating algorithm] . The procedure to create cal­

culation grid is as fo llows. 

CD Setting the division points in the transverse direction : 

Each river "transverse line" is di vided into two sections. Click on a transverse line anywhere, so 

change the color and width of the selected line. Then, right click on the selected line and select [Add 

Division Points] from the right click menu. 

9 ~ OloocracllcO.W 
t!) Elrv• t.on (m} ea J ._......,, 
f!l Eleveuonoflt:Cedbed (llll 

ea """"'" E!} feud r. Mcwable Bed 
f!l Oerc~tyo!V..eUitiOn(.-1) 
1!1 Hacht of Veceli\D'l (Ill,) 
~ M.n'l~'si'OI.IIh"eueoetfiw· 

f!l O.ansc:.dostrb.ttoOn 
E:) U Chi Q e.trc Condtto0n 
E:l Gold {f.b O.Ui) 
E:) "'-"-dVet­ea ....._...,,_, 
ea cH-s ea.....,......, 

t!! :l loiNsllel 

By using the mouse, you can move 
the grid location, and also zoom in 
and zoom out the grid. 

After click on [Add Division Points] from the right click menu, [Add Divis ion Points] window will ap­

pear. In this window, input the [Division Number] and [Division Method] as follows. 

I Add Division Point :' 

Divis ion Number [51"""3 
Division Method-------------, 

r. Divide Equally 

r Equal Ratio Division (Specify Common Ratio) ~ 

'I/IA1en you want to add division points near river center or 
upper side. please specify value more than 1. 

OK Cancel Apply 

Division points (yellow circles) will appear as figure below. 

• Division umber (example) ---- 5 
• Division Method----- Divide Equally 

Then, click on the other section of the transverse line and make division points in the same way. 

~~~~~~~~~~~-~-~~~~~~ dm~ 
'"""' Ftle i1!c1or1 Geocri!Qhe 04Ui ()od ~ed VtUe$ ~biLlion CondnO'I Smulot.on C.b.ILatiOtl Ruull v- Optcn HelP - ~ X t 

tt'\ i\ ... ~ r;- '\ Xv r.. • ... t e.. a • •• : : .,. . ~ ~ ~ ~ ~ r-

e ~ Geocraphc o.u 
e e:~ Elrv•t10nCnU eaJ ._.....,, 

E!l Elevatoonolhudbed(llll 

ea """"'" E!l Feud or Movable Sed 
E1 0..1()'ol\lecetetl0n(r0 
~ Heldtt ol Vecetat~r~ (1!1) 
E:J Mrnrc's ~ eoetfcr·· 
E1 Ckans.:md.rlfbutm 

~ u (kd Creatr~~ CondrtO'l 
E:l Ckod (No O.ta] 
E!J Measu-edVtUn 
WI R.oor! ...... ml......,,.. 
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Set same clivision number for the other 
section: 
• Division Number (exan1ple) ---- 5 
• Division Method----- Divide Equally 

• 

• 

• 



• 

• 

• 

Division points are displayed as follows . 

I;* E!l Geocr~ic:O..tll 
9 E'J [le\letiorl(m) 

11JJ"""'""'""' E'J Elt:vatiDnof!Dtlldbed(lll) 

l1l """"'" l1l 
l1l 
l1l 
l1l 
E?J Ctons.G:e dmribuhln 

I!] 0 Ch:l Creatrc Condrt10n 

E'J (h:I INoD4te] 
f!1 ~edVak.oe$ 

~ e.::t.crc..rd lmacu 
11J Ll-
E'J Ols-t.nceMNsuet 

El) ~ ~el 
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~ Setting the division points in the longitudinal direction: 

The nwnber of division points in the 
transverse direction is 11 (i.e., 10 trans­
verse sections). 

4 

On the menu bar, select [Grid]- [Grid Creating Condition]- [Add Division Points Regionally]. Then, 

[Add Divi ion Points Regionally] window will appear. In the window, make th e following settings . 

+ e el Gllocra(l'nc: Data 
9 ~ Ele'llauon (m) 

11J D """'""'""' 
f!) Ele'Vat.onoflixedbt 
f!) Cbsucle Reset to Delault 
E?J FIXedorMorvableEk 
eJ Dentey of Vecetat.:: 
1!1 HellhtofVecetllhcr 
E:l Mamrc's r~ 
E:J Ct11nsrzedGtrb.Ac•~ 

E?J L) Ch:l Creatn& Cond•tiOI'I 
0 G-el [t.b Data] ---r--..--...,....--' 
PI ~edVales 

I Add Division Points Regionally .. 

Start Travers o! line 122. 148 ::J 
End Traversa l line 11 3.8 ::J 
r. Specify division number for each sections w--:B 
r Specify target distance divis ion po ints ~ m 

OK Cancel 
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The ri ver section is divided by trans­
verse lines into 5 longitudinal reaches. 
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Division points are displayed as follows. 

Q) Create grid: 

On the menu bar, select [Grid] - [Create Grid], then [Grid Creation] window will appear as below. 

Click on [OK] here. 

# Grid Creation .1.J~ 

Start Traversal Line: iji fJ!f.i!Jiit!i· l :iiiiiiiiiiiiiiii~iJ~ 

End Traversal Line: l1 3.B iJ 
OK Cance l I 

The elevations of cross-sectional riv­
er survey data are converted into an 
elevation for each grid point. 

When division points and grids for calculation are displayed as follows , the creation of grids for calcula­

tion is completed. Check [Node attributes] -> [Elevation] in Object Browser, so you can confinn the ele­

vation contour map of the calculation grid. 
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2. Background Image File: 

To import background image file, select [Image]- [Background image] on the menu bar and open [ori .jpg] 

fi le. Background image wi ll be imported as below. 

--"'" 21 t_...,..w 
el ..l~ 1 

el ..l ~ .. .. .... , ... l(.) 
i?J .,J OMw.~ E!l -l '-·---- ... 
ii!l ~- ........... ~.- !) 
I! ~ .. ..,__,-> 
21 "'"-., ....,_..-c­
E!I I)_ . ........... 

E!l ,J 0>4o-trcc...t... 
i!J Go• Olio lhnM 

ii!l .l G-<1 ..... 1 •0 ._ __ 

·21 c....-­a ........ .. ~ 
- B ..u_...._ 

e •. ,. .. ~ .... ,. __ 
li!I .J "'--' 

... 

6 

Moving, zooming and rotating manipulations are possible using the mouse (see the fo ll owing hint) to 

match the location between calculation grid and back ground image file. 
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Hint for mouse manipulations. 
r M ... l 

Pan 

Zoom 

Rotate 

AJt+ Scaling 
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3. Setting the calculation conditions 

Set Manning Manning's roughness coefficient and calculation conditions. 

CD Manning's roughness coefficient: 

Right click on [Geographical Data] -> [Manning's roughness coefficient] in the Obj ect Browser and 

select add [Polygon]. Make a polygon where you want to set Manning's Roughness coefficient by your 

PC mouse. 

- · "" "" .'•b.'" .... .... ._. ····:: .- . ~ . ... !. ~t~ 
". I( • .. ·- ~ 

Ot,tae.-
-li!I -~Dmi 

21
: ~ 

1 
~ Ed1t Mann-no's roughness 

21 DevMlon ol Ax··· . ~ 
e f"ll&Cdor Mcrvilb· 
B Density fA Yeg 
e Helghlot~-
e HaJM~ng's rouo 

1111 -l Pototooont 
1!1 • Gn~t~Sal'8di:Str 

rJ Gridoeamgco. 
·Z • Grid(4Jixl7• 

!I · ~VM.Ies 
!!l · ~lnages 

o : on.pg ....... 
-iS · D~stanoe~ ........... 

In the window, input Manning's roughness coefficient. 

' Edit Manning's roughness coefficient 

Input the new value of Manning's roughness coeff icient at the se lected gr id cells . 

Manning's roughness coefficient : I 0.03 

OK Cancel 
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Thi s example selects the entire area 
of the computational grid. 

• Manning's roughness coeffici ent 
0.03 

The va lue has to be set greater than 
zero. 

• 

• 

• 
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® Calculation conditions: 

Select [Calculation Conditions] -[Setting] on the menu bar, then set various conditions as fo llowings 

Solver Type: 

J Cala.buon Condition 

Groups 

Solver Type 
Bouldary Condi.~ 
Time 
lnual Water 5~ ... 
Bed matenal 
Wgetanon 
.. Conflue-nce 
... Non-tnform _ 

•Bank~on 

-+Secondary flow 
•Others 
+Hot Start 
-+Output vanables 

Sellct tol\4!r tv;ll 

Bed deformation 

Anite cflffarantlal method of arMlet ion tam. 

+Corlluance 

+Bed material tvP! 

+Sedlrr.nt tranap:ut type 

-+Bedbad tra~~rt formula for uniform Adlment 

+Vector of tedbad transrort 

.,.Formula of Up.olilld nux of susoonded bad from rM!r tsd 

+Bankeroskln 

..SbPB oollila;e mod&l 

+T urbuBnt rrodal 

• t-bw ttl set elevat:i:m of fbced t:ed l •lfl/t 

Boundary Condition: 

I ColcuiMJOn CondJtJOn 

Slcpev•U:at~tream 

\leloc lt)' atii)CtrNm 

•Siooe ..,,u, ot tr ibut"Y thwnll 

Tinoe ...,rt ol diSCh¥cefwater Sl.r1ce hie 

Time r•a ot dccfwu , • t ~•m and """ter M i tt clc:loonn"Mm 

<()hence tne ~rote of ud•mem from thE ~IHNIItl bcu'dary 

•The ratCI of CI.ClOhed s:ed•ment tr..,;portiO tn ~dbrOJno wdo~ lr¥tq~C~JI 00 

Is-"' 

ictP rrett-od 

jUniform 

I&' "" 
IA.f:noa al'ld MtCN..., fom J• 

tanabe rorrnuta 

IItakura <'~rd hi fo!'l'nlJta 

lor•'*' 
11'«3 

l:ero e(l.Qllon modf 

.!J..~J 

j~ormf.,. 3 
jC.Iculatedfrom ciiOCI'l!Phledolt. iJ 
~ 
~ 
~ 

~ 
~ 
~ 
r---

11 0 T1me 

:2 3600 

3 25000 

DlscN~ml/s) water level(mi 500 

300 0 

~ 
06 

04 

02 ~ 

~ 
0 r 

sao 0 
450 

300 0 

~ 
E 

l •oo 

/ ~ 
,.. 

~2 ~ 

-0 4 

-06 

~ 
0 

350 

5000 10.000 15 000 20 000 2S 000 
Time 
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3 
3 
3 
3 
::J 
3 
::J 
3 
3 
::J 
3 

• Select solver type---- Standard 
• Bed defonnation---- Enabled 
• Finite difference method of ad­

vection tenns----- CIP method 

• Periodic boundary condi tion 
---- Disabled 

• 
• 

• 
• 

Water surface at downstream 
---- Uni fom1 fl ow 

Velocity at upstream 
---- Unifom1 fl ow 

Time--- Second 

Click on [Edit] to set di scharge 

Input the discharge 

• • 
Time---- 0 sec, 3600 sec, 18000 sec 
Di scharge---- 300, 500, 300 
(m3/s) 

Note: no need to input the water level in 
this di alog, because thi s case uses [Uni­
foml flow] for the boundary condi tion at 
downstream end . 



Time: 

Bed material: 

Out;..tlh.-entcrv41(a:oc:) 

CabJietGI tii!IC $tal (uc;:) 

Sl¥ttnn~ ofCU~PJ~(sec:) 

St.tTi""ofbeddefcr .... IO'I(~ 
lNec41Hel&l'(lbedm:lormMIOrl) 

II 

ps 

" 

u 
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• Output time interval (sec)----60 
• Calculation time step (sec)---- 0.2 
• Start time of output (sec)---- 0 

Boundary Conditlon 

nme 

Diameter of 111riorm bed 1Mttlraa1 (mrn) 12 • Diameter of unifonn bed material 
(mm) ---- 1.2 mm 

Initial water SUrfiM:::e 

Bedtnll~l --
Description of the uniform bed material setting 

Item Description 

Diameter ofunifonn bed material (mm) 

Remarks 

Enter a bed material grain size to be used 

for bed deformation calculation. 

Many other conditions can be set; however, they do not need to be set for this simulation . 

After making the settings above, cl ick on [Save and Close] to close the window. 

Q) Export the setting calculation conditions as a text format: 

If you use iRIC version after iRIC 2.3.9 6024, you can export your setting calculation condi tions as a 

text fonn at. In toolbar, select [File] -> [Exp01t] -> [Calculation conditions], and save your file as 

"**yml" extension as below. 

" File Import Geographic Data Grid Measured values calculation Condition Simulation calculation Re 

New Project... Ctr1+N • a !5i it Sa lb 6 

1 
Open... Ctrf+O 

: W Save Ctr1+S 

Save As File( · .ipro) ... 

Save As ProjecL.. 

:r Property ... 

a Save Snapshot ... 

~ Continuous Snapshot I Mov•e I Google Earth Export .• 

. • Import 

Recent Projects 

Geographic Data 

Grid ... 

Show iRIC Start Page... Sotver Console Log ... 

_Ex=.:.:c..''----,---------- calculation Result... 
Partie~ ... 

Visualization/Graph Settings ... 
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test.yml 
~============== 

YAML file (* .yml) 

CGNS fi le 

• 

• 

• 
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Change the file extension from "yml" to "txt", and then open the "** .txt" file. Calculation conditions 

can be confirmed as below. In addition, if you change the file extension from "txt" to "yml" again, the 

setting calculation conditions can be imported into ays2DH in iRIC . 

.. 
~·• •• •'• •~ •l.L! !< L I .._, L..L...< Jr w •IL..l ' ' 

1 h sru: 1 " real a or eddy viscosity coefficient (k/Su>h x a + b) • 
2 aTh: 0.8 "real Relaxation coefficient for water surface calrulation • 
3 b sru : 0 "real b for eddy viscosity coefficient (kl6u'h x a+ b) • 
4 bfi_sla>e: 0.001 " real Slape value at downs! rea~ • 
5 bheisht: 0.03 " real Heisht of bark (m) l 

~ ~T~~0-~57 ~ ~::~ ~i:e~f~jc:W,"ilo~ ~:.Oteroal (nm) 
8 discharae_t: discharae t.csv "[IU"dion] +O•scharae lime series of tributary charnel • 
9 discharae waterlevel: <lischarae_waterlevel.csv nf\l"ld •on] Time series of discharae at t.<>Sir· 

10 dt: 1 "[rea l] Calrulation time stec (sec) • 
11 e_d : 0.01 "lreaiJ Thickness of de<>osited layer(m) l 
12 e thick: 0.1 " real Thickness of movable bed layer(m) 1 
13 e<li ion: 0 " intner] Select solver type! 
14 h down: 0 " real Constant value (m) 1 

15 h=slape: 0.001 " real Initial water-surface sla>e of main charnel • 

~~ ~=~l::J ~ : ~l ~ ~:ljl~::::: :::~=~~=~ ~~= ~~ =~~i~~· 
18 h_sla>e_t: 0.001 " real +In itial water-surface slOPe of tributary charnel • 
19 i_erosion_end: 5 " inteaer] Bark erosion end section N..llber from downstream end• 
20 i_erosion_start: 5 " inte&er] Bark erosion start in& section N..llber from t.<>Siream end • 
ll !-~!~~-2 -·, ~~i~!~~ tn~~ia~ ~!~r_.~1~::~ , -'-- _ ~-- · z ' · 

4. Making a simulation 

Before stating the simulation, select [File] - [Select As File(* .ipro)] and save your project. 

For running a simulation, select [Simulation] -> [Run] in menu bar or select ~ on menu tool bar. Then, 

Solver console window will appear and calculation starts. If you want to visualize your calculation results 

before the calculation finish, Select [calculation result] - [Reload] on the menu bar . 
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5. Visualization of calculation results 

elect [calculation result] -> [Open new 2D post-processing window] on the menu bar, or click on the but­

ton [2D], named [Open 2D post-processing window]. 

Select [Nays2DHGrids]- [iRICZone] - [ ca lar]- [Elevation change (m)] in the Object Browser. 

fll I~ Draw Mtii'M.Ad 01rta Slro"UUItlon Anrledon ~ ,_.. ..,_ OpO:n Hlto 

'-1 & ~ lt"' l"ll r! r;' 'X Zy ~ •• t • 4. .... : : • •. -
0 080 g . J,. ,. ... . 

rl~ Dlpetl(rn) 
~ S.Vouon(m} 

f].J -

' -­I:IJ ~•t) 
f].J _....._ 
fl..l -

.J ­

..l ­

..l~ 

..l~ 

..l """""""' 

..)~ ...... 1) 

.) -M -J \lllocxy(.,..l ) ·j 

14! 

To fix the scale bar, select [Nays2DHGrids] - [iRICZone] - [Scalar] in the Object Browser and right click 

on [Contour] to select [Prope1iy]. In the [Property window] as shown in figure below, set the value range as 

fo llowings. 

~ So> lor Setting 

Physoc.ol VoU.. I Elevot<OnChonce(m) 

V~Ue r¥Ce 

['] Automotoc: 

Max: 

-5 

Division Number: 15 

Color mop 

0 

~tom Settnc 

o;.p~oys.un. 

- I 

0 Fill._areo 

~ Fill lower area 

~ Color Frilce Cont01.r Fictle lsolnes 

EJ Transparent 
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Reaion Settim~ 

lcolor Bar Settinsd 

OK I I Cancel 

• Value Range 
------Remove the check of Automatic 

Max: 3 
Min: -5 

• Transparent 
------ Remove the check 

• 

• 

• 
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• 
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The contour map is easier to see after it is restarted . 

Elevat ionChange(m) 
-2.71 -1.57 -0.429 0.714 1.86 3.00 

22.1 43 

Visualizing the fl ow velocity: 

In the Object Browser, select [Nays2DHGrids] - [iRICZone] - [Arrow]- [Velocity]. 

The generated vector map is difficul t to understand in defaul t. To fix the scale of vector arrow, right click 

on [Arrow] and select [Property]. 

fl'hy:5:~1 vt~U&: !vekx:Jty(/Tl$"'" I) ... j 

W..th 

[] Auto 

Stond,rd vakJe: 5.000000 

lenrth on screen:: 20 

Mr~imum vaUe to ciaw: 0.00500000 

5all1)1rc 

o All vertK:M 

Sa~tncrate. 

1-dreetion 1 • J-drect~~~n 1 

Colo< 

o Cus-tom color -

By ~lar vab:l Oepth(m) 
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[mls] 

{po:eO 

!mlsl 

'il !l 

JRe2ion Settinal 

Contour map: Depth (m) 

Vector map : Velocity (ms-1 ) 

[Property] Window: 

• Length 
------ Remove the check of Automatic 

Length on screen: 20 



The contour map is easier to see after it is restarted. 

lD Graph Window: 

Either of the fo llowing actions opens a new graph window. 

Menu bar: [Calculation Results] (R) .,.. [Open ew Graph Window] 

Operation Toolbar: ~ 

Nays2DH Tutor ial 

X"- rr;;;;o:) 

0.1""'"""""""' I &1emol I 
FbintO.ta 

~ 
'-r ... _a,...""""""',---' o._ .. ______ « Rem:~w J 

OPpt 'rn 
E~" ( 
WaterSurfaceElevdtJOn(m) 
Elev~tiooChangt.>( m) 
Vorti(:lty{S·l) 
"1 P..ameter{mm) 
Sl >"ldedSed1mentConcentnttOn 
v N ty (magnitude) 

~_§)_~~ 

, 500 ~.r~~----;::---------,- - Drsdler ce(mh-1) 

i~; ~ 
0 5.000 10.000 15.000 20.000 25.000 

Time 

:}ontrollel" 

[Deu.Stvc. !I AxiiSeur.c j [Dre..Settr"C I !"'-kerSeurc l ~ 

I .._.... ll csve-• 1 
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Visualize contour and vector map with discharge graph . 

~ Post-proce~W9(20) 10 

" ..) Oepct(m) 
rl J ....,tlon(m) 

r:JJ W.~ 
l..l£Jevatlor'Oiang 

r:JJ """"'Y(•·l) 
!] Ll --"""'( 
l:lJ - .• 
!:IJ ''''>do'"'"'bo< 
J­

CJ~ 
CJ~I 
CJ ,_,.. 
CJ -""·'l 
!:IJ II<dloodi'\D<{m -Ll \o'elodty{ms-1} 
I:]L) II<dloodi'\D<{m -­..)~ms-1) 

l:lJ -m ..,.... 
J 'ol!foaty{ms-1} 

l:lJ -m 

1 D Graph Window: 

•v 

14 

, Gnlph W'n:tow I 

Ell~ 
0 5.000 10.000 15.000 20f.t» 25.000 

Time 

l o.t.~ )) Ax•Sonrc )] Dt-- Secnrc )) M.wt.erSenrc)~ 

I ......., 11='-' l 

Elevation change in each cross section can be confim1ed with lD Graph window. Open 1 D Graph win­

dow (JL. ) and select X axis and Y axis as below. Using copy function, elevation can be compared . 

.._ rr----3 
o.~aAtion-.. 1 .....,.., 

lOIIIQ~O.~ 

Oepth(m) 
WaterSurfac:eEievattOO(m) 
ElevatiooOlange(m) 
Vorticity(S· l) 
MeanDiameter(mm) 
SuspencSedSedimentConcentratoo 
Veloaty (magrntude) 

?.. File Import Draw Simulation Animation calculation Result View Option Help 
~ ~ ., ~"'~~ t:."'XZ....~ .... :: • : a ._ I? 

0 090 • :::::=)t=3000s 

220 

200 

~100 
0 

·~ 
~ 160 
w 

140 

Contn>l•" 

2.CXXJ 4.CXXJ 

- 8<MOtio<(m) 

- Elevatio<(m)(t=:ll. J= 1) 

S.CXXJ S.CXXJ 10.CXXl 
Distance 

(~naSa.roo l A>dsSettmal O..wSettmal ........ s.,.J ~I 
s"'"""'' I csv E=n I 

Export Animation: Select [F ile] -> [Continuous Snapshot I Movie I Google Earth Export .. .. ]. 

End Tutoria l 3. 
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Nays2D Flood basic operating procedures 

The following are the basic procedures for operating Nays2D Flood with iRIC: 

Launching Nays2D Flood 
Prepare to use Nays2D Flood on iRIC. 

Creating the calculation grids 
Create a grid for calculation using Digital Elevation Model (DEM) data or the 
like. 

Setting the calculation conditions 
Set simulation discharge, boundary conditions, roughness and other items. 

Making simulations 
Run Nays2D Flood for the simulation. 

Visualizing the calculation results 
Visualize the simulation results, such as flow velocity, water depth and 
riverbed elevation, by means of a contour map/vector map to see whether the 
simulation has successfully run . 

Simulation conditions of Nays2D Flood 

This manual teaches how ays2D Flood is used to simulate river flow and riverbed 

deformation. 

Hence, there are some omissions in the explanations of the physical and numerical 

aspects of the simulation conditions that are to be set. ays2D Flood has functions 

(setting conditions) additional to those explained by this manual. For details, please refer 

to the ays2D Flood Solver Manual. 

2 
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Chapter 1 
An example of flood calculation 

for an actual river section 

Objectives 
Simulate the flow regime (water depth and flow velocity) by using ays2D Flood for an 
actual river section with a flood discharge, and see whether the simulation is 
successfully run. 

Outline 
1 Creating the calculation grid 

Using elevation data of an actual river section, create a calculation grid: 31 divisions in 
the transverse direction, and 64 divisions in the longitudinal direction. 

2 Setting the calculation conditions 

Set flood discharge for unsteady flow . Set various other conditions necessary for 
simulation. 

3 Making a simulation 

4 Visualizing the calculation results 

Here, we introduce how to display a water depth contour map and a flow velocity vector 
map. 

3 
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Creating the calculation grid 

I 
' 

1. Importing cross-sectional river survey data 

d) Importing geographic data 

On the menu bar, select [Import] - [Geographic Data] - [Elevation]. 

Open [chapterl]-[l_inputdata] , select [acehcity.tpo] and click on [Open] . 

._.....,.,..._ 
Goc9-Mep~ •mav-
\ ~ to'l Gt19' Stttr9L 

~ u Q'ldO'MdngCordtklrl 
~ lcu'lcl«yCCnltlcn~ 
~ \,.) (;rid (No Dllltlll) 
!11--!11 ._,....._ 
!11 ..l -

"" B Olltllra....._ 
B u -.. 

-­~CIIrlltiln. .. 

NMI frDCtJon tNt buldlng5 ocn.lp)'(max-0.95}-

~ On the dialog [Filtering Setting] , input [1] for [Filter] value and select [OK]. 

I 

Set a larger number for filter value and filter the dataset if the operation is slow because 
of the number of data. 

Filtering Setting 

If you "'ant to f ilter the dataset specify value more than 1. 

F iller:~ 

OK Cancel 

file ltnp:wt ~om~ ~va~~.oe~ ~Qincll:lon sm.Ntlon ~~ ~ 
!.l a Y~~"'~" ~ u ~ ~ ~ • • t • ~~ • • ••:: • • .· a h. ! 

... + )( ' 'r. ·~~ ·.:r· /. /... 
. · Pre~ocessmg W 1ndow ---- e u ~0oa1 

- B Elevaoon 
e .l PWGI 

!11 """"' !11-
B I.:l ~C\CII'dlcXIn 
B A.rMhd:lantt.attdl 

B ..J IOI'Ider.t~ngCOncltion 
B .,;J IIuiGirrCondltlonSialn'IJ 
B Gnd {Nor>eta) 
!11--
B ~lft'I09e$ 
!11 ..l -

-B l:llll:lllaHIII!Snl 
!11 J -.J 
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If the [Pre 
Processing] window 
shows the shape of 
the river section that 
you are simulating, 
the data have been 
successfully imported. 



In the object browser, right click the "Elevation" of Geographic Data folder and click 
"Color Setting" 

Elevation color setting window will open. Uncheck the "Automatic" and set the value 
range; 40 for Maximum and ·5 for Minimum. 
Then click Custom Setting in Colormap section. Select "Three Colors" for the legend 
type, choose white for the intermediate color and set the value as 10. Click OK. 

Elevation Color Set... ? 

VaUe ranee 

r Automoti: 

Max: 40 

Mir< -5 

.- Colormap 

OK ~I 

1 ~ ~ Custom Color Map 

T)'OO' ln-ree Colen :::J 
r- Two Cokwc/ lliee Colcrc -· 

Maximum v~Ue -
MediJm Value r--- Value 110 

Minimum VaUe -
------

1: -=: ~ ~ I 
I OK I Cancel I 

Value range: 
---- uncheck: Automatic 

---- Max.: 40 
----Min: - 5 

Colormap: Custom 
Setting ---- ----­

Type: Three Colors 

Medium Value: 
White (Recommended) 

Value: 10 

In the object browser, right click the "Points1" of Elevation folder and click "Property". 

E?J Obstade Edt Name. .. 

~ .;) =...- . Export. •• 

~~ Gr1d~~~~ + "" 
E?l Boundery Conditkln Set .. f.A 

~ Gr1d [No O.ta) 
l!l Measured values 
~ Background Images 
~ Ll Axes 

- E?l Distance MeS~.n:S 
~ .J Measuru 

•v 

5 
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In th e Display Setting popup window, set 1 for the point size . 

•' Display Setting ? .. 

Display Method 

r. Poilts 

r Wreframe 

l r Surface 

I Point Size: fi:B I Point size: 1 

I Transparent 
I II I I IIIII I 

[03 
I Hide Break Liles 

I OK I Cancel I 

(2) Importing a background image 

);:> On the menu bar, select [Import]- [Background Image] and import [chapter1]-[1 _ inputdata] 

and select [bg_aceh .jpg] . 

Import Geogrllphic Oata Grid 

Geogrl!phic Oatll 

Hydrl!ulic Oatll 

Grid ... 

calculation Condition ... 

calculation Result ..• 

~1~sured values ... 

Bilckgmund Image ... 

Google Map Background Image ... 

Visuahzabon/Gn!ph Settings ... 

0 Areal frllction that bulldi··· 
0 Grid Creating Condition 
0 Boundary Condition Setting 
0 .._::, Grid [No Oatll) 
0 Measured values 
0 Background I mages 
0 D Axes 
0 Distance Measures 

0 D Measure! 
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Background image: 

When creating grids for 
calculation, importing 
background images such 
as maps and aerial 
photos makes it possible 
to create grids th a t 
incorporate riverbanks 
and land use. Obst acle 
cells and roughness cells 
mentioned below can be 
set in reference to th e 
background image . 



~ Using the [Move] , [Rotate] and [Zoom] functions, match the background image with the 

elevation data. 

Hint: 
It is convenient to 
find the geographic 
features and mark 
on the background 
image when you 
match the 
background image 
with elevation data. 
In this case, the 
flame line is drawn 
and you can use this 
flame line to match . 

~ Referring to the hint above, match the background image with the evaluation data. 

\' ·~ 'C.' ;; /:. 

• ' Pre-processing Window 

~ Obstade 
~ Bomber 
~ Roughness a>ndltlon 
~ Areal Fr&tlon that buildi ·· 

~ .) Grid Crelltlng Condition 
~ Boondary Condition Settlng 
~ Gr1d [No Data] 
~ Measured Vlllues 

- ~ Background Images 
~ D bg_aceh.Jpg 

~ u Axes 
- ~ Dlstzlnce Measures 

~ D Measure.! 

7 
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I I 2. Selecting an algorithm for creating a grid 

I 

On the menu bar, select [Grid] - [Select algorithm to create grid] and select [Create 

grid from polygonal line and width] from the list below the [Select Grid Creating 

Algorithm] window, and click on [OK] . Instruction popup will appear. Nays2D Flood 

primarily creates a grid from polygonal lines and grid widths. 

llJ Select Grid a-eating Algorithm , ...... 
Akorithm: Oescr~t ion: 

Co .. .. . .. .. F" nl please defne poiy&onal lne. by .........-clock inc The 
create grid from from rtver survey dot21 polycCJI"'o!!l lils Cc used as the center lhe of the crid Then. you 
create grid by dividing rec121ngulor region defi1e the width. d1Vis: ion nu!T'ber of crid .-- I drection ~ J 

create grid by dM ding rec121ngulor region (~.on\ di-ection. 

create compound chonll<!l gnd 
C.rtesfon Grid for NoysE<Idy x64 
Mul~functlon Grid Genorotor 
Simple Grid Generator 

•I I ~ 

I OK I~ 

3. Creating a grid I 
)> Click on the upstream and downstream points through which the grid centerline passes, 

and press the "Enter" key. 

- ~ 

~ '''"'" ~ ~ """""" 
~ ­
~ --E!l NtiilfnKt:kwltNatbuldl 

I!] u Gl1dCrtotingCOndltlon 
~ _Cond<tion......, 
I!] Gt1d[NO ~ta] 

B Meandvr.!ues 
- I!] Bec:lcqrou'ld Images ~ u ..._ _ _ , 
~ ._) -

::; I!] [)lstarQMbSIJf'el 
~ u ........, 

2. Downstream 
0 

8 

Setting the grid 
centerline: 

Set the grid 
centerline from the 
upstream end, 
where flood flow 
enters, to the 
downstream end, 
where the flood flow 
exits. To finish , 
double-click on the 
end of the centerline, 
or hit the "Enter" 
key. 
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)> In the [Grid Creation] window, make the following settings and click on [OK) . 

The resulting mesh size would be dr =100m (flow direction) and dJ =100m (cross 
sectional direction) 
)> Click on (Yes] in the [Confirmation] window. 

Grid Creation 

n, 

nr. 120 j3 d!: 11 04.636 m 

nJ: 120 j3 dJ: 11 00 m 

W: 12000.01l0 j3 m 

OK Cancel 

Calculation grid will be created. 

9 
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Apply 

• Number of divisions in 
the longitudinal 
direction: 120 

• Number of divisions in 
the transverse direction: 
120 

• Grid width in the 
transverse direction: 
12000 m 

Adjusting the 
calculation grid: 

It is possible to 
move, add or remove 
centerlines under 
[Grid Creating 
Conditions] even 
after the grid is 
created. 

• 

• 

• 



• 

• 

• 

I 
Setting the calculation conditions 

4. Open "Calculation Conditions" I 
On the menu bar, select [Calculation Conditions] - [Setting]. The [Calculation 
Conditions] window will open. 

Setting the inflow boundary conditions : click on [Inflow/ Outflow Boundary 

Conditions] from the [Group] list to make the following settings: 

1] calaJiation Condition ?-.:JI 

Groups J !Second :::J Inftow/Outflow Boundery Conditions lime 111it of discharce/..uster sui-'Ce file 

Initio! W.ter Surface 
Bo..rod.ry Cond~ions for j= I ~ Tlme 

Others Bo..rod.ry Conditiom ro. j=nj JOutfiow :::J 
~ter st.riace at down$tream JFree outflow :::J 
Conotant vai.Je (m) I 0 

Stap at dcMn$1ream time ser~ ~ 
Rainfall Jwithout :::J 
Rainfall time Rra<mmAV ~ 

~ lliave ..-.d Close I ~ 

* Inflow conditions are decided at [6. Setting the inflow river 
conditions] 
*Use constant value or read from file when the stage at 
downstream is effected by sea level or overflow level at 
outflow. 

1: 

• Time unit of 
discharge/water 
surface elevation 
files: second 
• Boundary 
Conditions for j=l: 
Inflow 

• Boundary Condition 
for j=nj: Outflow 

• Water surface at 
downstream: Free 
Outflow 

Setting the initial water surface profile: click on [Initial Water Surface Elevation] 

from the [Group] list to make the following settings: 

u] 

Groups 
Inflow/OUtflow Boundory Conditions .. . - .. 
nme 
Others 

~ 

CalaJiation Condition ? .. 

I 
hitialwater sui Gee 'Depth- 0 :::J 
h it ial water Mace ;:lope of mei'l charnel I 0001 

Jliave..-.dC!osel ~ 

10 

• "Initial water 
surface": Depth= 0 

Note: When the 
water surface 
elevation of the 
downstream end 
may be affected by 
the sea level or the 
downstream flood 
level, use a constant 
value (a line). 
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Setting the time: click on [Time] from the [Group] list to make the following settings: 

Groops 
Inflow/OUtflow Boundory Condltloos 

rf&e lnlti~ l Wllter SU 
Time 
others 

~ 

Output time Flterval (sec) 

Cak:uleton time step($«:) 

Start time of output (sec) 

Start time of borrber (sec) 

? 

600 

~ ~and Ciose l ~ 

• Output time interval 
(sec): 600 

• Calculation time 
step (sec): 5 

• Start time of output 
(sec): 0 

• Start time of 
bomber (sec): 
BLANK 

Other setting s: Click on [Other] from the [Group] list to make the following settings: 

li] 

Groups 
!nf\ow/{)Utftow lloundo<y 
Initial water sortaoe 
Time 

~ 

Aforoddy viiiiCOi ity coeffc.~ Ck/kl-h x A• B) 

8 b eddy viscosityc:oeffleWM (k/kfo!h x A • 8) 

' 
jcJP_..., 3 

OJ 

Ul 

Nul!'ber of ttnads fa- pr•llll comQUt•ID'I (Only ~t~Uitt cae PC) I ±J 
hn:f.lt.cnofbutkfr1u ~ 

Mod&\p.wamat« b lbotructanc:ebybuildM I OJIS 

Hoo.toc.at:ulate u mllll. IPIII_x=u•..r- I'""'CJ1(1-un~.v) 3 

• Finite difference 
method of advection 
terms: CIP method 

• Maximum number of 
iterations of water 
su rface calculation: 10 

• Relaxation 
coefficient for water 
surface calculation: 
0.8 

___________________ ...,. • Minimum 
water 

depth: 0.01 

Many other co nditions can be set; however, they do not need to be set for this simulation. 

r parameters are described in Nays2D Flood Solver Manual. Details of othe 

Mter making t he settings above, click on [Save and Close] to close the window. 

s. Savin g the project I 
Before procee 

"Save AE File ( 

ding, saving the project is important. In the menu bar, click File and select 

*.ipro)" This option enables you to save the data for this pre-process as a 

mpressed file) . On the other hand, "Save AE Project" means saving the 

rbitrary folder. 

single file (Co 

project in an a 

11 
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I 6. Setting inflow condition 

CD Inflow river 
Set the inflow river condition at the upstream boundary. 

(2) Setting of inflow condition 

• In this river 
section, one river 
(Aceh River) flows 
across the 
calculation domain, 
as indicated by the 
white line. 

• No river comes in 
the area from j=l 
and j=nj and these 
boundary conditions 
are outflow; see the 
boundary condition 

I 

In the object browser, right-click the [Boundary Condition Setting] folder . Select [Add 

inflow], then "New Inflow" setting will be added. Selecting "New Inflow", enclose the 

sides of inflow location with a polygon. Click "Enter" and the location is confirmed. 

E E!] Geogn>phlc Dot> 
' E<l Elevo!lon 

E'J tJ Pomtsl 
!11 Obstode 
!11-E!l--E!l Areal fnKtion tMt bolkli 

E'l t.) Gr<ltno ..... a>ndltlon 
~ f!l ~ryCondltionSetting 

E'l t.) New Inflow 
- f!) Grid {121 X l21 • 14641) 

E'l :J Gr<lshope 
- 0 Node attributes 
r 0 Celottrfbutes 
-E'l -'YCooditlon 

1!1 Measured Vlllues 
.;. f!l ~Images 

E'l ..l bg_-.Jpg 
E!] t.) Axes 

..;. PI Dlstana! ~ 
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The Boundary Condition setting dialog opens. 

Boundary Condition ? 

Type: Inflow 
Name: r.I N~~~ln~flow ____________ __ 

I Setting 

I Discharge time series Edit 

Slope value at inflow 0.00 I 

Color: 

P' Transparent -~f5oj3 
I II II I II II I 

Line Width: f7:B 
rv Show name 

OK II Cancel 

Name: arbitrary name 

---- ----- Setting --------­
Discharge time series: 
Select [Edit] and input I 

import discharge data as 
the figure below 

Slope value at inflow: 
0.001 

After selected [Edit], input/import the discharge from the upstream boundary. In 
this tutorial, select [Import] discharge and select [chapterl]-[2_hydraulicdata] and 
open "Qin_Aceh.csv" 
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Time 
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Hydrograph will be 
imported 

• 

• 

• 
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7. Setting obstacle cells 

In the Object Browser, select [Geographic Data] - [Obstacle] - [Add] - [Polygon]. 

Enclose the grids of "Obstacle" locations with polygons. Set the obstacle from "Edit 

Obstacle value" popup. 

eJ u ­
eJ ..l ­

eJ .;) -
1!1 --
~ Areolfntcdont:hotbulcl 

B U Gncleretr.gccndlt5on 
e l!l Bol..ndaryCondftion~ 

E?J J New Inflow 
:? I!J Grid ( 121 X 121 - 14641) 

eJ ..J c;nj ...... 
4 0 Node attl'tltltes 
• 0 Cell ettrtbJt.e; 
f:O f!) ~Condllkln 
f!l MNandlolllluls 

= e~ .................... 
1!1 J bg_oai>.Jpg 

eJ J -
- B Oiltanal ro4Hafts 

eJ J -

Ple..se input new vak.Je in this polycon. 

Obstacle : l:•::nr:;rwi] 
OK Cancel 

a. Setting the roughness 

• Set obstacles such 
as roads, banks and 
embankments . 

ote: Unless the 
calculation grid cells 
are small enough to 
depict roads , banks 
and embankments 
as a part of the 
topography, set 
roads, banks and 
embankments as 
obstacles. 

In the Object Browser, select [Roughness condition] - [Add] - [Polygon]. Enclose the all 

grids with a polygon. Input Manning's roughness coefficient. 

- E; Geogntpltlc """' 
- I!) Elevation 

!!J u PDi<>tsl 
- !!I Obstlldo 

!!I u Polygon2 
!!i ..l - 1 

!!I Bomber 
" !!I Roughness­

!!I .) ""'-" 
f!l ~ Areal fBction ttlat bulkl 

E; Ll Gr1d creollng Condition 
- !!1 Bounda<yc.nditlonSealng 

E:l U New tnnow 
.:;;, E:) Grid (121 X 121 • 14641) 

!!) U Gt1d shape 
· 0 Node attributes 
• 0 cell att11butes 
- !!I Bouncl.vy Cond-

E'] Measured Values 
- !!) Boclcgroond lmoges 

E; u bg_ecelt.Jpg 
l!l U A.x:K 

- E?J Dibnc:eMHsures 
l!l Ll M~suru 

14 

• Roughness 
coefficient: 0.03 

ote: Set Manning's 
roughness coefficient 
by taking 
comprehensive 
consideration of 
calculation model, 
land use and past 
flooding data . 
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On the menu bar, select [Grid] - [Attributes Mapping] - [Execute]. Attribute Mapping 

confirmation will appear and click OK Information popup will appear and check 

[Obstacle] and [Roughness condition] , and then click OK. 

oo.t.c~ -~condrtiOI'I 
P<ool ~ ... .,., '"'' t>uildru oco..<""""'ull 

9cudary CondltiOI'I Settnc 

p "'" nliow 

In the Object Browser, uncheck [Geographic Data] - [Obstacle] and [Roughness 

condition]. In the Object Browser, check [Grid] - [Cell attributes] - [Obstacle] 

9. Setting for the box culvert 

Confirm the cells 
which was given 
obstacle attributes 

In the Object Browser, select [Boundary condition setting] - [Add Box Culvert] to set 

a Box culvert cell (inflow side). Enclose the grids for box culvert location (inflow side) 

with polygons. 

AcehRoodTest.ipro • 1RIC 2.3.7.5503 [Nays: 

15 

Box culvert can be 
specified in one cell 
units. 

Set an "inflow side" 
of a Box culvert 
using polygon. 
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When the location is confirmed, the [Boundary Condition] setting dialog opens. Set 

the conditions of box culvert from in the dialog and click OK. 

Boundary Condition ? 

Type: BoxCulvert 

Name: I New BoxCu !vert INI 

Settng-------------------------, 

A couple of code number 

Inside/Outside 

Width(m) 

Height(m) 

Elevation(m) 

Multiply 

Extended for mu Ia 

Coefficient of submerged f low I 

i ±J 
I Inside 

0.75 

Coefficient of subsurface flow I 0 51 

Coefficient of free flow 0.79 

Color: 

P" Transparent --)-- [50±J 
I lilt II Il l I • 

P Show name 

OK Cancel 

Box culvert 

' ' 

D 
---

)--·-· 
,.. 

16 
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Name: 
New BoxCulvert IN 

A couple of code 
number: 1 

Inside/Outside: In 

Width : 5m 

Height: 5m 

Elevation: 4m 

Multiply: 1 

Extended formula : 
No 

Coefficient of 
submerged flow: 
0.75 

Coefficient of free 
flow: 0.79 

~L (cbr.Jc) 57 

·or 



In the Object Browser, select [Boundary condition setting] - [Add Box Culvert] to set 

a Box culvert cell (outflow side). Enclose the grids for box culvert location (outflow 

side) with polygons. 

-et ~Data 
- !!1 -

!!I J ....., 
- !!I ­

O J ­
O ..l Pt~tygoret 

!!1 -
- E!l -­

O J -• 

Ao!hAoodTest.JP(O- 1RIC 2.) .7.5503 (Nays20 Flood v5.0 64 bit) 

~ Arulrr.c:tlcntNtbulcl 
f?.I ....) Qld~Cordl:ior! 

'- ~ Bo.lrdetyCCI"dtla\Stmng 
~ .J Nfw INlow 
~ ..) Ntw~IN 
el il New&clilcOMrt 

- !2'J Gnd (l 21xlll - 11641) 
B .l cortd~ 

. 0 Nodtllt'tl'b.ltes 
- 21 Cll atU'b.as 

E!l .:l ....... 
o ..J ­
O J -­
O ..l Arellfnlcdonthalbu 

· eJ Bcu'daryc.cndltion !!1 -­- E!l ~- ........ 
!!I J ,__ .. 

!!I J -
- 21 Dlltllrce~ 

E!J ..) ...._..._l 

Aco.cJIIcCIIIcodl.,.._ ~ 

~ ,---­
,---­
,---­
,---­

r::-3 

Set an "out flow 
side" of a Box 
culver t using 
polygon. 

When the location is confrrmed, the [Boundary Condition] setting dialog opens. Set 

the conditions of box culvert from in the dialog and click OK. 

Type: BoxCulvert 

Name: I New BoxCulvert OLJTl 

- Settinc------------~ 

A couple of code rmrber 

Inside/ Outside 

Wodth(m) 

Hejght(m) 

Elevation(m) 

Multiply 

Exteroded formula 

I 

Coefficient of submer'ed flow I 

!Outside :::J 

0 76 

Coelficient of subsurf..::e flow I 0.51 

Coelficient of free flow 0.79 

Color: 

P Transparent -~[50:B 
11 11 1 1 1 I Il l 

P Show name 

OK Cancel 
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Name: 
New Box Culvert 

Inside/Outside: OUT 

A couple of code 
number: 1 

Outside 

• 

• 



• 

• 

• 

How to calculate 

No Flow Entrance to Exit Exit to Entrance 

1 

submerged low 

On the menu bar, select [Grid] -[Attributes Mapping] - [Execute] and select New Box 

Culvert I and OUT, and then Click OK 

Geoc:raP"Mc Data 

J;f E\e'illtDI 

p Obruc" 

P"Bo"""' 

Ebrdary Condrtian Senna 

I I 1 o. Saving the project 

Before start calculation, select Save in the File menu of the menu bar . 

18 
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Making a simulation 

I 1. Start your calculation project 

On the menu bar , select [Simulation] - [Runl. 

AcohRaadTe&ipro • iRIC 2.3.7.55CIJ (Noip20 Flaod '115 0 64 bit] 
Fie Import Geogn>pNc OOIZ> Grid -....d lllllues Colallotlon C<r6tlon Slmulotlon Colculotlon lleoult 

" r. t>." "x "Y'x ••tf ~ 

Click Yes for the 
information popup. 

The [Solver Console [ ays2D Flood] (running)] window will open to start the 
simulation. 

_ Solver- Console [Nays2D Flood vS.O 64 b1t] (running) 
Nays 2d flood Sol~r Venioa 5.0.0000 Last updeted 2014/5/U 
CopynQht: fC) by Yasuyut:i Shim1-:u , Boklraido Oniv. , Japan 
Mod.1.Ued by IchirO Kimura, Toshlii Ivuaki , Sataai KawUiln , lakuya looue , Hie 
b.1h1.ro .l!ar.ati , rate:~hi ra~a 

------- --BozCulve:rt-----
BcJE.C'Ulwn:: dat.a• 2 
Rm:.- 1, l!dex• 
lluD- 2 , l.l:dex-

0 
0 
0 
0 

0 
0 
0 
0 

in.!low(i•l)li~ Inflow 
t ime q_l.nput 

0.000 100.0000 
600 . 000 100.0000 

1200.000 100.0000 

1, I • 
1, I• 

._ ..... 
o.oooo 
o.oooo 
0 . 0000 

... J • 56 •.. ,.. .. 
•• • • .. .. 
•• •• •• •• •• •• •• 65 

•• •• •• 65 

•• • • •• •• •• •• •• •• •• •• 
0.0000 out 
0.0000 out 
0.0000 OUt 
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Visualizing the calculation results 

I 
I 

2. Open the ··20 Post-Processing" window 

On the menu bar, select [Calculation Result] - [Open new 2D Post-Processing .. . ]. 

AcehRoodTest.1pro- iRIC 2.3.7.5503 (Nays20 

Open new 2D Post-Prooesslng Window 

The "Post-Processing (2D)" window will open . 

In the object browser , select "bg_aceh .jpg" in the "Background Images" folder. 

~. Post-processing (20}: 1 
Object Browser 

0 No 20 Aood vS.O 64 bit··· • 
0 Geogrophlc Dato 

0 8evatlon 
0 IRJCZone 

0 u Gr1d shape 
~ · Sclllor 

D Depth(Mox) 
0 0 Depth 
D Elevatlon 
D 0 WoterSurface8 ··· 
D 0 Velocity (mogn··· 
D 0 Ve.locity(ms-1) ··· 

" 0 Arrow 
D Velocity(ms-1) 

~ streamlines 
D 0 Velocity( ms-1) 

8 0 Portldes 
D Velocity(ms-1) 

0 Cell attributes 
0 0 Obstode (Nor··· 
0 I] Obstode (Obst··· 
D Bomber (Norm··· 
D Bomber (Bomb··· 

Measured Values 
Bll round Imo e.s 
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3. Visualizable quantities 

Descriptions in the Object Browser Description of each quantity 

• Con tour 

Depth(Max) 
The max. water depth by the t ime of 
visualization (m). 

Depth 
The water depth at the time of 
visualization (m) 

Elevation The ground heigh t of calculation grid (m) 

WaterSurfaceElevation 
The water surface elevation at the time of 
visualization (m) 

Velocity (magnitude Max) 
The max. flow velocity by the time of 
visualization (m/s) 

Velocity (magnitude) 
Flow velocity at t he time of visualization 
(m/s) 

• Vector 

Velocity 
Vector of flow velocity (m/s) at the time of 
visualization 

• Streamline 
Velocity Displays a streamline. 

• Particles 
Velocity Displays particles. 

• Cell attributes 
Nor mal cell (a normal cell) Displays a normal celL 
Obstacle cell (a cell with an obstacle) Displays an obstacle cell. 

4. Visualizing the maximum water depth 

In the Object Browser, select [ ays2D Flood Grids] - [iRICZone] - [Scalar] - [Depth 

(Max)]. A contour map of water depth will open. 

~ Post-processing (20): 1 
Object Sr ....... 

~ Noys2D Aood VS.O 64 bit ··· • 
"' ~ Geographic O.to 

~ Elev>~tlon 
" ~ IRICZone 

~ 0 Gridshope 
S ~ SC.Ior 

:I 
0 Ll Depth 
0 Elevotlon 
0 u W!lterSurfzK:eEI··· 
0 Ll Velocity (mogn··· 
0 D Velocity(ms-1) ··· 

9 ~ Arrow 
0 1..) Velocity(n s-1) 

~ Streamlines 
0 Ll Velocity(ms- 1) 

~ Portldes 
0 U Velocity(ms-1) 

~ Cell ottribotes 
0 D obstode (Nor··· 
0 Obstode (Dbst··· 
0 0 Bomber (Norm··· 
0 u Bomber (Bomb··· 

~ Meosured V.lues 
~ ~d<ground Images 
~ 0 bg_oceh.Jpg 

~ 0 Title 
t'7l Thn o 
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In the Object Browser , select [Nays2D Flood Grids] - [iRIC Zone] - [Scalar]. Right · 

click on [Scalar] to select [Property]. The [Contour Sett ing] window will open. 

~ Post-processing (20): 1 

In the [Scalar Setting] window, make the following settings and click on [OK] . 

Ilk Scalar Setting 

Phy.ie.l v ..... IOeoth(Max) :::1 
V.!!Uerance--------­

r Automate 

t"·l ____ P" Fill._., .. 

IOJ1 r Fill low!.,. .. 

Colormap - -- ___, 

r. -- ~_j (" -
("' Cl.mom~ 

, .. 
Reiion Settin2 I 

Qoior Ba r Setti02 l 

The contour map is easier to see now. 

~Post-processing (20): 1 

E'J I) Depth(Max) 
o D Depth 
0 D Elev•tiOn 
0 t..) W.terSurfoce8··· 
0 D Velocity (m•gn··· 
0 0 velodty(ms-1) ··· 

E'J .::_:, Arrow 
0 D Velodty(ms-1) 

E'J Streomlines 
0 0 Velodty(ms-1) 

E'J Pllrtldes 
0 D Velodty(ms-1) 

E'J Cell •ttributes 
0 0 Obstode (Nor··· 
0 0 Obstode (Obst··· 
0 D Bomber (Norm··· 
o D somber (Bomb··· 

E'J Meosured V.lues 
s E'J Boc:kground lm•ges 

E'l D bg_•ceh.Jpg 
1'71 D Title 
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• Va lue range: 
Remove 0 from Automatic. 

Max: 4 
Min: 0.01 
Remove 0 from Fill 
lower area. 

• Display Setting : 
Contour Fringe 



I 

I s. Visualizing the max. flow velocity I 
In the Object Browser, select [ ays2D Flood Grids] - [iRIC Zone] - [Vector] - [Velocity 

(magnitude Max)]. Open the [Property] window of [Scalar] and flx the value range of 

the scalar bar of velocity contour map. 

6. Visualizing the inflow discharge hydrograph I 
Open new Graph Window from the calculation results menu. 

Import Draw MeMured Datzl Simulation Animabon Cala.Jlz!tioo Result View Optjon Help 

lal a, <S It') "' ~ !:. b" 'X 'Y "x • • 11li( Open new 20 Post.J>rocesslng Window 

~ 0 (!}E) E) A ,.., .. .,,,. 11 ,.,.,) t=~ "§) Opennew20Bird's-EyePost-Pnx:essingWindow 

. .. Pre-processing W1ndow 

a,, '>o Post-processing {20): 1 
Cl>JOCt-

23 

Open the Graph 
window 

iRIC_phoenix_2016 154 of252. 

• 

• 

• 



• 

• 

• 

Select [Calculation Result] - [Point datal - [New Inflow]. Click [Add] but ton at the 
center . 

I g) Data Source Setting ? ....... 

X Ax;.o lnme :.:J 
c.~cu~ation Re.utt 1 E>cternol I 
Pofit ~ta Selected Data 

New BoXCulvert IN ' New BoXCulvert OUT 

X Axis: Time 
Add» I 

Two dimensioMI Data 
« Re move I 

Deptll[~tox) 
Selected Data: Inflow 

Depth 
Elevotion 
WoterSurfllceEievobon 
Velooty (mognotude Mox) 
Velooty(ms-1) (mogn.tude) 

Se«ilc I 
I OK I 0«1cel I 

The hydrograph can be mapped with a contour map. 

iR. 
24 
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Chapter 3 
Examples of Tsunami Runup 
Analysis Using SRTM data 

+ Objectives 

Simulate tsunami·runup-induced flooding with ays2D Flood. 

+ Outline 

1. Creating the calculation grid 

Using elevation data of an actual river basin, create calculation grids: 101 division 

points in the transverse direction, and 131 division points in the longitudinal direction. 

2. Setting the calculation conditions 

Set a value for tsunami wave height assuming that a large-scale earthquake has 

occurred. Set various other conditions necessary for simulation. 

3. Making a simulation 

4. Visualizing the calculation results 

Here, we introduce how to display a water depth contour map and a flow velocity vector 

map. 

25 
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Exercise2. Tsunami flooding analysis 

s 0 AnOiff 
D D V•loorty 

a ~ Streamlnes-
0 L) Ve loc11y 

0 Par1ic:~ 

0 D V.lo<Ry 
Iii 0 Cell attrhltes 

0 C) Cbst«:leCNormoleetD 
0 D Chtac:le ~toc:le) 

0 Measued VaLe$ 

S 0 BackcrOII'IdlrMces 
0 D 201tam-to-11Kl122-a2.pe 
0 D 2'011C9l!l-1G--MG721-a2..P& 
0 U 2011000!HG-IotG624-a2.pc 
0 D 2011CIJJ!HD-1«)6Z}-a2.Pc 
0 D 201108l!HD--M0622-a2.A 
0 0 20TT09.J9-1D-MG621-a2.pe 

00 rrtle 
0 0 Time 
00 """ 

Creating the calculation grid #1 

1. Importing geographic data 
> On the menu bar, select [Import]- [Geographic Data]- [Elevation]. 

> Open the [¥SampleData¥N2F2] folder to select [tsunami.tpo] and click on 
[Open] to import t he data . 

> Select [1] for the value of [Filter] in the [Filtering Setting] window. 

: £• ~ C..cfto:.o.t. t-d ~~ c,.b* .... c::..-o... .. iooUat ..... (:.ebAot(lllfi-1 v- Q>~ .... ~ _" ~~: 

~..~ ... ~.,,.. '!! tr 'v"- ••t• ····:: ... . . .. ..,~ 
++ )'( \ , .. . · · · ;:;: -·-

IX: 1'1'-
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Creating the calculation grid #2 

2. Importing a background image 
~ Open all jpg files in the (¥SampleData¥N2F _2] folder, the positions of 

background images are automatically corrected. 

~~2011 0809-1 0-MG621-a2.jpg 
4! 2011 0809-1 0- MG622-a2 jpg 
4: 2011 0809-1 0- MG623-a2.jpg 
4:2011 0809-1 0- MG624-a2.jpg 
4: 2011 0809-1 0- MG721-a2.jpg 
4:2011 0809-1 0- MG722-a2.jpg 

Creating the calculation grid #3 

3. Selecting an algorithm for creating a grid 
~ On the menu bar, select (Grid]- [Select algorithm to create grid] . 
~ Select [Create grid from polygonal line and width] from the list below the 

[Select Grid Creating Algorithm] window, and click on [OK]. 

Alp:Jrllh!K DesiiCIIOR 

':gCJe~C.~~~.,.~~~m.~ple.Mdeine~-l lroe.by-.se-dcl.rc The 
• Oftte god from from nver swvey dlltzl .. lht 

1
:: ::!: :e::;:: ::r:~ ~ r 

ere~ gnd by dMcting rectMgUior rtgiOn dt-ectO'I.. 

en. .. ...,.,.._""'"""""'._ , ..... 

""'""""""""'""""'""" Cottesi-"1 Gnd for NeysEddy x64 

MuklfuncUcn Grid Cenenlltur 
Srmpte Grid G~Mr8tor 

./ Nays2D Flood primarily creates a grid from polygonal lines and grid widths. 
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Creating the calculation grid #4 
4. Creating a grid 
~ Right-click on several points through which the grid centerline passes, and 

press the "Enter" key . 

. • (jlo "'"" r... ...... o.o. C.• ..., ... _ ~-c:...... ~-M~- c:oa.w-~ -.:- ~- ~ 

.. ... ~ -"'\ 'tr ... --·· .... :: • • • • " ,t,. 
•• > -- .•...•. . ..• . . 

nstream end 

~ In the [Grid Creation] window, make the following settings and click on [OK]. 

e [nj] (Number of divisions in the longitudinal direction}: 100 
e [ni) (Number of divisions in the transverse direction}: 130 
e [W) (Grid width} : 3000m 
Note: In this example, grid cell intervals di, dj are set at around 30 m. 

~ Click on [Yes] in the [Confirmation] window . 

Creating the calculation grid #5 
4. Creating a grid 

[IN2F_2.spro - •RIC [Nay£20 flood v41 32 brt] - iPre- proce"inc Windo") ~~L8) 
"' Eile ImPort ~ro!!Phic Oeta !)ld Mea;ured Valles Qlllcul&t100 Cond1t100 S.mM.dation 

~ ~ ~ YxZv"x ••tf 

~~~~~-=~x ::~ .. ~ .. ,.~~ 

Node attr hrtes 
Celt attributes 
ilo.nl«y Cond rt""" 

0 MeaNed VaLes 
S 0 Bockc<<U>d lmo&es 

0 D 2011oeo9-1o-M0722-a2.;,c 
0 Ll 201 1oeo9-1Q-M0721-a2.i;>c 
0 D 2011oeo9-1o-M062•-a2..,. 
0 D 2011CBJ!H Q-M0623-a2.i;>c 
0 D 20110009-1 o-MG622-a2..,. 
0 D 2011CBJ!H Q-M0621-a2.i;>c 

0 D Ax .. 

. . . . 

J 
..... . 
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Setting the calculation conditions #1 
1. "Calculation Conditions" 
~ On the menu bar, select [Calculation Conditions] - [Setting] . 

Cllk:oll2tion Result VIeW Option Help 

1&. ~IJ!ij . ~ 

Setting the calculation conditions #2 

1. "Calculation Conditions" 
~ Click on [Inflow/ Outflow Boundary Conditions] from the [Group] list to make 

the following settings: 

!il Calculation Condit ion -- - - r1J(g) 
Groups 

I I I :I Time unit of discharge/water surface f ile !second vi 
Initia l Water Surface 
Time 
Others 

Reset 

Boundary Condit ions for j=1 

Boundary Condit ions for j=nj 

Water surface at downstream 

Constant value (ml 

Stage at downstream lime ser ies 

Rainfall 

Ra infall lime ser ies(mmlhl 

iRIC Phoenix 2016 160 of252. 

!outflow vi 
!outflow vi 

C(Read from file J:l> 
ol 

Edit l 
!without vi 

Edit 

[ Q.ave and Close I [ Cance I 
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Setting the calculation conditions #3 
1. "Calculation Conditions" 
)> Click on [Stage at downstream time series] to edit. 
)> Click on [Import] on the [Calculation condition] window. 
)> Select [¥SampleData¥N2F _2]- [HOl.txt] and click on [Open] . 
;.'1Cak:ul11t11m Cond1t1Dn L1JrRJ 

,.,,_<~> ~~ ;::"'=§'"'=;;;=======---=o:....:':...._· m-~-· _ 

~ .GiiD-'" l Time Water LIMII(m) 

ti<fo<:""' li) an"" 

7A!lh'1 

~=-==-~ J 
0 500 1 000 1 500 2.000 

Time 

""" Wlltslevel fm> 

1 c=J· 
2 " 1B1 , 100 ,. 

~ s . 101 ... ~ 
5 "" "" ~ · j 

• "" .,. 
~ J 

1 .. i 
8 "' .,. 2 

' ... "" 
10 .t50 ... 
11 511! 3S 

0 500 1 000 1.500 2 000 
Time 

Setting the calculation conditions #4 
1. "Calculation Conditions" 
)> Click on [Initial Water Surface] from the [Group] list to make the following 

settings : 

Groups 
Inflow/ Outflow Boun· · · 

Time 
Others 

Reset 

Initial water surface qGgnstant s lope ;:? 

Initial water surface slope of main channe l I 0.0001 I 
0.0001 

~~ave and Close j [ Cancel 
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Setting the calculation conditions #5 

1. "Calculation Conditions" 
)> Click on [Time] from the [Group] list to make the following settings: 

)> Conditions in [Others] are not changed. 

---------------------------~- ·-
Ill Calcu I at ion Condit ion LlJ~ 

Groups 
Inflow/Outflow Boundary Condit··· 
Initial Water Surface 

Others 

Reset 

20 1
20 

Output time interval <sec) . 
~======~ 

Calculation time step <sec) 0.510.5 
Start time of output <sec) 0 I 

!§ave and Close II Cancel 

Setting the calculation conditions #6 

2. Setting inflow rivers 
Additional setting of inflow condition 
)> In the Object Browser, select [Boundary condition setting]-[Add inflow] 
)> While selecting the [lnflowL enclose the sides of "Inflow" locations with polygons. 
)> When the location is confirmed, the [Boundary condition] setting dialog opens. 

iRIC_Phoenix_2016 162 of252. 
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Setting the calculation conditions #7 

2. Setting inflow rivers 
~ On the [Boundary Condition] window, input "New Inflow 1" to the [Name] box, and 

select [Edit] for the [Discharge time series] box under [Setting]. 
).> Click on [Import] on the [Calculation Condition] window. 
~ Open [¥SampleData¥N2F], select [QOl.txt] and click on [Open]. 

I C<!lc-uliiiiDn Condot1on ~~ ' Caleui,Jtmn Condolron f1J(g) 

Name: 

Setting 

Coloc 

0 Transparent ~-~ jso : . 

Point S i2e: DJ 

0 Show name 

OK I I Cancel 

06 

02 

.. , 

:: lf'M"TTT"I ~'TT"I' ""'''ITT"' .,.,I 
500 1 000 1 SOD 2 000 

Time 

limo D~aeCm3/d 

1 ~0 
2 50 0 

8 350 . "" 
10450 

" "" 0 SOO I 000 1 500 2 000 
Tim o 

Setting the calculation conditions #8 
3. Setting the roughness 
).> In the Object Browser, select [Geographic Data]- [Roughness condition].- [Add]­

[Polygon] 
>- Enclose the all grids with polygons 
).> Set the obstacle from [Edit Roughness Condition Value]. 

::1 NZF y. rpro - •RIC (Nit)'$20 fiDod v4 1 32 bit] - (Pre-proce~~:rnc Wmdo"] r;JLQ)rg) 
, ~ f•la lrroort Gpraptuc Data "d ~eel Values QalcuiatO'I Ccrdition S:urulatiOfl CalculotiCI'I ~It ~- ~ion Jielp - ". 

laj ~ ~ f'O '\ r:, !-" •x "Y "x • • t f "- "- •• •• l : .. • . ' A 5l:Wi;o"""{o~~I"'I 
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Making a simulation 

)> On the menu bar, select [Simulation]- [Run]. • 
)> Save the project. 
)> The [Solver Console [Nays2D Flood] (running)] wind ow will open to start the simulation . 

:J U2F _2 tpfO - 1RIC (Uaya2D flood v4 1 32 bit] - [Solver Concole (Na)'~D flood v4 1 32 bJt] trunnmr:l) ~§~ 

1.1..:...:;__ .. ++: : 
Rays.&.d_!lood Scl".-e: "ers1c.= 4.C.l!ll Lan update:! lOll 4 'U 
Cep-{:1~: r:o t:'i Ya!IU}":ll:1 Sbl.:.l.:u, 3el'kUI10 tl:uv .• .;apa.:l 
Mtod.i!a:t b',· :chl...-? Kl.=:a, !o.h.1n Ivuah, Snau V..Ya:ul , :axuy• I~e 
!.:.! evo.-!11>~ : r: ! levt 

~~J: ··~ 
: a1e 

C.GOO O.iJCOO o:-oooo o.oooo C'Jt. 

:c.coo O.')ODCi 0.')'Z40 c.oooc e~: 
40.000 o.oooo l.H!O 0.0000 !:l.lt. 

~~ .000 o.oooc 2.14!0 o.oooo eut. 
t:C.OOO o.oooo 2.!240 0.0000 C'Jt. 

100.000 0.':1000 3.~000 0.0000 cut 
120.000 o.oc:•o 4 .C!~O c.oooo cut 
140.000 O.OGOO LUOO 0.0000 OUt. 
!fiO.COO O.OGOC ~.l"J20 0.0000 C:.lt 
1!0.000 0.0000 s.UfO Q,QQOQ COlt. 

2:0 . 000 o.oooc 6.0€00 0.0000 C'Jt. 

220.000 0.0000 6.:HOO 0.0000 cut 
::!4C.OOO a.ococ 6.62~0 O.IJOOC cut. 
ZEC.OOO o.oooo 6.eO!O 0.0000 cut 
:Z!C.Ot'O o.oooo E.9C40 0.0000 aut 
300.000 o.oooc ~ .oooo o.oooo cu: 
!ZO.OOO 0.0000 6.90<40 0.0000 CUt 
J,C.COO O.'JO'JO s.ec~: o.ooc-o cut 
JEC.OOO O.OC'JO 6.il'JO 0.0000 cut 
3!0.000 0.1)000 6.J4'JO 0.0000 aut 
.t:c.·:oo 0.)0:]0 6.t6':oC: C.GOOGcu: 

- tf X 

fx "'"11'==---==-

Visualizing the calculation results 

)> On the menu bar, select [calculation results] -[Open New 20 Post-Processing 
Window] . 

)> In the Object Browser, select [Nays2D Flood Grids]- [iRICZone]- [Scalar]- [Depth] by 
making a check mark in each box. 

)> In the Object Browser, select [Nays2D Flood Grids]- [iRICZone]- [Contour]. Right click 
on [Scalar] to select [Property]. 

)> On the [Scalar Setting] window, make the following settings and click on [OK]: 

~Scalar Settm& - - ITJrRJ 
Ph)'<ocal Va"-' "-Dop'-"th'------' 

Value ranee 

0 Automatc -
0 
0 

E.] FIll upper area 

;:;,;om;:===~l 0 F•ll,_. ., .. 

0 C...tom Settrc 

Oc;play Seunc 

0 Colo< Frrc• 0!Con- ,..,..,1 0 lsolnes 
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TUTORIAL 2: Green River, UT 

This tutorial shows how to prepare the data necessary to run the SToRM model within the iRIC 
2.3 graphical modeling system (henceforth called iRIC only, for simplicity). Data collected in the 
Green River, Utah, is used to illustrate the application . An aerial view of the region of interest is 
shown below. 

Contents: 
1 ..... ......... .... ......... ... ...... ..... .... ..... .. .... ..... ... .... ... .......... ....... ..... .. .. ......... .. .. .... .. .. .. ... Getting Started 
2 .......... ............. .. ......... ..... .. .... ... ... .. .... .. ..... .... .. ..... ............ ........... .... .. Preparing Bathymetric Data 
3 .... .. ... ..... .. .... ... ........... .. ....... ..... .. ................ ......... ...... ....... .. ... .. Creating the Computational Mesh 
4 .. .... .................. ................. .. ................ .... .......... .. ........... Defining Inflow and Outflow Boundaries 
5 ......... ....... ............. .. ... ................... ...... .... ..... ... ... ..... ..... .... .. ...... Roughness and Initial Conditions 
6 ...... ... ... ..... .. ..... ... .. ..... ............... ... .. ....... ........ .... ... .................. .. ........ ........ ...... Running the Model 
7 ..... ....... ..... .. ..... ........ .. .... ... ........ .............. ........... ...... .. ........ ................... .. Visualization of Results 
8 .. ..... .......... .... .. .... ....... ..... ..... ..................... ...... .... .... .... ......... ... .. .. ........ ....... . Refini ng the Solution 
9 ........ ..... .. ... .. .. .... .. .. .. .................. .. ..... ... .. .... ...... .. .. .. .. .... ...... ..... .. ..... Thinning Areas of Dry Nodes 
1 0 ... ............. .... .. ........ ..... ......... .... ..... ................ ...... ..... .. .. ......... .......... ..... .. ... ... .. Model Calibration 
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TUTORIAL 2: Green River 

1. Getting Started 

Using iRIC and SToRM in a productive work environment usually results in an iterative cycle in 
which successive model runs hone into a progressively more accurate-perhaps the term refined 
is more appropriate here-solution, each benefitting from feedback from the previous ones. The 
workflow of an iRIC/SToRM project and consists in the following schematic steps: 

1. Import bathymetric data into iRIC. 
2. At this point ancillary data can also be imported into iRIC. Ancillary data may consist of 

items such as field measurements and orthorectified aerial imagery. 
3. Analyze and edit the data. 
4. Prepare a computational grid for use by SToRM. 
5. Define initial and boundary conditions, including roughness factors and other driving 

parameters. 
6. Specify model run parameters, such as choice of numerical scheme(s) and duration of 

the run . 
7. Run SToRM. May take minutes (go get a cup of coffee), hours (nap time), or days (don't 

less the boss know the computer is doing all the work). 
8. Analyze the model results , compare with measurements, all while exercising critical 

engineering judgment. 
9. Are model results grid-independent? If yes, proceed to the next step; if not, backtrack to 

steps 4. 
10. Is the model properly calibrated? If yes, proceed to the next step; if not, backtrack to 

steps 5 or 6. 
11 . Are model results satisfactory? Do they pass critical scrutiny? If yes, proceed to the next 

step; if not, backtrack to steps 4, 5, or 6. 
12. Production run completed . 

This set of tutorials, of which this is tutorial number two, aims at teaching how to use the technical 
tools comprised in iRIC 2.3 to accomplish the tasks described above. 

2. Preparing Bathymetric Data 

The first step consists in importing the topographic data into iRIC. The data used in this tutorial is 
located in file GR.tpo. GR.tpo is an ASCII editable file that contains the coordinates and elevation 
of each data point. To load this data into iRIC: 

• Use pull-down command Import 1 Geographic Data 1 Elevation from the main menu 
bar. 

• Find the data file in the folder where it is located and click OK in the pop-up window. 

The final result is shown in Fig . 2.1 . The individual survey points are plotted, colorized by bed 
elevation. (Note about notation used in this tutorial : bold faced words separated by a vertical bar 
denote a cascade of menus and submenus in iRIC, or a hierarchy of objects in the Object 
Browser.) 

Note the objects in the Object Browser window (Fig. 2.2). Among other things (which will be 
seen later) , this window can be used to turn specific aspects of the data on or off in the main 
display canvas. For example, click on the checkbox to the left of Points1 to uncheck it and the 
data will disappear. Cl ick on it again to check it and the data will reappear. This is true for all the 
graphic entities created during the course of this tutorial. The color range is calculated 
automatically from the data , but it can be changed from an appropriate control window (Fig. 2.3, 
left), which is brought up by highlighting Points1 in the Object Browser window (highlighting of 
any item in the Object Browser window is accomplished by left-clicking the mouse on the 

Page 2 of 37 
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TUTORIA L 2: Green River 

desired object) and then right-clicking the mouse on Geographic Data 1 Elevation and selecting 
Color Setting from the pop-up menu. The same pop-up menu has other functionality, such as 
controll ing the display a color legend. The use of this menu is simple and straightforward . 

lol & " t{ , ....... ... . 

• + X .. '" . •· • /. /-

..... : ; .. . . . 

Figure 2.1 

Object Browser 

0 
0 Elevation 

0 Point s1 

0 lbughness 

0 lnitiaiU 

0 lnitiaiV 

0 - Initial Stage 

0 Wind Friction Coefficient 

0 Wind Magnitude 

0 Wind Direction (Azimuth) 

8 0 Grid [No Data] 

0 0 Grid Creating Condition 

0 Measured Values 

0 Background I mages 

0 D Axes 

Figure 2.2 

,.,.,.rm, 

X 

Right-clicking the mouse on Points1 directly brings up another pop-up menu with different 
functionality . For example, it is possible to change the name of the dataset (Points1 is the name 
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TUTORIAL 2: Green River 

assigned to the data by default) and the points' appearance. To change how the topographic data 
is plotted: 

• Right-click the mouse on Geographic Data 1 Elevation 1 Points1 and select Property . 
The window in Fig . 2.3 (right) will appear. Click OK when finished . 
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Figure 2.3 

It is possible to use gee-referenced images and plot them under the topographic data. This 
provides a much more interesting visual feedback when working with the data. To import a 
background image: 

• Select File !Import 1 Background Image from the main menu. Alternatively, Import 1 
Background Image can also be used. 

• In the Open Image dialog window, select GR with WS.jpg. 

The image is now displayed in the main drawing canvas under the topographic data, as shown in 
Fig. 2.4. Note that displaying this image is optional : its display can be turned off by unchecking 
Background Images 1 GR with WS.jpg in the Object Browser window. Turning the topographic 
data set off (by unchecking Geographic Data I Elevation 1 Points1 ) shows the background 
image without the data points. The blue circles indicate the locations where measurements of the 
water surface elevation were made; these measured data will be used later in this tutorial. 

At this point it may be convenient to save the project. To save the project: 

• From the main menu, chose File 1 Save as Project. Never choose command Save as 
File (*.ipro) when using SToRM. 

• A pop-up window (Fig. 2.4) lets you select the location where the data will be saved. 
Select the desired location and click on Make New Folder. Assign it a name and click 
OK. 

• This operation creates a new folder containing all the data used by iRIC and by SToRM. 
The data used later by SToRM is saved in a CGNS-formatted file with extension .cgn . 
CGNS (CFD General Notation System) is a data format used widely in the computational 
fluid dynamics community . 
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3. Creating the Computational Mesh 

TUTORIA L 2: Green River 

In this exercise, the area of interest is comprised of the elbow and the island located West of it. 

Zoom and pan to that area, which can be accomplished by using buttons ~ ~ in 
the main toolbar. Zooming can also be done by rotating the mouse wheel and panning by right­
clicking the mouse and moving it on the display canvas while pressing the <Ctrl> key. After 
zooming and panning to the desired area, iRIC will look like what is displayed in Fig . 3.1. 
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Figure 3.1 

In iRIC, the computational grid is created automatically by a triangulation program using a few 
parameters defined by the user. These parameters are: a polygon encompassing the area of 
interest, maximum area of the triangles, and their minimum allowed internal angle. The steps 
needed to create the grid are : 

• From the main menu bar, use command Grid 1 Select Algorithm to Create Grid .. . and 
select Create grid from polygonal shape by clicking on it. 

• The computational domain is defined by a polygon that encompasses the area of interest. 
Define it by left-clicking the mouse at the desired polygon vertices, in the proper 
sequence. iRIC provides guiding visual feedback during this process. Double-click the last 
point or press <Enter> to finish the polygon. Use Fig. 3.2 to guide you on the shape and 
location of the polygon . 

• Right-click on Grid[No Data] in the Object Browser. This starts the grid generator. 
• The Grid Creation window is used to define the basic parameters that control grid quality. 

Enter the values shown in Fig . 3.3 (maximum angle for cell vertices: 32 degrees; 
maximum area for cells: 73 m2

) . 

• When prompted to map geographic data to grid , click Yes. This operation transfers the 
topographic data to the computational grid . 
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TUTORIAL 2: Green River 

The result of these steps is shown below in Fig . 3.4, where the background figure display was 
turned off to help visualizing the grid. The computational mesh was created within the shaded 
polygon. The flow is from East to West. Build the polygon to extend the reach of interest. Narrow 
sections away from bends are good locations to use as inflow and outflow boundaries because 
they have stronger and somewhat straighter velocity profiles than wider areas. It is a bad idea to 
place these boundaries near zones of recircu lation . 
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Figure 3.4 

The objective of the internal angle constraint is to avoid creating triangles that are long and 
narrow, which have poor interpolating qualities and can impact negatively the accuracy of the 
model 's numerical solutions. Ideally, the value chosen should be close to 60 degrees, which are 
the internal angles of an equilateral triangle. Unfortunately, the grid generator may become 
unstable for an angle greater than 30 degrees, therefore the use of this value is recommended . 

The maximum triangle area constraint was determined from considerations about the required 
resolution . Querying the topographic data indicated that the river width at the section entering the 
computational grid is approximately 130 m. A good rule-of-thumb is to have a starting mesh with 
at least 10 grid segments across any area of interest (in this case, across the river width ). 
Calculations on finer grids are more accurate than on coarser ones, but take longer computer run 
times. A good compromise is sought, where there are enough grid points for accurate solutions 
without the computational burden of a finer discretization . This determines that a good size for the 
edges of the triangles may be 13m (= 130/1 0). The formula for the area of an equilateral triangle 
whose edges are 1::0< in length is 

Using this expression with 1::0< = 13, an approximate triangle area of 73 m2 is found . 
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4. Defining Inflow and Outflow Boundaries 

The computational domain defined by the grid is the only part of the river "seen" by SToRM 
during the calculations. In other words, the model does not have any sort of information about the 
region outside the computational grid . To be able to carry out the backwater ca lculations, it is 
necessary to know something about what is upstream and downstream from the computational 
region . Basic hydraulics principles require that, for subcritical river flow, the discharge entering 
the grid and the water surface elevation at the downstream-most region of the grid must be 
known. These regions, where the stage and discharge must be specified , are usual ly called the 
hydraulic boundaries of the domain. The quantities prescribed there (discharge and stage) are 
called the boundary conditions. This section illustrates how to define the boundary conditions in 
iRIC. 

First, we are going to define the inflow boundary. This can be thought of as being the upstream­
most cross section in the computational domain , and the flow discharge must be specified there. 
It is convenient to define this boundary as a straight line perpendicularly to the centerline of the 
river channel. This is done when defining the main boundary polygon for the mesh, but the 
appropriate nodes need to be assigned to the inflow boundary. Each inflow (and outflow) 
boundary is composed of a string of contiguous nodes located on the boundary of the 
computational grid. The steps below show how to mark the inflow nodes and assign an inflow 
boundary condition to them. 

Zoom to area of interest, as shown in Fig . 4.1 , and: 

• Right-click on Boundary Condition Setting item in the Object Browser and select Add 
Inflow in the pop-up window. 

• Define a polygon that encompasses all the grid nodes (triangle vertices) belong ing to the 
inflow boundary. Do not skip nodes. End the polygon by pressing <Enter> on the 
keyboard . 

• In the ensuing boundary Condition window, assign the inflow condition a name and 
click Ok. Here, we use Inflow (Fig . 4.2, left). 

• Select Fixed Width in the Type of inflow boundary. 
• Enter the time series for the inflow discharge by clicking Edit. In this example, only one 

value is entered (Q = 247 m3/s), because we seek a steady state flow solution (Fig. 4.2, 
right). Cl ick on the button Add to add a row on the left (white) window, for data entry. 
Click on the respective time and discharge cells to enter the numerical values. Click Ok 
when done. 

• The defined inflow boundary is shown in Fig. 4.3. 
• If the grid has been rotated , the display can be returned to its original state of zero 

rotation by clicking on the button U located in the main toolbar. 

Fig. 4.1 shows the grid colored by bed elevation. This is accomplished by checking Grid 1 Node 
attributes I Elevation in the Object Browser. 
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Figure 4.3 

The inflow discharge is entered at a time series, with time (seconds) in the left column and 
discharge (m3/s) in the right column . In this case there is only one constant value of the 
discharge, therefore time data is not important, and a value of 0 (zero) was entered. 

In this example, the discharge is distributed uniformly across the string of nodes defined as the 
inflow boundary. A synthetic flow velocity field is then generated with velocity vectors that are 
perpendicular to the string. Due to the artificial nature of this velocity distribution, it is 
recommended that this boundary should be placed away from the areas of interest, i.e., from 
regions where accurate solutions are sought. Try not to include nodes that are thought to be dry 
or, at least, try keeping them to a minimum. This may require a trial-an-error procedure, where 
successive runs are performed with increasingly accurate boundary node strings. This process is 
illustrated in Fig. 4.4, which depicts three inflow boundaries, with the computational grid in gray, 
the physical river margins in thick black lines, the computed river margins in thinner black lines, 
and the arrows showing flow paths. In (A) , too many nodes (small squares) are assigned to the 
inflow boundary, resulting in an artificially larger river width. In addition to the inaccuracy, potential 
problems associated with this type of boundary are caused by large flow velocities on shallow 
depths over the margins, which may induce numerical instability and require unnecessarily small 
time steps to march the solution in time (time stepping is discussed in a later section of this 
tutorial). The opposite circumstance is shown in (B), where too few inflow nodes cause the flow to 
accelerate in the middle of the channel and produce spurious eddies near the river margins. 
These eddies occur because triangle edges at the border of the grid are treated as solid walls, 
therefore the flow is computed as if there are small groynes blocking the flow at each side of the 
inflow cross section. Finally, the ideal boundary string is shown in (C): it does not extend past the 
river margins, neither does it fall short. 
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Recirculation 
eddy 

® © 
Figure 4.4 

To deal with the issues described in the previous paragraph, SToRM offers two different 
implementations of the inflow boundary condition. The first (used in the example in this tutorial) 
uses the static inflow boundary, where the flow is distributed along every segment in the 
boundary node string , as described in the previous paragraph. This option is the Fixed Width in 
the Type of inflow boundary option (Fig . 4.2, left). This option is useful for those cases where 
the top width of the inflow cross section does not change significantly during the hydrograph, but 
it may require trial-and-error to set properly (as shown in Fig. 4.4 ). The second type of inflow 
boundary condition is the Variable Width in the Type of inflow boundary option (Fig . 4.5). 
When this option is selected, of all the inflow nodes in the inflow boundary string , only the 
boundary edges associated with wet triangles will have inflow. In this case, the inflow cross 
section may widen when the stage at the inflow rises, and contract when it lowers, which may be 
useful for inflow hydrographs with large amplitude, i.e. , with large magnitude changes. Its 
disadvantage is that it cannot be used to start simulations of the flooding of dry areas. It may also 
cause spurious oscillations in the solution due to alternate wetting and drying of triangles at the 
edges of the inflow cross section. 
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Figure 4.5 

The outflow boundary can be thought as the downstream-most cross section of the river reach , 
and is where the water surface elevation (stage) is needed for the backwater calculations. This 
boundary is defined in similar steps as those used to define the inflow boundary: 

• Zoom to the area of interest, which is the northwest end of the computational grid (Fig . 
4.6). 

• Right-click on Boundary Condition Setting item in the Object Browser and select Add 
Outflow in the pop-up window . 

• Specify the outflow boundary nodes using a bounding polygon , as it was done for the 
inflow boundary. 
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• Assign the inflow condition a name and click Ok. Here, we use Outflow (Fig . 4.7, left). 
• Enter the time series for the outflow stage by clicking Edit. This process is similar to the 

one used to define the inflow discharge time series: click on Add to create a data entry 
row and click on each cell to enter the corresponding value. 

• In this example, on ly one value is entered (1447.4 m), because we seek a steady state 
flow solution (Fig. 4. 7, right). Time is, therefore, not important and the value 0 (zero) is 
used here. Click Ok when done. 

• The defined outflow boundary polygon is shown in Fig . 4.6 . 
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Figure 4.6 
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Outflow boundaries need not be defined as rigorously as inflow boundaries, and assigning nodes 
that are known to be dry is acceptable. Outflow boundaries that are too narrow, however, will 
have similar issues with flow obstruction and unrealistic recirculation areas. Ultimately, it is better 
to have an outflow boundary that is too wide than one that is too narrow. The outflow boundary 
should be defined as a cross section placed perpendicularly to the flow and away from 
recirculation zones. Ideal places are gaging stations in the river, where stage information is 
known and can be used as boundary condition . However, in most cases that is not be possible, in 
which case the data collection program should include the surveying of appropriate water levels 
for the discharges of interest. 
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It is relatively easy to make an error creating a boundary-node string. Any string can be deleted 
by right-clicking on its name in the Object Browser and selecting Delete in the corresponding 
pop-up menu. Note also that the inflow and outflow boundaries are grid nodes defined on the 
border of the computational grid. Any string can be defined as inflow or outflow, and it is up to the 
user to define them correctly to ensure that the flow is in the right direction . 

After all the boundaries are created , map the boundary polygons to the grid by executing the 
command Grid I Attributes Mapping 1 Execute ... from the main menu. The boundary nodes will 
not be properly identified by SToRM until this step is completed . 

This would be a good point to save your work. 

5. Roughness and Initial Conditions 

Roughness is set by drawing polygons (sometimes called coverage polygons) over the areas of 
interest. Follow these steps to set the roughness: 

• In the Object Browser, under Geographic Data right-click on Roughness and select 
Add and Polygon in the respective pop-up menus. 

• Draw a polygon covering the entire computational grid. The polygon is entered by left 
clicking the mouse on the canvas to enter each vertex of the polygon, in sequence. Finish 
by double-clicking the last vertex of the polygon (or by pressing <EnteP ). 

• Enter the value of the roughness, as in Fig. 5.1. 
• Map the roughness values to the computational grid by executing the command Grid 1 

Attributes Mapping I Execute from the main menu . 
• The final polygon may look like what is shown in Fig . 5.2. 
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Figure 5.1 
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Figure 5.2 

In SToRM, roughness can be represented by Manning's n values, by Chezy's C coefficients, or 
by drag coefficients cr. The default is Manning's n, which is used in this tutorial , but it will be 
shown later how to select the others. There is a conceptual difference between roughness in one­
dimensional and in two-dimensional modeling frameworks. For example, recirculation areas are 
not modeled by one-dimensional models, therefore their contribution to flow resistance is 
incorporated in a bulk roughness factor n, which also includes flow resistances from many other 
phenomena. Two-dimensional models, however, are able to calculate recirculation areas with 
greater detail , therefore their effects do not need to be included in n. The same happens for a 
number of other phenomena (such as super-elevation), which results in the same river cross 
sections having different values of n depending on the model used. In general , the Manning 's 
roughness values are lower in two-dimensional models than in the one-dimensional counterparts. 

The term "initial conditions" reflects the state of the flow at the beginn ing of the simulation , i.e. , at 
time t = 0 s. A simulation run starts with a known flow field , which is a known velocity and water 
depth throughout, and advances it in time (also called time marching or time stepping in the 
modeling community). Often times, the initial flow field is unknown and it must be guessed in an 
appropriate manner. In steady state computations, a good initial guess is closer to the final 
solution, therefore needing shorter run times to reach it. In this tutorial , a number of polygons are 
used to define a set of initial conditions to run SToRM. 

One of the ways that can be used to define initial conditions is by the use of coverage polygons, 
identical to what is done above for roughness data entry. For each quantity U (component of the 
flow velocity along the x axis), V (component of the flow velocity along they axis), and 11 (water 
surface elevation), a polygon is used to define a region with a uniform distribution of the 
respective variable. The polygons do not need to be identical for each quantity and may overlap. 
In the present example, three areas are defined, as shown in Fig . 5.3: the inflow stretch (1 ), the 
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elbow region (2), and the island (3). This classification is arbitrary and many others could be 
devised . 

Figure 5.3 

The steps to define each polygon are described here using Fig. 5.3 as a guide. For the U velocity: 

• In the Object Browser of the Pre-processing Window, right-click on Initial U and select 
Add and Polygon in the respective pop-up menus. 

• Define the first polygon by left clicking the mouse on the locations of its vertices. Double 
click or press <Enter> to terminate the polygon and assign it a value of -0.50 m/s (Fig. 
5.4). 

• Repeat the steps to define the second polygon and assign it a value of -1.54 m/s (Fig 
5.5). 

• And repeat the steps to define the third polygon and assign it a value of -1 .09 m/s (Fig 
5.6) . 
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Repeat similar steps to define identical polygons for the V velocity: 

TUTORIA L 2: Green River 

• In the Object Browser of the Pre-processing Window, right-click on Initial V and select 
Add and Polygon in the respective pop-up menus. 

• Define the first polygon similarly to what was done for the U component and assign it a 
value of -1.46 m/s (Fig . 5. 7). 

• Repeat the steps to define the second polygon and assign it a value of 0 m/s. 
• Finally, define the third polygon and assign it a value of 1.09 m/s. 

Similarly to what is done above for the components of the flow velocity, water surface elevation 
can be defined in the same three regions of the computational domain. Values of the stage for 
each area were averaged from existing experimental data. 

• In the Object Browser of the Pre-processing Window, right-click on Initial Stage and 
select Add and Polygon in the respective pop-up menus. 

• Define the first polygon similarly to what was done for the velocity components and 
assign it a value of 1448.7 m (Fig. 5.8). 

• Repeat the steps to define the second polygon and assign it a value of 1448.51 m. 
• Finally, define the third polygon and assign it a value of 1447.75 m . 
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Try to make the corresponding U and V polygons match each other as closely as possible. After 
all the polygons are defined , transfer their properties to the computation grid points by executing 
the command Grid 1 Attributes Mapping 1 Execute in the main menu bar. Save your work. 

The values of the water surface elevation used above were determined by averaging 
measurement data taken inside each coverage polygon. There are no measured velocity data 
points, therefore the values used in the initial guesses above had to be derived some other way. 
First, a cross section was cut from the topographic data right at the southern-most tip of the 
elbow, in region 2 of Fig . 5.3. This location is very close to a measurement point for which 
experimental data is available, and its top width is representative of a large part of the study 
reach . The cross section is plotted in Fig. 5.9, showing also the experimental stage. The top width 
in that section is 135 m, and an estimated average depth is 1.5 m. From the known value of the 
water discharge (Q = 247 m3/s , as defined in the previous section), an average value of the mean 
cross sectional velocity can be found : Um = Q/A = 1.2 m/s, where A is the cross sectional area. 

135 m 

Figure 5.9 

Using the flow directions represented by the white arrows in Fig. 5.3, in region (1) the flow makes 
an angle a of 250 degrees with the x axis, 180 degrees in region (2), and 135 degrees in region 
(3). From the known relations U = Um cos a and V = Um sin a, one can find the values used in this 
exercise. 

Don't forget to save your work. 

6. Running the Model 

The previous sections defined the region (computational domain) where the simulations are going 
to take place. Like any other model , SToRM requires the definition of additional parameters. 
Some of these parameters are physical quantities, others are parameters used to set up the 
numerical methods used to solve the equations. These must all be defined by the user in a set of 
entry screens that are going to be covered in this section . 

To define the parameters needed for the run , there are a group of entry screens in the 
Calculation Condition window. This window is invoked from the Calculation Conditions I 
Settings ... menu from the main pull-down menu bar. The different parameter entry screens are 
selected by clicking the appropriate text in the left-hand side panel. The first is titled Initial 
Conditions and is shown in Fig. 6.1 , left. In this tutorial , the initial conditions were defined using 
coverage polygons in the previous section , therefore this entry screen must read From coverage 
polygons in the Set-up initial conditions pull-down menu . 
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The Wetting and Drying entry screen shown in Fig . 6.1, right, is used to specify the parameters 
that control the behavior of the wetting and drying computation algorithm in SToRM. Parameter 
Threshold for drying cells is a value of the water depth (in meters) below which a wet cell 
becomes dry. In th is example it is set to 3 mm. Parameter Threshold for re-wetting cells 
defines a value of the water depth above which a dry cell becomes wet. It is a dimensionless 
multiplier: th is value multiplied by the Th reshold for drying cells provides the desired value of 
the water depth. Here, the value of the parameter is 2, meaning that a dry cell is considered wet 
again when its water depth becomes higher than 6 mm (2 x 0.003). The Threshold for re­
wetting cells parameter is important because it prevents excessive triggering of wetting and 
drying of cells at the river margins. This numerically-induced wetting and drying cycle can 
introduce instabilities in the solution and slow down convergence to steady state . Recommended 
values are of 2 or higher in the lowest range, and up to 10 or more, depending on the value used 
for the threshold for drying cells: low drying thresholds require higher re-wetting values. 

The Solution Parameters entry screen (Fig. 6.2, left) is used to define the parameters used by 
the time stepping solution algorithms in SToRM. The Time step size defines the size of the time 
step used to advance the solution in time. The time units are seconds. The Time stepping 
method is a pull down menu that selects the time stepping method used in the calculations. 
There are two methods: Order 1 and Order 2. The first method is computationally more efficient 
and the second more accurate (at the expense of computer run time). The choice of time 
stepping method is a compromise : in a typical application, both methods should arrive to the 
same solution , but it may be necessary to use smaller time steps when using the 151 order 
method. Experimentation may be needed to choose between each, with the ultimate goal being to 
reach a solution in the shortest computer run time. 

A maximum of 100,000 time steps are sought (parameter Number of time steps), with 
intermediate print-out of the solution every 10,000 time steps (parameter Plot Increment). This 
corresponds to a run of 10,000 seconds (approximately 2.8 hours) with an intermediate solution 
every 1,000 seconds. 

Finally, the General Options entry screen (Fig. 6.2, right) al lows to select the type of roughness 
coefficient from the Type of resistance coefficient pul l-down menu. The other options are not 
used in this tutorial and can be safely ignored for now. 
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After the data preparation, SToRM is run by cl icking the .... button on the main window command 

bar. A model run can be stopped at any time by clicking on the button . A window pops-up 
where the progress of the computation can be followed . The first column contains the iteration 
number; the second column contains the corresponding time, in seconds; the third column 
contains the value of a quantity that indicates the relative change of the water depth in each time 
step, defined as 

'L(h:+lll- h:t 
"L(h:r 

where h: is the water depth in triangle i and at time t, M is the time step size, and the summation 

is carried over all the wet triangles; the fourth column contains the inflow discharge of water 
(m 3/s); and the fifth column contains the discharge out of the computational domain (m3/s). 

Choosing the appropriate time step for the run is an important task. SToRM uses explicit time 
stepping methods. In practical terms this means that, in order to keep the computations stable, 
there are constraints to the time step size. If unstable, the computations "blow up," which is a way 
to say that the variables become uncontrollably large or small- cause divisions by zero or the 
numbers become larger than the limits of computer representation- so that the water depth may 
become negative, and the run stops prematurely and its results are meaningless. An indication of 
these events is the presence of 'lnf' or 'NaN' in the model output window during the run. Usually, 
in convection-dominated flows, stability is related to flow celerity, size of the time step, and 
triangle dimension by a dimensionless parameter: 

where M is the time step size, Um is the magnitude of the flow velocity at the center of the triangle 
( = (Lf2 + \12) 112), his the water depth at the same point, g is the acceleration due to gravity (9.8 
m/s2) , and Lr is a grid-related length scale (for example, the triangle's perimeter). The 
dimensionless parameter Cr is called the Courant number and is fixed for a certain time stepping 
method, but usually different for different methods. The above relation translates into the flowing 
statements: 
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1. For a triangle of a certain size, larger flow velocity requ ires smaller time steps. 
2. In the same situation , larger depths also require smaller time steps, but this constra int is 

less severe than the one for flow velocity. 
3. For a certain flow field , larger time steps can be used for larger triangles. For smaller 

triangles the time step size must be reduced accordingly. 

This process is succinctly schematized in Fig . 6.3, where the two constraining parameters, flow 
velocity and grid size, are shown as curves representing the stabil ity of the numerical solution. 
Considering each parameter individually, the curves represent the maximum stable time step 
size. For example, the maximum allowed time step size increases as triangle size increases, but 
it decreases as flow velocity grows. 
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Figure 6.3 

A stable time step must lie below both curves. In some cases the limiting factor is velocity 
magnitude, in others grid size . This means that, for each physical prototype, there is always a 
limit to the maximum value of the time step that produces a stable numerical solution , which is 
represented by fltmax in Fig. 6.3. These are important facts to keep in mind when selecting the 
parameters that go into the Solution Parameters entry screen . Unfortunately, th ings are not that 
simple. For example, for shallow depths the friction terms become dominant, the flow is no longer 
convection-dominated, and new restrictions are imposed to the time step to keep the 
computations stable: small time steps are needed for very shallow depths. Therefore, a trial-and­
error cycle is usually necessary to determine the largest time step that retains the stabil ity of the 
computations. This is case dependent and varies with bed geometry and other boundary 
conditions. 

7. Visualization of Results 

Besides the data preparation and model 's parameter input, a process usually referred to as pre­
processing , iRIC also provides means to view the model 's numerical solution. This post­
processing stage is done in its independent window, titled Post-processing (20):1 and shown in 

Fig. 7.1. The pas-processing canvas of iRIC is invoked clicking on button or by selecting 
Calcu lation Result 1 Open new 20 Post-Processing Window from the main menu . The Post­
processing (20) :1 window works identically to the Pre-processing Window, with its own Object 
Browser, and is used to plot the solution variables. 
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Figure 7.1 

The Post-processing (20):1 can be resized , and visualization of the diverse solution variables is 
turned on and off by checking the corresponding boxes in the Object Browser. For example, 
velocity vectors and water depth are visualized in Fig . 7.2. 
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As it can be seen, sometimes the plotting parameters are not ideal for the optimum display of the 
desired quantities. The visualization of each can be fine tuned using the appropriate 
customization menus. For example, the visual properties of the velocity vectors can be changed 
from the Arrow Setting window (Fig 7.3 left), which is invoked by right clicking the mouse on 
SToRM Gids 1 iRICZone 1 Arrow in the Object Browser. Similarly, the visual properties for the 
selected variable, which is water depth in the present case, can be set in the Scalar Setting 
window (Fig . 7.3 right), which is invoked by right clicking the mouse on SToRM Gids I iRICZone 1 

Scalar when Water Depth is checked. Visual izing all scalar quantities is done the same way and 
their names are self-explanatory. The user is encouraged to try them all. 
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There is an important scalar quantity that is different and requires addressing. It is the SToRM 
Gids 1 iRICZone 1 Scalar IIBC. This quantity is used like a mask to separate wet from dry cells, 
and has a value of 1 in wet cells and 0 (zero) in dry cells. Its visual ization is shown in Fig. 7.4. It is 
used to mask the other solution variables when it is desirable to see their values in wet cells only. 

To show how to use IBC to mask a variable, let's use the water surface elevation . Without 
masking , the water surface elevation is shown in Fig . 7.5. The display shows water surface 
elevation in wet cells, but also in dry cells, where stage is not defined but plots with the same 
elevation as the bed. To restrict the display of water surface elevation to wet cells only: 

• Right cl ick the mouse on Scalar (henceforth the string SToRM Gids 1 iRICZone will be 
omitted when there is no source of ambiguity) and select Property to bring up the Scalar 
Setting window (Fig. 7.6, center). 

• Click on Region Setting and select Active Region (Fig . 7.6, right). Click OK when done. 
• Click OK in the Scalar Setting window to complete the process. 
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Figure 7.4 

The resulting plot is shown in Fig . 7.7, where the legend was removed to improve clarity. To 
remove the legend: 

• Right click the mouse on Scalar and select Property to bring up the Scalar Setting 
window (Fig. 7.6, left). 

• Click on Color Bar Setting to bring up the Color Legend Setting window (Fig . 7.6, 
right). 

• Uncheck the Visible setting. Press OK when done. 
• Click OK in the Scalar Setting window to complete the process. 

Note that there are other attributes that can be changed in the Color Legend Setting window. 
They are self-explanatory and the user is encouraged to try different settings to see how they 
impact the look of the plotted variables . 
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Figure 7.7 

In iRIC, it is possible to visualize the flow using streamlines, which are lines are tangential to the 
flow field (they also represent the trajectories of weightless buoyant particles in steady state 
conditions). To create streamlines: 

• In the Object Browser check Streamlines and Velocity. 
• Right click the mouse on Streamlines and Property to bring up the Streamline Setting 

window (Fig. 7.8). 
• Left click the mouse in a desired initial position in the plotting canvas and drag it to the 

desired final position without releasing the mouse button . Release the mouse button only 
at the final position. This operation defines a starting line for the streamlines. Set the 
streamline parameters (color, number of streamlines, and streamline width) as desired. 

• Clock OK to create the streamlines. 

A view of some streamlines is shown in Fig . 7.9, plotted over water depth . 
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8. Refining the Solution 

Figure 7.9 
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After a solution is found it may be desirable to refine it. There may be several reasons for th is: the 
computational grid may have been deemed too coarse; a sensitivity ana lysis may be contractually 
requ ired ; the time step may have been too large; quality control ; etc. One of the possible 
refinements may consist in using the 2 nd order time marching scheme. This impl ies obtaining a 
new SToRM solution. To run SToRM with a 2 nd order time marching scheme follow the next 
steps: 

• Close the post-processing window. 
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• In the main menu, select Calculation Condition and navigate to the Solution 
Parameters entry screen . 

• From the Time stepping method pull-down menu select Order 2 (Fig . 8.1 ). 
• Click on button Save and Close. 

Because the same computational grid and boundary conditions and corresponding node strings 
are used , nothing else needs to be changed. SToRM can , therefore, be run again by simply 

clicking on button ... in the main toolbar. When the run finishes, follow the steps described in the 
previous section to view the new solution , which is shown in Fig. 8.2. Fig 8.2 shows velocity 
vectors over water surface elevation, with visualization of the computational grid turned off. 
Visualization of the solution vectors was customized to the display parameters shown in Fig. 8.3. 
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It is often necessary to refine (or coarsen) the mesh. Mesh refinement is desirable when more 
accurate solutions are sought; mesh coarsening is desirable when shorter computer run times are 
required . Care must be exercised when working on coarser meshes, to ensure that the quality of 
the solution is not degraded. When refining the mesh , the following steps must be followed : 

• Create a new mesh using the mesh generator. 
• Define new inflow and outflow boundary strings. 
• Define new roughness and initial conditions polygons. 
• Re-run the model. In general , the same SToRM parameters can be used, but the time 

step size may have to be adjusted . For example, the time step size may have to be 
reduced to ensure stability of the computations. 

In essence, one must repeat all the steps previously described in sections 3 through 6. For th is 
example, a new mesh was generated using the same polygonal shape defined in section 3, which 
needs not be re-entered . Only the mesh generator needs to be re-run , this time using a maximum 
triangle area of 40m2. The resulting mesh is shown in Fig. 8.4, with the new boundary node 
strings. 

The new solution is plotted in Fig. 8.5 in the same manner as the one in Fig. 8.2. One can see an 
overall more refined solution , with a somewhat better behaved flow field-often a result of the 
smaller grid size at the margins of the river. The same SToRM parameters were used in this new 
run , but with a 1st order time stepping method and a time step of 0.1 s, as described previously in 
section 6. 
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9. Thinning areas of dry nodes 

Areas of the computational mesh that are dry are excluded from the computations. Nevertheless, 
they still use computer memory and contribute to an additional memory overhead that may 
degrade computational efficiency, resulting in longer run times of SToRM . An example of a dry, 
unused part of the computational grids discussed in this tutorial is the island in the middle of the 
river. iRIC and its mesh generator provide the tools necessary to thin out that area , a process that 
involves delineating the area to be th inned (or hollowed out) and regenerating the mesh. 

To thin out the island, start by turn ing all the v isualization options off except the background 
figure, the Grid Creati ng Condition , and the Node Attributes (set to Elevation). This will resu lt 
in a display canvas such as the one shown in Fig. 9.1 and will help guide the process. Select 
Grid Creating Condition in the Ob·ect Browser window. This will activate the editing menu bar 

: + + CJ • \ A+ A_ X • 
· . Left click the mouse on the __ button and draw a 
polygon around the area to thin out. The polygon is drawn by left-clicking the mouse on the 
desired points and term inating with a double click or carriage return. Here, an hexagon is used to 
illustrate the process (Fig . 9.2). Right click the mouse on Grid to generate the final mesh. The 
resulting grid is shown in Fig. 9.3, where the Grid Shape visualization was turned on . 

Figure 9.1 
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It is possible to create as many thinned holes in the mesh as desired. The boundaries of each of 
these areas are treated as vertical solid walls and the flow will not go through. Vertical bridge 
piers, dikes, and general emergent obstacles in the flow can , therefore, be represented by 
thinned out holes. 

Please recall that the old inflow and outflow boundaries must be redefined anew every time a new 
computational grid is created . 

10. Model Calibration 

In spite of the many tables commonly found in open channel flow textbooks, characterization of 
hydraulic roughness is still a difficult task to accomplish . One of the difficulties stems from the 
high variability of surface types encountered in environmental hydraulics: sand, cable , and 
boulder river beds, vegetated channels, debris and other flow obstructions, all offer different 
values of resistance to the flow. It is not easy to measure flow resistance itself directly in the field . 
In practice, a surrogate to flow resistance is provided by the slope of the free surface elevation , 
which is a quantity easy to measure. In this section , values of the free surface elevation are used 
to obtain an estimate of the value of bed roughness (Manning's n values) for the reach . 

iRIC provides a tool to import measured data and to compare it with the corresponding solution 
quantities computed by SToRM . Here, the experimental measurements are provided in a plain 
ASCII text file named "Calibration WSE.txt". The first few lines of this file are: 

X, Y, WaterSurfaceElevation 
645360 . 541958 , 4473695 . 035004 , 1447 . 375977 
645411 . 952969 , 4473599 . 122009 , 1447 . 375977 
645499 . 504971 , 4473469 . 084000 , 1447 . 485962 
645430 . 440029 , 4473445 . 841003 , 1447 . 524048 
645616 . 889004 , 4473384 . 176003 , 1447 . 650024 

The first line contains a title, and the following lines contain triplets of data: for each data point, 
the x-coordinate, they-coordinate, and the value of the free surface elevation, all using the same 
datum as the original topographic data and separated by commas. The tool that allows the use of 

this data in iRIC is accessed through the l::i button in the main tool bar. 

To compare measured data with an existing SToRM solution in iRIC, follow the next steps: 

• Import the data to iRIC. This can be done from the Import 1 Measured Values ... pull­
down menu in main menu bar; it can be done from the Measured Values I Import .. . pull­
down menu also in the main menu bar; or it can be done by right-clicking on Measured 
Values in the Object Browser panel of the Pre-processing Window. 

• In the Open Measured Data File window that pops up, select file "Calibration WSE.txt" 
and click the Open button. 

• A data object is created in the Object Browser window that allows turn ing on and off the 
visualization of the data (Fig. 10.1 ). 

• Click on button l::i in the main tool bar. The Verification Window pops up (Fig. 1 0.2). 
• Select the appropriate solution variable from the Physical Value pull-down menu . In this 

case it is the Water Surface Elevation , as shown in Fig. 1 0.2. Don't forget to drag the 
Select the timestep of calculation result pointer to the desired solution . Click Ok to 
close the window. 
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Figure 10.1 
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Figure 10.2 

TUTORIAL 2: Green River 

• The result is plotted in a calculation vs. measurement graph , as shown in Fig . 1 0.3. The 
line of perfect agreement is also plotted . 

B vcnncat1on (1]~ 
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Measured Value 
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Root Me«15ql.wed Error : 0.512-497 

~~ ...... ,,~ ... ,~ 

Figure 10.3 

The results shown in Fig . 1 0.3. were computed with a uniform Manning's n-value of 0.035, as 
described in sectionS. The calibration procedure consists in varying the roughness values in order 
to obtain the best fit. This is a cyclic procedure, where the roughness is adjusted , SToRM is run , 
then the predicted water surface elevation is compared to the corresponding measured values. 
These steps are carried out until the best solution is obtained . Results of this process are shown 
in Fig. 10.4 for values on the manning's n of 0.015 (top), 0.025 (middle), and 0.045 (bottom) . 
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Figure 10.4 

TUTORIAL 2: Green River 

In this particular case, some of the solution shows good agreement with the measured data for n 
= 0.025, but other does not. This suggests that a single value of the roughness may not be 
enough to describe the reach properties, and that multiple roughness polygons are required in 
different regions. 
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TUTORIAL 4: 30-Mile Canal, South Platte, NE 

SToRm is a time-dependent flow model that was specifically developed to calculate rapidly 
varying surface water flows with unsteady discharges. The previous tutorials showed how to set­
up SToRM using the iRIC 1 2.3 graphical user interface (henceforth called iRIC only, for 
simplicity). They cover all the main steps necessary for a successful SToRM simulation, such as 
using bathymetric data and generating a computational grid , defining initial and boundary 
conditions, and finding a suitable time step, but steady state conditions were used to simplify the 
presentation. The present tutorial complements previous information by using fully unsteady data. 
The bathymetry and boundary conditions used herein are real field data that were collected in 30-
Mile Canal-a bypass canal in the South Platte River, NE- and represent a spill from a retention 
dam through a small canal , with flooding and drying of adjacent floodplains. 

Contents: 
1 ...... ... ..... .... ... .... ... ......... ... .... .. .. .. ......... .. .... .. Preparing Bathymetric Data and Computational Grid 
2 ... ... .. .. .. .. ... ... .. .... ....... ... ...... .................. ... ... .. .... ..... .... ... .. Defining Inflow and Outflow Boundaries 
3 ...... .... .... .... ... ... .. ....... .......... .. ...... ... ..... ... ... .... ... ... ..... ........ .... .............. ............ .. .. .. .. ... Roughness 
4 .... .. ..... ... ..... .... .. .... ... ..... ..... .. ... .. ..... ... ......... .... ... ....... ...... .. .......... ....... ......... ... . Runn ing the Model 
5 ... ..... ...... .. .. ... .. .... .. .......... .. .. ..... ....... ..... ... .. .... ...... ....... ....... .... ..... ....... .. ... . Visualization of Results 
6 ....... ... .... ... .... ....... ............. .... .... .. ....... ....... ....... ....... .............. ..... .......................... Final Remarks 

1. Preparing Bathymetric Data and Computational Grid 

The bathymetric data of the reach used in this tutorial is contained in file 
GPS_survey_9_16.1 O.tpo. To import the data into iRIC: 

• Use command Import 1 Geographic Data I Elevation from the main menu bar and 
select file GPS_survey_9_16.1 O.tpo . Recall that the file has extension .tpo, wh ich must 
be set appropriately in the filter of the Select file to import window. 

The result of the Import command is shown in Fig .1.1. 

For the present exercise, a computational mesh having a maximum element area of 2m2 is used. 
This size grid is chosen to capture enough topographic detail for the model simulation, but without 
resulting in very long computation time. In practice, grid resolution must reflect the accuracy 
sought for the flow field , but it must also be consistent with the data available. Here, the grid used 
is of finer resolution than the available topographic information, therefore care must be exercised 
when interpreting the results . 

1 iRIC stands for International River Interface Cooperative. 
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TURORIAL 4: 30-Mi/e Canal 

Figure 1.1 

The steps to generate the computational grid are identical to those described with detail in 
previous tutorials: 

• Use command Grid I Select Algorithm to Create Grid ... to select Create grid from 
polygonal shape. Click OK. 

• The computational domain is defined by a polygon that encompasses the area of interest. 
Define it by left-clicking the mouse at the desired polygon vertices. Double-cl ick the last 
point or press <Enter> to finish the polygon. In this example we are interested in the 
region in close proximity to the confluence of the two rivers. Use Fig. 1.3 to guide you to 
create the mesh polygon. 

• Right-cli ck on Grid [No Data] in the Pre-processing Window and select Create grid ... in 
the pop-up menu . Use the parameters shown in Fig . 1.2 (minimum angle for cell vertices: 
32 degrees; maximum area for cells: 2m2) . Click <OK>. 

The resulting mesh is depicted in Fig . 1.3. Further data visualization follows the same steps as 
described in previous tutorials. 
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TURORIAL 4: 30-Mi/e Canal 

Figure 1.3 

2. Defining Inflow and Outflow Boundaries 

The unsteady boundary conditions used in this section were derived from flow measurements in 
loco during a release flow event at the 30-Mile Canal. An inflow discharge hydrograph is used at 
the upstream-most end of the grid , which , in this case, is the western boundary. A corresponding 
stage hydrograph is used at the downstream-most end (the eastern boundary). 

To define the inflow boundary: 

• Zoom in the area of interest in the mesh boundary. 
• Right-click on Boundary Condition Setting item in the Pre-processing Window and 

select Add Inflow in the pop-up window. 
• Create a polygon surrounding the nodes belonging to the boundary. Only external nodes 

(nodes on the boundary of the mesh) should be included in this polygon. The polygon 
creation process is ended by double-clicking the last point or by simply pressing the 
<Return> key. The nodes belonging to the inflow boundary are shown in Fig . 2.1. 

• Assign the inflow condition a name and click Ok. Here, we use Inflow (Fig . 2.2, left). 
• Enter the time series for the inflow discharge. Each row contains a time (left column) and 

a discharge (right column), and is created by clicking on button Add. Here, the 
hydrograph is defined by 5 points, therefore 5 rows need to be created. The cell values 
are entered by clicking on the cell and typing the desired value. Enter the values shown 
in Fig . 2.2 (right). The shape of the hydrograph is plotted at the right of the same window. 
Click Ok to terminate the input of values . 

Page 3 of 13 

iRIC Phoenix 2016 205 of252 . 



TURORIAL 4: 30-Mi/e Canal 
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Note that the first entry of the inflow hydrograph is set at time 0 (zero). All SToRM simulations 
start at time 0 and proceed forward , incrementing time one time step at a time. It is not 
necessary, however, to start the hydrograph at time 0: SToRM uses the first value of the 
hydrograph if its first entry is set at a time larger than zero , until the defined time is reached . 
Linear interpolation is used for times between the points defining the hydrograph. For example, if 
the hydrograph in Fig. 2.2 started at time of 300 seconds, SToRM would used a value of Q = 4 
m3/s until such time was reached . The same approach is used for times after the end of the input 
hydrograph: for the hydrograph of Fig . 2.2, SToRM will use an inflow of 4 m3/s if the run is 
prolonged after the 900 second limit of the hydrograph. The base discharge in the flow channel 
before the flow release is 4 m3/s and , in the present exercise, the first 300 seconds are used to let 
the flow establish itself in the channel from the guessed initial conditions. 
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TURORIA L 4: 30-Mi/e Canal 

The downstream boundary is located at the eastern side of the computational grid . A stage 
hydrograph matching the inflow discharge must be defined there. Entry of those values is done in 
the same way as for the inflow hydrograph: 

• Zoom in the area of interest in the mesh boundary. 
• Right-click on Boundary Condition Setting item in the Pre-processing Window and 

select Add Outflow in the pop-up window. 
• Create a polygon surrounding the nodes belonging to the boundary. Only external nodes 

(nodes on the boundary of the mesh) should be included in this polygon . End polygon 
entry by double-clicking on its last vertex or by simply pressing the <Return> key. The 
resulting polygon is shown in Fig . 2.4. 

• Assign the inflow condition a name and click Ok. Here, we use Outflow (Fig. 2.3, left). 
• Enter the time series for the outflow stage, each row contains a time (left column) and a 

stage (right column), and is created by clicking on button Add . Here, the hydrograph is 
defined by 5 points, therefore 5 rows need to be created. The cel l values are entered by 
clicking on the cell and typing the desired value. Enter the values shown in Fig . 2.3 
(rig ht). The shape of the hydrograph is plotted at the right of the same window. Click Ok 
to terminate the input of values. 
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The inflow and outflow hydrographs are correlated to each other physica lly, but they are entered 
using separate time values. In other words, the values entered in the Time columns of the 
corresponding Calculation Condition windows (in the right side of Figs. 2.2 and 2.3) do not need 
to be the same. And, just like for the inflow hydrograph, the first point of the outflow hydrograph 
does not need to be set at time 0 (zero). Also, if the run is prolonged for more than 1020 seconds, 
SToRM will set the outflow stage at 798.51 m . 
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TURORIA L 4: 30-Mi/e Canal 
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Figure 2.4 

3.Roughness 

In this example, channel bed roughness is set to a Manning's n value of 0.025 using a coverage 
polygon, as shown in Figs. 3.1 and 3.2. The initial conditions are set in the next section. 

Figure 3.1 
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TURORIAL 4: 30-Mi/e Canal 
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4. Running the Model 

Figure 3.2 

Unlike in the previous tutorials, initial conditions have not been set yet. This is because iRIC 
allows the initial cond itions to be defined in multiple ways. In this exercise, uniform initial 
conditions are used and, rather than using coverage polygons, a different option is used. To 
accomplish this, go to Calculation Condition 1 Setting ... to set-up model parameters. The initial 
conditions are set in the first entry screen. Here, uniform initial conditions are set to U = 0.4 m/s, 
V = 0 m/s, and water surface elevation to 798.71 m (see Fig . 4.1, left). 

• Use the pull-down menu Set-up initial conditions and select Uniform initial conds. 
• Enter the values shown in Fig . 4.1, left . 
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TUROR/AL 4: 30-Mi/e Canal 
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Set wetting and drying parameters as shown in Fig . 4.2, right. In this simulation, a 151-order 
numerical integration scheme is used, with a time step of 0.005 seconds. The flow event will be 
simulated in 400,000 time steps. Plotting interval is set to 3 minutes. The above parameters are 
shown in Fig. 4.2, left. Make sure the roughness coefficient used is set to Manning's n (Fig. 4.2, 

right). Now, run the model using button ~ in the main iRIC toolbar. 
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Figure 4.2 

5. Visualization of Results 

The run takes approximately 28 minutes in a normal desktop PC. Use the button to bring up 
the visualization window. The results are shown in Figs. 5.1 through 5.3 for the velocity vectors 
(color denotes velocity magnitude), water depth (under the computational grid), and water surface 
elevation, respectively. 
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TURORIAL 4: 30-Mi/e Canal 
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TURORIAL 4: 30-Mi/e Canal 

iRIC offers the possibility of analyzing the time-dependent data by plotting each output time step 
(requested in the Calculation Condition window of Fig . 4.2), which was set to 3-second 
inteNals. Note the time tools toolbar of Fig 5.4, which appears in the previous figures. It indicates 
that the data viewed corresponds to a time of 2,000 seconds (which is also printed in the main 
display canvas in Figs. 5.1 to 5.3). The solution corresponding to the other times steps can be 
accessed by moving the slider in Fig. 5.4 to the desired position . For example, the magnitude of 
the velocity for second 840 is shown in Fig. 5.5 (only wet cells are colored). 
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TURORIAL 4: 30-Mi/e Canal 
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Figure 5.5 

The buttons at the left of the tool bar in Fig . 5.4 are used to view the solution in different time steps 
and can be used to produce a timed animation of the flow solutions. They are easy and intuitive 
to use, and it is left to the reader to try them out. The buttons are: 

6. Final Remarks 

Go to first recorded solution . 
Step back in time by one solution. 
Start animation , starting on currently displayed solution. 
Stop ongoing animation . 
March solution forward in time by one. 
Go to last recorded solution. 

In its current distribution , SToRM uses time steps of fixed size, which is set in the Calculation 
Conditions window for each simulation run. Additionally, SToRM uses an explicit type of time 
marching scheme, wh ich resul ts in numerical stability constraints: simulation runs may become 
numerically unstable if the time step is too large. Stabil ity is, thus, limited by the most severe 
condition encountered anywhere during a simulation run. In the example presented in this tutorial , 
stability issues are encountered in the earliest stages of the simulation, in the first few time steps, 
but not later. During these earlier time steps, time step size must be very small. 

There are two ways to deal with this phenomenon . One way, which is the most accurate, is to run 
the first few time steps with a very small time step, stop the run after these are overcome, and 
restart it again with larger time steps. Another method, wh ich is simpler and was used in this 
tutorial , is to limit the maximum possible velocity to a certain value. This was done in the 
Calculation Conditions window by setting Allow large time steps to Yes in the pull-down menu 
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TUROR/A L 4: 30-Mi/e Canal 

and assigning a value of 10 m/s to the Maximum velocity (m/s) option. This has the effect of 
clipping the highest possible calculated velocity to 10 m/s. 

Using the latter approach allows the simulation to progress past the difficult time steps without 
numerical instabilities, but accuracy may be somewhat affected, depending on the number of 
cells affected by the time step size restrictions. Fig. 6.1 shows the velocity field (vectors and 
magnitude of velocity) for the solution obtained in this exercise; Fig . 6.2 shows the same solution 
obtained with a much smaller time step of 0.001 seconds without velocity clipping . The area 
shown is near the inflow region. Although at this stage (at 60 seconds) the two solutions are 
similar, they are some differences. It is up to the user to ensure that the solutions obtained by the 
model are physically meaningful and accurate. 
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Figure 6.1 

If, on the other hand, steady state solutions are sought, the accuracy of the earl ier intermediate 
solutions is not important. In this case, velocity cl ipping can be used and the final steady-state 
solution is not affected as long as the maximum computed velocity is lower than the clipping 
value entered in the Calculations Condition menu . That can be easily verified by the user by 
plotting the magnitude of the velocity and ensuring that its maximum value is lower than that 
val ue. For example, in Figs. 6.1 and 6.2 the highest veloci ty magnitude is about 1.5 m/s, much 
lower than the prescribed 10 m/s of Fig . 4.2. 
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TUTORIAL 5: Flooding of Lamoure, ND 

SToRM @.ystem for Iransport and River Modeling) is a time-dependent hydraulic flow model 
specifically developed to calculate rapidly varying surface water flows with unsteady inflows and 
moving wetting/drying fronts. Th is tutorial shows how to set-up SToRM using the iRIC 1 2.3 
graphical user interface (henceforth called iRIC only, for simplicity). It covers all the necessary 
steps for a successful SToRM simulation , such as using bathymetric data and generating a 
computational grid , defining initial and boundary conditions, and setting up model parameters. 

This tutorial shows how to determine the flooding conditions in a semi-urban setting . The source 
of the flooding waters is Twin Lakes, which , under certain extreme hydrologic conditions, may 
spill over an emergency spillway (see figure below). The downstream spill channel is normall y dry 
and drains all the way to the town of Lamoure, ND. The entire area is initially dry and, as water 
passes the culvert under 73'd St. , it gradually becomes inundated. Flood delineation and time of 
arrival are two of the aspects investigated in this study. 

N 

-t 

Lamoure, NO 

73rd St SE 

Culvert 

Lamoure R;~············ ... 'tal 
Municipal Airport · ·-.[~· ••• 

The example presented here is based on a flood inundation project carried out by the North 
Dakota State Water Commission for the town of Lamoure, NO. The focus of the project was to 
determine the time and extent of the flooding affecting Lamoure's Rott Municipal Airport for spills 
from Twin lakes corresponding to hydrologic conditions with different return periods. The data 
used here was taken directly from the NO data server (http://lidar.swc.nd.gov/). 

1 iRIC stands for International River Interface Cooperative (http://i-ric.org/en/). 
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1. Getting Started 

iRIC can be launched the usual way: from the Windows Start menu, or by double-clicki ng on its 
icon on the desktop. When it starts, iRIC offers several options (Fig . 1.1, left): Create New 
Project and Open Project File. In this tutorial , boldfaced words are used to represent iRIC 
commands, menu items, and general items found anywhere in the iRIC graphical interface . Open 
Project File opens a file that was previously created by iRIC and stored somewhere in your 
storage devices. Here, we are interested in starting a new project: click New Project (Fig . 1.1, 
left), then select SToRM in the following screen and click Ok (Fig. 1.1, right) . ... 
[]
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........ c:~ ... 

. ..._ 
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(~ICh'I.O -I.STMlU1 
Noyt.X~Ao.l "'-0"~ 
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N.,-.lMy._1ll .41 ._,. 

Figure 1.1 
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The iRIC graphical user interface (GUI ) contains multiple windows, buttons, and pull-down 
menus. This is depicted in Fig 1.2, which shows the general look of iRIC when a new SToRM 
project is started. Different areas are identifi ed there, wh ich will be used throughout this tutorial. 

The Pre-processing Window opens by default when iRIC is first started. It is used to display 
data and prepare several of the quantities needed to run SToRM. It is used for data pre­
processing, i.e. , for data that needs to be prepared before SToRM can be run . Examples of this 
type of data are topographic information, computational grid , boundary conditions, and model 
parameters. 

There is also a Post-processing Window, which is used to visualize model resul ts. This window, 
which is independent from the Pre-processing Window and that can be displayed concurrently 
to it, is used after the model is run to process and interpret the data produced by SToRM. 
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Examples of this type of data are the computed velocity vectors, water surface elevation , and 
plots of comparisons between computed and measured quantities for model calibration . 
Examples of these wil l be shown later in this tutorial. 

Main too lbar ~ / Ma·n menu bar I 

Pre-proces 
Window 

sing 

-Object Bro 
Window 

wser 

Plotting 
canvas 

/ 

,. -~ ... --c-.. - ~ c-.. .__,- ~ -
.. . I! • . ...... .... :: • ··· · ·· 

. 
~---. _,_ 

. u::~ 

; ..J=·~-
· ..J-....-
· ..J-~w-t 

"'"~-...c:w-.. ...._., _ _..,. 

'~ " -~ f!_ lor __ .. 

J -

,., 

-
Figure 1.2 

.. ~ 

··- -=-

The main menu bar contains many of the commands used in iRIC, many of which will be seen 
later in this document. The main toolbar contains buttons that provide quick access to some of 
the functions more frequently used. The Object Browser Window is used to control the 
appearance of the items in the plotting canvas of the Pre-processing Window. Some of the 
buttons appearing in the main toolbar are: 

~0 

Open an existing project 
Save the current work 
Save a snapshot 
Export data to Google Earth 
Undo last operation 
Redo last undone operation 
Fit all data to the current plotting canvas 
Reset rotation of the viewing canvas to zero degrees, which is the 
default view 
Rotate the data by 90 degrees counterclockwise (data view can also be 
rotated by right-clicking the mouse while holding the <Ctrl> key) 
Move data to the left (data can also me moved by left-clicking and 
dragging the mouse while holding the <Ctrl> key) 
Move data to the right 
Move data up 
Move data down 
Zoom in 
Zoom out 
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Other tools will be explained later. Note that a help balloon appears when hovering over the icons 
in the main menu bar. Some of the icons may be grayed out, indicating that the corresponding 
operation cannot be carried out. 

Using iRIC and SToRM in a productive work environment usually resu lts in an iterative cycle in 
which successive model runs hone into a progressively more accurate solution , each benefitting 
from feedback from the previous ones. The workflow of an iRIC/SToRM project and consists in 
the following schematic steps: 

1. Import bathymetric data into iRIC. 
2. At this point ancillary data can also be imported into iRIC. Ancillary data may consist of 

items such as field data and orthorectified aerial imagery. 
3. Analyze and edit the data. 
4. Prepare a computational grid for use by SToRM. 
5. Define initial and boundary conditions, including roughness factors and other driving 

parameters. 
6. Specify model run parameters, such as choice of numerical scheme(s) and duration of 

the run . 
7. Run SToRM. May take minutes, hours, or days. 
8. Analyze the model results, compare with measurements, all while exercising crit ical 

engineering judgment. 
9. Are model results grid-independent? If yes, proceed to the next step; if not, backtrack to 

steps 4. 
10. Is the model properly calibrated? If yes, proceed to the next step; if not, backtrack to 

steps 5 or 6. 
11 . Are model results satisfactory? Do they pass critical scrutiny? If yes, proceed to the next 

step; if not, backtrack to steps 4, 5, or 6 . 
12. Production run completed. 

This process is schematically represented in the flow chart of Fig . 1.3. The use of the technical 
tools comprised in iRIC 2.3 facilitates accomplishing these tasks . 

Page 4 of37 

iRIC Phoenix 2016 219 of252. 



-------------------------------------------------------------------

SToRM Tutorial: Flooding of Lamoure, NO 

1. Start iRIC 2.3 and 
select a SToRM Project 

2. Import topography 
Import I geographic Data I Elevation ... 

Load other ancillary data, if any 

l Import I Measured Values ... 

I Load background image(s), if any 
Import I Background Image ..• 

3· Create the computational grid 
Grid I Select Algorithm to Create Grid ..• 

(Create grid from polygon shape) 

May have to add holes, areas 
of refinement or coarsening, 

'-- break lines 

4. Set-up bed roughness and initial conditions o a .... .A_ X 
(Polygons defined via mouse input) 

s. Set-up inflow and outflow boundaries 

6. Enter model parameters 
Calculation Condition I Setting ..• 

7· Run SToRM 

8. Display of results, analysis, calibration 

~ L. 
No 

Were the desired Yes f END 
results obtained? \. 

Figure 1.3 

2. Preparing Bathymetric Data 

Bathymetric data contains the terrain information (bathymetry is the underwater equivalent of 
topography; because under different flow conditions the terrain can be dry or submerged , both 
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terms are used interchangeably in this tutorial) . This data is usually the result of a field survey 
program and must be referenced to some common datum. An ideal dataset covers all the area of 
interest with sufficient spatial resolution for the desired application. 

The first step consists in loading the topographic data into iRIC. The data used in this tutorial is 
located in Shifted0ataSet-3m.tpo. This file type is an ASCII editable file that contains the 
coordinates and elevation of each data point, in metric units2, with 3-meter resolution. The 
beginning of this file looks like this (only the first 7 lines of data are displayed): 

2217392 
449 . 336 395 1 . 541 397 . 688 
452 . 336 3957 . 541 397 . 719 
452 . 336 3954 . 541 397 . 717 
452 . 336 3951 . 541 397 . 68 
452 . 336 3948 . 541 397 . 693 
455 . 336 3963 . 54 1 397 . 66 4 

The first line indicates the number of data points contained in the file. The triplets x,y,z that 
constitute the coordinates of each point (space-delimited) are then given one to a line. Note that 
iRIC can import several other data formats. To load this data into iRIC: 

• Use pull-down command Import I Geographic Data 1 Elevation ... from the main menu 
bar. 

• Find the data file in the folder where it is located and click OK in the pop-up window. 
• The Filtering Setting dialog window opens (Fig . 2.1 ). This window allows resampling 

very large data sets by reducing the number of points imported to iRIC to alleviate 
computer memory limitations. It works by defining the sequence of data points read into 
iRIC in the Filter variable: 1 means "read every point;" 2 means "read every second 
point;" 3 means "read every third point;" etc. Depending on the capability of a computer, 
filtering may or may not be necessary. 

(Note about notation used in this tutorial : bold faced words separated by a vertical bar denote 
a cascade of menus and submenus in iRIC, or a hierarchy of objects in the Object Browser.) 

Filtering Setting ? .. 

If you want to filter the dataset, specify value more than 1. 

Filter:~ 

OK Cancel 

Figure 2.1 

The final result is shown in Fig . 2.2 (after resizing the Pre-processing Window). The individual 
survey points are plotted, colorized by bed elevation . 

2 Important: all units used in SToRM are metric unless otherwise specified. 
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Untitled- iRIC 2.3.6.5364(5ToRM) 

. ix, 886.933S3Zn5 lv, 30S3.98193359 

Figure 2.2 

Note the objects in the Object Browser window (Fig. 2.3). Among other things (which will be 
seen later), this window can be used to turn specific aspects of the data on or off in the main 
display canvas. For example, cl ick on the checkbox to the left of Points1 to uncheck it and the 
data plot will disappear. Cl ick on it again to check it and the data plot will reappear. This is true for 
al l the graphic entities created during the workflow. The color range is calculated automatically 
from the data, but it can be changed from an appropriate control window (Fig . 2.4, left). which is 
brought up by highlighting Points1 in the Object Browser window (high lighting of any item in the 
Object Browser window is accomplished by left-cl icking the mouse on the desired object) and 
then right-clicking the mouse on Geographic Data 1 Elevation and selecting Color Setti ng from 
the pop-up menu. The same pop-up menu has other functionality, such as controlling the display 
color legend. The use of this menu is simple and straightforward. 

Right-clicking the mouse on Points1 directly brings up another pop-up menu with different 
functional ity. For example, it is possible to change the name of the dataset (Points1 is the name 
assigned to the data by default) and the points' appearance. To change how the topographic data 
is plotted: 

• Right-click the mouse on Geographic Data 1 Elevation I Points1 and select Property. 
The window in Fig. 2.4 (right) will appear. Click OK when finished. 
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. ' Pre-processing Window 
Object Browser X 

8 0 Geographic Data 
8 0 Elevation 

0 D Points1 
0 Roughness 
0 Initial U 
0 lnitiaiV 
0 Initial Stage 
0 Wind Friction Coefficient 
0 Wind Magnitude 
0 Wind Direction <Azimuth) 

0 0 Grid Creating Condition 
0 Boundary Condition Setting 
0 Grid [No Datal 
0 Measured Values 
0 Background Images 
0 Axes 

9 0 Distance Measures 
'· 0 0 Measure1 

Figure 2.3 

. ' Elevation Color Setting ? -

!
Value range 

Display Setting ?-P Automatic 

Max: 1438.339 

Min: j 394.13 Display Method---------, 

Colormap---------, r. Points 

I W1reframe 

r Surface 
r 
I Custom Sel:tlng ... PointSize: ~ 

r Transparent '1-, -•• -. -. ,- , -. ,- 1 ro-±1' 
r Hide Break lines 

OK Cancel OK Cancel 

Figure 2.4 

It is now possible to carry out a number of exploratory analyses of the topographic data in iRIC. 
Using the mouse buttons, it is possible to interactively pan, zoom, and rotate the viewport: 
panning of the viewport is accomplished by clicking and holding the left mouse button and the 
control keys simultaneously; zooming in and out is accompl ished by the use of the mouse wheel ; 
rotation is done holding the control key and the right mouse button. The viewport can be restored 

using the U button in the Main Toolbar. 

The display characteristics of the bathymetry data points can also be changed and customized. 
This is accomplished by selecting Geographic Data 1 Elevation 1 Points 1 (left-click on it in the 
Object Browser window) and right-clicking on it to access a pop-up menu that allows to edit the 
name of the data, export it, delete it, and adjust its properties, such as point size and display 
method. 
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A legend can be added to the display canvas by selecting Geographic Data 1 Elevation , right­
cl icking on it, and selecting Set Up Scalarbar in the resul ti ng pop-up menu . Make sure that 
Elevation is displayed in the drop-down menu and the Visible box is checked. The Edit button 
gives access to additional features that control the legend display. These menus are intuitive and 
easy to use, and the student is encouraged to try them to see their effects in the way data is 
presented . 

To conclude th is section, save your work. To save the project: 

• From the main menu, chose Fi le I Save as Project. Never use command Save as File 
(*. ipro) when using SToRM. 

• A pop-up window (Fig. 2.5) lets you select the location where the data wi ll be saved. 
Select the desired location and click on Make New Folder. Assign it a name and cl ick 
OK. 

• This operation creates a new folder containing all the data used by iRIC and by SToRM . 
The data generated later by SToRM run is saved in a CGNS-formatted file with extension 
.cgn . CGNS (CFD General Notation System) is a data format used widely in the 
computational fluid dynamics community. 

SAVE YOUR WORK OFTEN. 

Browse For Folder .. 
Save iRJC project 

~ Heda_Junct 

~ HydrographShift 

I> ICHE2014 

~ JamesRiver 

l> Data_Jun2015 

l> Debug_Jan2014 

lmagery_Jun2015 

James River ND 

l> T raining_Jun2015 

Japan_Meet_2014 

l> Kremmling 

l> Leadville 

I> Magma 

Make New Folder OK Cancel 

Figure 2.5 

3. Importing Ancillary Data 

It is possible to use different types of geo-referenced data in iRIC. These data can be scalar data, 
vector data, and images. Importing data is easy and the necessary steps and file formats have 
been shown elsewhere. Here, we are only interested to import a geo-referenced image to be 
used as auxiliary backdrop. This provides a much more interesting visual feedback when working 
with iRIC. To import a background image: 

• Select File I Import 1 Background Image from the main menu. Alternatively, Import I 
Background Image can also be used. 
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• In the Open Image dialog window, select BaselmageShifted.png3 . 

The image is now displayed in the main drawing canvas under the topographic data , as shown in 
Fig. 3.1, and has its own entry in the Object Browser window. The image used in this tutorial has 
a corresponding world file that positions each image correctly in the coordinate space-file 
BaselmageShifted .pgw, which is loaded automatically by iRIC. Images without such information 
can also be used in iRIC, but they must be adjusted manually by translating , rotating and scaling 
them appropriately: 

• To adjust the location of an image, select its name under Background Images in the 
Object Browser. 

• When an image is selected, the left mouse button drags the image, the middle mouse 
button scales the image, and the right mouse button rotates the image. 

C:\ Users\ frsimoes\ Documents\ UserData\ Projects\)amesRiver\ T raining)un20 15\StepRun - iRIC 2.3.6.5364 [SToRM] 

Fife Import G«<gr11phic O.tta Grid Measured V,tlu~ Calcu/.-tion Condrt.ion Simulation CalculatJon R!Wit View Option Help 

I..J .t~~< ~ll"'('>l~[2 tl' Yx"v'X ••tf ~~ ++++~: lll> •. ' ~ ~ 

-t- + X ~ 

X 

9 £a Geographic Data 
~ EltvaUon 

£a 0 Pointsl 
~ RoughnHs 
Ea lnltia!U 
E?.J lnrt:iaiV 
E?.l lnrt:iaiStage 
E?.J Wind Friction Coeffic1~t 
E?.l Wind Magnrtude 
E?.J Wind Otrection (Az;muth) 

E?.J L) Grid Creating Condition 
E?.J - Boundary Condrbon Sdtlng 
2J Grid [No Datal 
2] Measured Value:5 

5· E?.J Back round lma H 

Figure 3.1 

At this point it may be convenient to save your work . 

3 A smaller sized image can be found in file BaselmageSmallerShifted.png . It may be beneficial to 
computer performance to instead load this image, especially if graphics memory is limited . 
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4. Creating the Computational Mesh 

Most numerical models for surface water flow use a computational mesh (here, the term grid is 
used interchangeably) to calculate the flow solution. The mesh consists in a set of points (the 
term nodes is also used interchangeably) with some type of connectivity among them . For 
example, that connectivity provides a link between a point and all of its neighbor points, i.e ., it is 
used to define relations of proximity between nodes. Models compute the flow solutions on the 
discrete points of the mesh , and use interpolation methods to find flow parameters in the areas 
between the points. There are many different types of mesh configurations possible , but they can 
all be classified in one of two broad classes: structured or unstructured. In structured grids, the 
nodes are placed in an ordered row-column matrix, as shown in Fig. 4.1 (left). In unstructured 
grids, the nodes are placed in a scattered cloud without apparent symmetry. There are many 
ways to define an unstructured grid. SToRM uses a lattice of contiguous non-overlapping 
triangles and computes the flow variables (velocity and depth) at the geometric centers of those 
triangles, marked by ci rcles in Fig . 4.1 (right). This section is devoted to show the necessary 
steps to build an adequate grid that can be used for SToRM computations. ' 

y y 

X X 

Figure 4.1 

The area of interest for the current flooding study is centered at Lamoure's airport. It is convenient 
to place the computational grid outline far enough from the area of interest to minimize boundary 
condition effects, therefore we expand the area of interest to also include the 73rd St culvert, the 
city of Lamoure, and an area south of the airport, as outlined by the red circle in Fig. 4.2. 

In iRIC, the computational grid is created automatically by a triangulation program using a few 
parameters defined by the user. These parameters are: a polygon encompassing the area of 
interest, maximum area of the triangles, and their minimum allowed internal angle. The steps 
needed to create the grid are: 

• Zoom and J?an to the area of interest, which can be accomplished by using buttons 

0.. ~ in the main toolbar. Zooming can also be done by rotating the mouse wheel 
and panning by right-clicking the mouse and moving it on the display canvas while 
pressing the <Ctrl> key. 

• From the Object Browser, right-click on Grid Creating Condition and on Select 
Algorithm to Create Grid ... in the ensuing pop-up menu. Click on OK in the Select Grid 
Creating Algorithm window. 
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• The computational domain is defined by a polygon that encompasses the area of interest. 
Define it by left-clicking the mouse at the desired polygon vertices, in the proper 
sequence. iRIC provides guiding visual feedback during this process. Double-cl ick the last 
point or press <Enter> on the keyboard to finish the polygon. Use Fig . 4.3 to guide you on 
the shape and location of the polygon. 

Figure 4.2 
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C:\ Users\ frsimoes\ Documents\UserData\ Projec:ts\)amesRiver\ T ra ining)un20 15\StepRun • iRIC 2.3.6.5364 (ST aRM) -"-
Ea G~gnphic Oat• 
8 ~ Elevatron 

D D Po.nul 
t:!) Roughness 
0 lnrtiaiU 
Ea lnitiaiV 
Ea lnitiaiStagr: 
Ea Wind Friction C~c1ent 
~ Wind Magnitude 
0 Wind Direction (Azimuth) 

~ U Grid Creating Condition 
21 Boundary Condition Setting 
~ Grid {No Data) 
~ Musured Values 

e Ea Background lmagi!S 
0 D Baselmag&rfted.png 

E1J ll .... 
E:) Distance MusurH 

Ea L) Musurt1 

Figure 4.3 

It is possible to edit (delete and add) and change the location of the vertices of the grid polygon. 
To accomplish these operations do the following: 

• Left click on Grid Creating Condition in the Object Browser window. Th is will activate 

: + -+ (J • \ A+ A_ X 
the editing menu bar · . Next, left click on the 
mesh polygon. The grid polygon is highlighted and its vertices appear as black squares. 

• The mouse can now grab individual vertices: when left clicking the vertex , the cursor 
changes from an open hand shape to a closed hand shape, wh ich means it is grabbing 
that vertex. Move the mouse without releasing the left button and the vertex will move with 
it Release the mouse button at the desired new vertex location . This process is depicted 
in Fig . 4.4, where the cursor is placed near a vertex and takes the shape of an open hand 
(Fig. 4.4, left), then the mouse is cl icked and the vertex is moved (Fig . 4.4, right). 

• Grabbing near or on top of a vertex moves the vertex ; grabbing the frame moves the 
entire polygon to a new location. 

• New vertices can be added to the grid polygon : left cl ick on the A+ button, then left cl ick 
on the desired location for the new vertex. This location must be on the polygon , and not 
inside or outside of it 

• Similarly, and existing vertex can be deleted from the polygon: left click on the A_ button , 
then left click on the vertex to be deleted. 

• The above operations can be undone using the undo button llf'1 in the main toolbar. 
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Figure 4.4 

In iRIC, the computational grid is generated automatically by a triangulation program that uses 
quality constraints specified by the user: the minimum allowed internal angle of the triangles, and 
their maximum area. The objective of the internal angle constraint is to avoid creating triangles 
that are long and narrow, which have poor interpolating qualities and can impact negatively the 
accuracy of the model 's numerical solutions. Ideally, the value chosen should be close to 60 
degrees, which are the internal angles of an equilateral triangle. Unfortunately, the grid generator 
may become unstable if an angle greater than 32 degrees is prescribed, therefore the use of this 
value is recommended. 

The maximum triangle area constraint is determined from considerations about the required 
resolution . In other words, it is desirable to have triangles that are small enough to capture all the 
features that determine the preferential paths that the water will take. A way to determine 
maximum triangle area is by using the formula for the area of an equilateral triangle whose edges 
are t:,x in length: 

Table 1. Area and edge length for various equilateral triangles. 

ill< A 
10 43.3 

10.7 50.0 
15 97.4 
20 173.2 

21.5 200.2 
25 270.6 
30 389.7 

Using this information , we are now ready to generate the mesh. To start the automatic mesh 
generator: 

• Right-click on Grid Creating Condition in the Object Browser. This starts the grid 
generator. 

• The Grid Creation window is used to define the basic parameters that control grid quality. 
Enter the values shown in Fig . 4.5. 

• When prompted to map geographic data to grid , click Yes. This operation transfers the 
topographic data to the computational grid . 

• Visualization of the grid can be turned on and off by left-cl icking on Grid in the Object 
Browser window . 
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Grid Creation 

P" Specify minimum angle forceD vertices _ 132.00 j3 degrees 

When polygon has vertices that has smaHer angle than the value above, the 
condition is not applyed to the ceHs that indude those vertices. 

P" Spedfy maximum area for cells ~ !200 m2 

OK Cancel 

Figure 4.5 

One of the means to capture terrain features is provided by break lines. Break lines force the grid 
generator to create triangles with edges lying on those lines. Placing break lines on certain terrain 
features allows the grid generator to create grids that capture important topographic details. In the 
present example, it is important to capture accurately road elevations, because roads, being at a 
higher elevation than the adjacent lands, pose an important obstacle to the flow of water. The 
next step is, therefore, to use break lines to improve the grid. 

Break lines are open polygonal lines digitized by left-clicking the mouse on the display canvas. 
Each mouse click defines a vertex in the break line. A break line is ended by double-clicking the 
last vertex or by pressing <Enter> on the keyboard . To start the break line tool : 

• 

• 

• 

Left-click on Grid Creating Condition on the Ob"ect Browser of the Pre-processing 

Window. This will bring up a toolbar: ~ + + 0 • '- A+ A_ X 

Use button ""\ I to create a breakline. Click <Return> (or duble-cklick the last point) 
when completed . 
The locations of break line vertices can be edited and new vertices can be added using 
the same procedure described to edit the grid's main defining polygon-see Fig . 4.4 and 
corresponding text. 

Use Fig. 4.6 as a guide to create break lines over the most important roads and airport runway. 

Click on button~ to start each new break line. Break lines must not intersect each other nor 
the edges of the main grid polygon. After all break likes are entered , generate the new mesh: 

• Right-click on Grid Creating Condition in the Object Browser and select Create Grid ... 
• Cl ick on Yes in the warning window. 
• Click OK in the Grid Creation window. 
• Click OK in the Confirmation Window about mapping the geographic data to grid 

attributes. 

Using Table 1, it can be seen that the above choice of parameters provides a resolution of about 
f...x = 21 .5 m, which may be too low for certain localized reg ions of the domain. iRIC contains tools 
that allow the computational mesh to be easily refined and/or coarsened. A mesh is refined when 
the new mesh uses smaller triangles than the original, and coarsened when larger triangles are 
used. Refinement and coarsening of the computational grid can done selectively, i.e., the mesh 
can be refined and/or coarsened only in selected areas of the domain. Selective refinement may 
be advantageous when only a small part of the reach needs a fine mesh , while the solution for 
the remainder of the reach can be obtained by the use of a larger mesh. Areas where finer grids 
are needed are areas where the variables (water and/or flow velocity) change rap idly, such as in 
recirculation areas behind obstacles, around the tip of groins or other salient features, etc. Using 
selective refinement is a good way to avoid having too many grid triangles when a few are 
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enough, thus reducing the total number of computational points and resulting in increased 
computational efficiency (i .e., SToRM runs faster) . 

C:\Use"\f"imoes\Documents\UserData\ProjectsVamesRiver\ T raining)un2015\Setup_run2 - iRIC 2.3.6.5364 [ST oRMJ 

.- ~ Background Images 
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Figure 4.6 

Areas of mesh refinement and coarsening are created by defining polygons within the main grid 
polygon . Here, we are interested in refining the solution in a small area near the upstream 
boundary and culvert. To help identify the location of the culvert's inlet and outlet, we can load the 
set of their coordinates to place visual markers on the display canvas. This is done as follows: 

• Select Import 1 Measured Data from the main menu bar and select file 
CulvertShifted.csv. 

A new entry will appear in the Object Browser window called CULVERT. At the same time, two 
points will appear on the canvas. These show the location of the culvert (see Fig . 4.7) and help 
identify the areas of interest. 
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Figure 4.7 

We are interested in creating two areas of mesh refinement: one north of 73'd St, covering the 
culvert inflow; other south of the same, covering the culvert outflow. The refinement polygons are 
created in the same manner as when creating the main computational grid polygon. 

• 

• 

• 

• 
• 
• 

Left-click on Grid Creating Condition on the Ob'ect Browser of the Pre-processing 

Window. This will bring up a tool bar: ~ + + )( 0 a \. -"'• -"'- )( _ 
Use button tJ to create a refinement polygon. Left-click the mouse on polygon vertices . 
Click <Return> (or double-click the last point) when completed. 
Enter a refinement triangle area of 50m2 in the Refinement Maximum Area window and 
click OK. 
Digitize the next polygon in the same manner as above . 
Use Fig. 4.8 as guideline to create the refinement polygons . 
Note that the locations of polygons and their vertices can be edited, and new vertices can 
be added using the same procedure described to edit the grid 's main defining polygon­
see Fig . 4.4 and corresponding text. 
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Figure 4.8 

The edges of the refinement polygons must not cross over other edges or break lines. After both 
refinement polygons have been completed, regenerate the computationa l grid: 

• Right-click on Grid Creating Condition in the Object Browser and select Create Grid ... 
• Cl ick on Yes in the warning window. 
• Click OK in the Grid Creation window. 
• Click OK in the Confirmation Window about mapping the geographic data to grid 

attributes. 

An example of the final grid is shown in Fig . 4.9 . 
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Figure 4.9 

5. Prescribing Boundary and Initial Conditions 

The computational domain defined by the grid is the only part of the river "seen" by SToRM 
during the calculations. In other words, the model does not have any sort of information about the 
region outside the computational grid . To be able to carry out the backwater calculations, it is 
necessary to know something about what is upstream and downstream from the computational 
region . Basic hydraulics principles require that, for subcritical river flow, the discharge entering 
the grid and the water surface elevation at the downstream-most region of the grid must be 
known . These regions, where the stage and discharge must be specified , are usually called the 
hydraulic boundaries of the domain . The quantities prescribed there (discharge and stage) are 
called the boundary conditions. This section illustrates how to define the boundary conditions in 
iRIC. 

First, we are going to define the inflow boundary. This can be thought of as being the upstream­
most cross section in the computational domain , and the flow discharge must be specified there. 
It is convenient to define this boundary as a straight line perpendicularly to the centerline of the 
river channel. Each inflow (and outflow) boundary is composed of a string of contiguous nodes 
located on the boundary of the computational grid. The inflow hydrograph was synthesized from a 
spill from Twin Lakes corresponding to a 1 00-year rainfall event and is given in file 
hydrograph+12.txt and plotted in Fig . 5.1. The steps below show how to mark the inflow nodes 
and assign an inflow boundary condition to them. 
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Figure 5.1 

Zoom to area of interest, as shown in Fig . 5.2, and: 

8 10 

• Right-click on Boundary Condition Setting item in the Object Browser and select Add 
Inflow in the pop-up window . 

• Define a polygon that encompasses all the grid nodes (triangle vertices) belonging to the 
inflow boundary by left-clicking the mouse. Do not skip nodes. The polygon must incl ude 
boundary nodes only, and no internal nodes. End the polygon by pressing <Enter> on the 
keyboard. 

• The desired inflow boundary polygon is shown in Fig .5.3. 
• Assign the inflow condition a name and click Ok. Here, we use Inflow (Fig . 5.4 , left). 
• Select Fixed Width in the Type of inflow boundary. 
• Enter the time series for the inflow discharge by clicking Edit. To use the hydrograph in 

file hydrograph+12.txt, cl ick Import and select the fi le. The result of these operations is 
shown in Fig . 5.4 , right. Click Ok when done. 

• If the grid has been rotated , the display can be returned to its original state of zero 

rotation by cl icking on the button U located in the main tool bar. 

The inflow discharge was entered as a time series table, with time (seconds) in the left colum n 
and discharge (m3/s) in the rig ht column. The discharge is distributed uniformly across the string 
of nodes defined as the inflow boundary. A synthetic flow velocity field is then generated with 
velocity vectors that are perpendicular to the string. Due to the artificial nature of this velocity 
distribution, it is recommended that th is boundary should be placed away from the areas of 
interest where accurate solutions are sought. 

To complete the process, map the boundary polygon to the grid by selecting Grid 1 Attributes 
Mapping I Execute ... from the main menu. This is a step that must be carried out after each 
boundary condition is entered . 
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Figure 5.2 
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The outflow boundary can be thought as the downstream-most cross section of the river reach, 
and it is where the water surface elevation (stage) is needed for the backwater calculations. An 
appropriate outflow boundary condition for this exercise can be created by using a very shallow 
outflow stage. To find an appropriate stage, find the bed elevation at the outflow location using 
the Attribute Browser: 

• Zoom to the area of interest, which is the southeast end of the computational grid (Fig. 
5.5). 

• Right-click on Node attributes in the Object Browser and select Show Attribute 
Browser from the pop-up menu. 

• The Attribute Browser window will appear below the Object Browser window. It allows 
to query the values of individual grid nodes. Simply use the mouse to point to the desired 
node and its corresponding values will be displayed in the Attribute Browser window. 

• Point to a node at the outflow boundary. The example shown in Fig . 5.5 registers a bed 
elevation value of 394.1 9 m. Adding 1 em to this value yields a value of 394.20 m for the 
outflow boundary water surface elevation . 

C:\Users\frsimoes\Documents\UserData\Projects\JamesRiver\ T raining)un2015\Setup_run2 • iRIC 2.3.6.5364 (ST aRM) 
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Figure 5.5 

The outflow boundary is defined in similar steps as those used to define the inflow boundary: 

• Zoom to the area of interest, which is the southeast end of the computational grid (Fig . 
5.5). 

• Right-click on Boundary Condition Setting item in the Object Browser and select Add 
Outflow in the pop-up window. 
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• Define the polygon that encompasses all the grid nodes (triangle vertices) belonging to 
the outflow boundary by left-clicking the mouse. Do not skip nodes. The polygon must 
include boundary nodes only, and no internal nodes. End the polygon by pressing 
<Enter> on the keyboard . 

• See Fig . 5.6 for the desired boundary polygon. 
• Assign the inflow condition a name and click Ok. Here, we use Outflow (Fig. 5.7, left). 
• Enter the time series for the outflow stage by clicking Edit. Click on Add to create a data 

entry row and click on each cell to enter the corresponding value. 
• In this example, only one value is entered (394.20 m). Time is not important and the 

value 0 (zero) can be used here. See Fig . 5.7, right. Click Ok when done. 
• If the grid has been rotated , the display can be returned to its original state of zero 

rotation by clicking on the button 13 located in the main toolbar. 
• Map the boundary polygon to the grid by selecting Grid 1 Attributes Mapping 1 

Execute ... from the main menu. 
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Figure 5.7 

SToRM allows the inclusion of hydraulic structures defined by performance rating curves. A 
performance rating curve is the depth versus discharge relation for the flow th rough the structure. 
The depth is defined at the invert of the structure's head. A structure is defined by a rating curve, 
by the (pointwise) location of its inlet and outlet, and by the invert of the structure at the inlet. 
SToRM transfers water from the inflow to the outflow, removing the appropriate amount of water 
from the triangle where the inflow is located and transferring it to the triangle where the outlet is 
located. This transfer is instantaneous, but it enforces conservation of mass. 

The performance curve must contain only the flow that passes through the structure. In some 
cases, however, there may be flow passing through the structure as well as above it. This may be 
the case in overflowing highway cu lverts, when the culvert is at maximum capacity and there is 
also flow passing over the roadway above it. In this case, the culvert flow rate is calculated from 
the performance curve, and the free surface flow over the roadway is calculated normally by 
SToRM. Therefore, performance curves must not contain the structure's overflow. This is 
illustrated in Fig. 5.8, where a typical culvert performance curve is shown. Only the inlet and 
outlet control parts of the performance curve are used in the SToRM input data, and the roadway 
overtopping contribution must not be included. Similar considerations must be made for other 
hydraulic structures, such as for submerged gates and drain pipes. 
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Figure 5.8 

The performance curve for the culvert passing under 73rd St. is given in file CulvertShifted.txt. To 
import it follow these steps: 

• 
• 
• 

• 
• 

Select Calculation Condition 1 Setting ... from the main menu bar . 
Click on the General Options option in the left window (see Fig . 5.9) . 
Select Yes in the pull-down menu Activate culvert computations . 

Locate the file with the culvert data by clicking on ~ and selecting the appropriate f ile . 
Click on Save and Close to complete the operation . 
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Roughness is set by drawing polygons (sometimes called coverage polygons) over the areas of 
interest. Follow these steps to set the roughness: 

• In the Object Browser, under Geographic Data right-click on Roughness and select 
Add and Polygon in the respective pop-up menus. 

• Draw a polygon covering the entire computational grid. The polygon is entered by left 
clicking the mouse on the canvas to enter each vertex of the polygon, in sequence. Finish 
by double-clicking the last vertex of the polygon (or by pressing <Enter>). 

• When asked, enter a value of the roughness of 0.045 (Manning's n). 
• Map the roughness values to the computational grid by executing the command Grid 1 

Attributes Mapping 1 Execute from the main menu . 
• The final polygon may look like what is shown in Fig . 5.10. 
• The vertices of the polygon can be edited later by highl ighting the polygon in the Object 

I] + + )( I• I , .. + ,._ I 
Browser window and using the tools in toolbar . 

• Map the boundary polygon to the grid by selecting Grid 1 Attributes Mapping 1 

Execute .. . from the main menu . 

In SToRM, roughness can be represented by Manning's n values, by Chezy's C coefficients, or 
by drag coefficients cr. The default is Manning's n, wh ich is used in this tutorial , but it will be 
shown later how to select the others. 
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Figure 5.10 

5.3. Initial Conditions 

The term "initial conditions" reflects the state of the flow at the beginning of the simulation , i.e., at 
time t = 0 s. A simulation run starts with a known flow field , which is a known velocity and water 
depth throughout, and advances it in time (also called time marching or time stepping by the 
modeling community). SToRM can be run from a state of completely dry, partially wet and dry, or 
completely wet bed configurations. In this exercise, we use an initially wet inflow boundary, which 
helps model stability and allows larger time steps to be used in the calculation of the progression 
of the solution through time. 

One of the ways that can be used to define initial conditions is by the use of coverage polygons, 
identical to what is done above for roughness data entry. A small reg ion with prescribed water 
surface elevation can be created with the following steps: 

• In the Object Browser window, right-click on Initial Stage and select Add ... 1 Polygon 
from the ensuing pop-up menus. 

• Click on the display canvas to define a polygon at the inflow boundary using Fig . 5.11 as 
a guideline. Left-click the mouse to create a vertex, double click or press <Enter> to finish 
the operation . 

• When asked, enter a value of 412 m for the stage in the area of the polygon . 
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• Note that the vertices of the polygon can be edited later using the tools in tool bar 

In + • x 1• 1 A+ A_ 1 
• Map the boundary polygon to the grid by selecting Grid I Attributes Mapping I 

Execute ... from the main menu . 

C:\ Users\ frs imoes\ Documents\UserData\ Projects\JamesRiver\ T rainingjun201 S\Setup_run2 - iRIC 2.3.6.5364 [SToRM] 

Figure 5.11 

6. Running the Model 

Like any other model , SToRM requires the definition of additional parameters. Some of these 
parameters are physical quantities, others are parameters used to set up the numerical methods 
employed to solve the equations. These must all be defined by the user in a set of entry screens 
that are going to be covered in this section . 

To define the parameters needed for the run , there are a group of entry screens in the 
Calculation Condition window. This window is invoked from the Calculation Conditions I 
Settings ... menu from the main pull-down menu bar. The different parameter entry screens are 
selected by clicking the appropriate text in the left-hand side panel. The first is titled Initial 
Conditions and is shown in Fig. 6.1, left. In this tutorial , the initial conditions were defined using 
coverage polygons in the previous section, therefore this entry screen must read From coverage 
polygons in the Set-up initial conditions pull-down menu . 
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The Wetting and Drying entry screen shown in Fig. 6.1, right, is used to specify the parameters 
that control the behavior of the wetting and drying computation algorithm in SToRM. Parameter 
Threshold for drying cells is a value of the water depth (in meters) below which a wet cell 
becomes dry. In this example it is set to 1 em. Parameter Threshold for re-wetting cells defines 
a value of the water depth above which a dry cell becomes wet. It is a dimensionless multiplier: 
this value multiplied by the Threshold for drying cells provides the desired value of the water 
depth. Here, the value of the parameter is 2, meaning that a dry cell is considered wet again 
when its water depth becomes higher than 2 em (2 x 0.01 ). The Threshold for re-wetting cells 
parameter is important because it prevents excessive triggering of wetting and drying at cells at 
the river margins. This numerically-induced wetting and drying cycle can introduce instabilities in 
the solution and slow down convergence to steady state. Recommended values are of 2 or higher 
in the lowest range, and up to 10 or more, depending on the value used for the threshold for 
drying cells: low drying thresholds require higher re-wetting values. 

The Solution Parameters entry screen (Fig . 6.2, left) is used to define the parameters used by 
the time stepping solution algorithms in SToRM. The Time step size defines the size of the time 
step used to advance the solution in time. The time units are seconds. The Time stepping 
method is a pull down menu that selects the time stepping method used in the calculations. 
There are three methods: Order 1, Order 2, and Order 3. The first method is the most 
computationally efficient and the last one the most accurate . The choice of time stepping method 
is a compromise : in a typical application , all methods should arrive to the same solution , but it 
may be necessary to use smaller time steps when using the Order 1 method. Experimentation 
may be needed to choose between each, with the ultimate goal being to reach a solution in the 
shortest computer run time. Use the values shown in Fig. 6.2. In practice, the Order 1 or Order 2 
methods should be used, because Order 3 is computationally too onerous and the law of 
diminishing returns kicks in . 
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A run of 10 hours is sought, with intermediate output of the solution at every 15 minutes. The 
rules to enter the Number of time steps and the Plotting increment values are: 

• A plain number is interpreted as the number of time steps. 
• A number followed by a letter is interpreted as a time period. For example, typing 5s 

means a run of 5 seconds. The permissible units ares for seconds, m for minutes, h for 
hours, and d for days. Capital and lower case are both okay, but don't put a space 
between the number and the letter (1 .5D is okay for a day and a half, but 1.5 D is not). 
Use only one time unit: for example 6.5h is okay for 6 and a half hours, but 6h30m is not. 

Finally, the General Options entry screen (Fig . 6.2 , right) allows to select the type of roughness 
coefficient from the Type of resistance coefficient pull-down menu , using culvert data, and wind 
forcing (which is not used in thin exercise). 

After data preparation, SToRM is run by clicking the .. button on the main window command 

bar. A model run can be stopped at any time by clicking on the button . The progress of the 
computation can be followed in a pop-up window (console). The first column contains the iteration 
number; the second column contains the corresponding time, in seconds; the third column 
contains the value of a quantity that indicates the relative change of the water depth in each time 
step, defined as 

"L(h:+£>1- h:r 
"L(h:r 

where h: is the water depth in triangle i and at time t, M is the time step size, and the summation 

is carried over all the wet triangles; the fourth column contains the inflow discharge of water 
(m3/s); and the fifth column contains the discharge out of the computational domain (m3/s). 

Choosing the appropriate time step for the run is an important task. SToRM uses explicit time 
stepping methods. In practical terms this means that, in order to keep the computations stable, 
there are constra ints to the time step size. If not, the computations "blow up," which is a way to 
say that the variables become uncontrollably large or small- cause divisions by zero or the 
numbers become larger than the limits of computer representation - so that the water depth may 
become negative. The run stops prematurely and its results are meaningless. An indication of 
these events is the presence of 'lnf' or 'NaN' in the model output window during the run . Usually, 
in convection-dominated flows, stability is related to flow celerity, size of the time step, and 
triangle dimension by a dimensionless parameter: 
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where M is the time step size, Um is the magnitude of the flow velocity at the center of the triangle 
( = (i..J2 + \1") 112) , his the water depth at the same point, g is the acceleration due to gravity (9.8 
m/s2) , and Lr is a grid-related length scale (for example, the triangle's perimeter). The 
dimensionless parameter C, is called the Courant number and is fixed for a certain time stepping 
method , but usually different for different methods. The above relation translates into the flowing 
statements: 

1. For a triangle of a certain size, larger flow velocity requires smaller time steps. 
2. In the same situation , larger depths also require smaller time steps, but this constraint is 

less severe than the one for flow velocity. 
3. For a certain flow field , larger time steps can be used for larger triangles. For smaller 

triangles the time step size must be reduced accordingly. 

This process is succinctly schematized in Fig . 6.3, where the two constraining parameters, flow 
velocity and grid size, are shown by cuNes representing the stability of the numerical solution. 
Considering each parameter individually, the curves represent the maximum stable time step 
size-in other words, any time step size below that curve results in stable calculations. For 
example, the maximum allowed time step size increases as triangle size increases, but it 
decreases as flow velocity grows. 

Flow velocity 
(U + (gh)"') 

Spatial discretization 
(triangle size) 

Region of numerical 
stability 

Constraining parameter 

Figure 6.3 

A stable time step must lie below both curves. In some cases the limiting factor is velocity 
magnitude, in others grid size. This means that, for each physical prototype, there is always a 
limit to the maximum value of the time step that produces a stable numerical solution , which is 
represented by fltmax in Fig. 6.3. These are important facts to keep in mind when selecting the 
parameters that go into the Solution Parameters entry screen. Unfortunately, things are not that 
simple. For example, for shallow depths the friction terms become dominant, the flow is no longer 
convection-dominated , and new restrictions are imposed to the time step to keep the 
computations stable: small time steps are needed for very shallow depths. Therefore, a trial-and­
error cycle is usually necessary to determine the largest time step that retains the stability of the 
computations. This is case dependent and varies with bed geometry and other boundary 
conditions . 

Page 32 of 37 

iRIC Phoenix 2016 247 of252. 



,......----------------------- - - ---

SToRM Tutorial: Flooding of Lamoure, NO 

7. Visualization of Results 

Besides data preparation and model 's parameter input, a process usually referred to as pre­
processing , iRIC also provides means to view the model 's numerical sol ution. This post­
processing stage is done in its independent window, titled Post-processing (20) and shown in 

Fig. 7.1 (water depth). The post-processing canvas of iRIC is invoked clicking on button or by 
selecting Calculation Result 1 Open new 20 Post-Processing Window from the main menu. 
The Post-processing (20) window works identically to the Pre-processing Window, with its 
own Object Browser, and is used to plot the solution variables. 
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Figure 7.1 

Fig. 7.1 shows water depth contours. Many other quantities can be displayed, including velocity 
vectors, streamlines, and particle paths. The visualization properties of each displayed quantity 
can be accessed through pop-up menus by right-clicking on the corresponding entity names in 
the Object Browser window: 

• The lines and indices of the computational grid can be set from the pop-up menu from 
SToRM Grids 1 iRICZone 1 Grid Shape and selecting Property ... from the pop-up 
menu. 

• Visualization properties of all scalar quantities can be changed by right-cl icking on 
SToRM Grids 1 iRICZone 1 Scalar and selecting Property ... This allows creating color 
maps and change colorization of the displayed scalar field , as well as creating color 
legends (Fig . 7.2). 
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• Vector plots can be customized from SToRM Grids 1 iRICZone I Arrow. It is possible to 
change vector size, color, and sampling. 
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Figure 7.2 
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Figure 7.3 
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There is an important scalar quantity that is different and requires addressing . It is the SToRM 
Gids 1 iRICZone 1 Scalar IIBC. This quantity is used like a mask to separate wet from dry cells, 
and has a value of 1 in wet cells and 0 (zero) in dry cells. Its visualization is shown in Fig . 7.4. It is 
used to mask the other solution variables when it is desirable to plot their values in wet cells only . 
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Figure 7.4 

To show how to use IBC to mask a variable, let's use the water depth . Without masking, the 
water depth was plotted in Fig. 7.1. The display showed water depth in wet cells, but also in dry 
cells, where stage is not defined but plots with the same elevation as the bed (zero depth). To 
restrict the display of water surface elevation to wet cells only: 

• Right click the mouse on Scalar (henceforth the string SToRM Gids 1 iRICZone will be 
omitted when there is no source of ambiguity) and select Property to bring up the Scalar 
Setting window. 

• Click on the Region Setting button (top right) and select Active Region. Click OK when 
done. 

• Click OK in the Scalar Setting window to complete the process. 

The resulting plot is shown in Fig . 7.5, where the legend was removed to improve clarity. To 
remove the legend: 

• Right click the mouse on Scalar and select Property to bring up the Scalar Setting 
window. 

• Click on the Color Bar Setting button to bring up the Color Legend Setting window. 
• Uncheck the Visible setting, in the top left corner of the window. Press OK when done. 
• Click OK in the Scalar Setting window to complete the process. 
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Note that there are other attributes that can be changed in the Color Legend Setting window . 
They are self-explanatory and the user is encouraged to try different settings to see how they 
impact the look of the plotted variables. 
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Figure 7.5 

iRIC offers the possibility of analyzing the time-dependent data by plotting each output time step 
requested in the Calculation Condition window of Fig . 6.2 (left) . Note the time tools toolbar of 
Fig 7.6, which appears in the previous figures. It indicates that the data viewed corresponds to a 
time of 360,000 seconds, or 10 hours, and is also printed in the main display canvas in Figs. 7.1 
to 7.5. The solution corresponding to the other times steps can be accessed by moving the slider 
in Fig. 7.6 to the desired position . For example, the magnitude of the velocity for second 135,000 
is shown in Fig . 7.7 (on ly wet cells are colored). 

I, II II II II Il l II II II I ! t - 360000 s 

Figure 7.6 
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Figure 7.7 

Cl -

The buttons at the left of the toolbar in Fig. 7.6 are used to view the solution in different time steps 
and can be used to produce a timed animation of the flow solutions. They are easy and intuitive 
to use, and it is left to the reader to try them out. The buttons are: 

Go to first recorded solution. 
Step back in time by one solution. 
Start animation, starting on currently displayed solution. 
Stop ongoing animation . 
March solution forward in time by one. 
Go to last recorded solution . 

The animation speed can be set using button __ to define the animation interval. 
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